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Introduction

Maplytics™ is a leading Certified for Microsoft Dynamics 365 (CfMD) geo-analytical mapping app.
Maplytics empowers users across verticals with the power of Geographical Data Visualization, Optimized
Routing, Automated Appointment Planning, Proximity Search, Heat Maps, Shape Overlay, Census data
visualization and Territory Management to drive better sales, improve business processes and engage

right customers at the right time.

Maplytics is available for Microsoft Dynamics versions CRM 2013 and above and supports all deployment
models of CRM On-Premise (IFD as well), CRM Online and Partner-hosted. It uses the API services provided

by Bing maps. The following are the highlights of Maplytics:

v" Ease of access

<

Compatible with Dynamics 365 App for
Phones and Tablets

Multiple language support

Plot multiple OOB & custom entities on map
Hierarchal Territories

Area of Service

Search nearby records with Proximity Search
Auto Scheduling for multiple users

Track field reps’ activities with Check-In
Custom icons for pushpins

Multiple categories on plot card

PowerApps Component Framework
Multiple categorizations for single entity
Multiple territories for a record

Spider Cluster

Building Marketing list

Pie Charts and Column Charts in Heat Map
Overlay

NN N N N N N N N N N N N N N N

Merged Plot and Route view
Maplytics Security Template

<\

Point of Interest search
Layer Menu v
Concentric Proximity search

Land Area Mapping v

N N N N N N N N N N N N N N N N N SR

CRM / Dynamics 365 Customer Engagement v

Bulk geographies upload

Shape operations

Territory Management

Auto-Territory Creation

Real-Time Tracking

Maplytics API

Territory Assignment Rules

Draft Territories

Census data visualization

Support for CDS

Data grid resizable

Plot Saved Templates on individual records
Configurable color-coded pushpins
Routing with multiple waypoints

Along the Route search

Ability to Save & Share Driving directions
Sales analysis with Heat Maps

Summary Card on Detail and Heat Map
Configurable color for Heat Map measure
Maplytics Dashboards with configurable
queries

Geocoding Confidence Rating
Turn-by-turn navigation on mobiles &
tablets

Seamlessly integrated within Dynamics
Multi-search layer in Detail map Control
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Language Support

Maplytics is a multi-language solution currently available in seven different languages namely:
e English
e Spanish (Espafiol)
e German (Deutsche)
e French (Frangais)
e Portuguese (Portugués)
o  Turkish (Tirk)
e Arabic (g,*)

Set Personal Options

Change the default display seftings to persenalize Microsoft Dynamics 365, and manage your email templates

Generzl Synchronization Activities Formats Email Templates Email Signatures Email Privacy i___a_n_q_u_a_ge_é
Select the language you prefer to see Microsoft Dynamics 365 displayed in

You can change the display langusge used for items such as menus and dislog boxes

Zaze Language I;,-g ish
User Interface Language I Emglish ¥ I
Help Language Emglish hd

Maplytics auto-detects the user language set in Dynamics CRM and sets its language accordingly.

To check user language set in Dynamics CRM, please go to Settings > Options > Languages

@I-u:lts.lg: ﬁ@ MAPLYTICS" Page 10 of 284




Maplytics™ — User Manual

Maplytics Configuration (Personalization)

Each user of Maplytics can customize Maplytics configuration according to their preference. The user can
configure Zoom level, Current Location, default origin and destination and a couple of other settings like
Map more, default summary grouping, etc. Please go to Settings > Maplytics Configuration Details >
Select Maplytics Configuration record for the required user (users added in Team Maplytics)> Set
according to the preference

Refer to ‘Maplytics Configuration Details (Personalization)’ section of Installation Manual for a detailed
description of personalization settings.

Maplytics Security Template

System admin and Maplytics admin can provide selective access of Maplytics actions to the Maplytics
users. They can select the required Mass actions & other actions in the list and save it as a Security
template. They can further assign this template to the required users so as to provide the access of the
selected actions in the template to the respective Maplytics users.

To create a Security Template,

Go to the Maplytics App > Settings > Maplytics Security Templates > New > ‘General’ tab > Give a name
and ‘save’ the template.

Dynamics 365 Maplytics | Settings > Maplytics Security Templates

= [ show Chart [ Delete | ~ () Refresh [ Emailalink | ~ o Flow ~ Wl RunReport ~ @ Excel Templates ~ @7 Export to Excel | ™

{2t Home

_—_ . A Active Maplytics Security Templates Search forrecoras P
2 Pinned ~
v | Name T Add...TL Aut... T} Cha... T} cre.. T} Cre.. T} cre.. T) cre.. TL Do.. Tl Exe... T
Maplytics
Field Sales No No No No No L] - Yes No

B Maplytics Dashboard...

B entity Maps Marketing No No No No Na | | - No No
1} Maplytics Templates

B Maplytics Configurat...

| Maplytics Security Te...

& License Registration
B Teritories
"t Teams
m Routes
»
All # A B C D E M N (o] P Q 5 T U v X Y z
View records that start with this letter
1-2of 2 (0 selected)
H Settings S
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To assign a template to the Maplytics users, Admins can add
the Maplytics Configuration Detail records of the Maplytics
users under the section of ‘Maplytics Configuration Details’,
to whom the template has to be assigned.

Lookup Records x

Select record

Look for Records je
Maplytics Configuration Details Al Maplytics Configuration Details
[l Add Existing Map Configur... B Maplytics
8/10/2020 11:24 AM
O Refresh
Run R Maplytics
un Report > H plyt Ny
No d Sam L
BH  Excel Templates >
@  Export Maplytics Configura... | > H Maplytics
v
ES,  See associated records Dave Butler
Maplytics
n plyt . o
Ashley Swift
Maplytics
. I v
Kelly Johnson
New Map Configuration o Change

Details View

In order to assign the Security Template to multiple users at once. Admins can also add teams/users using
the button ‘Manage users’ from the Ribbon bar. They can also remove the required users/teams from
the list. Thus, using ‘Manage users’ admins can easily manage the users assigned with any Security
Template.

Dynamics 365 ~ Maplytics  Settings > Maplytics Security Templates > Sales

Save ‘] Save & Close = New [‘*@ Deactivate ]E Delete | A, Manage UsersI

Home

o Sales

(O Recent A Maplytics Security Templates

s> Pinned N General Action Configuration  Related

@nas.é ﬁo MAPLYTICS™ Page 12 of 284
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Admins can choose whether they want to assign the template to Users or Teams by adding them. They
can also choose to remove the users/teams from the list. They can also see the list of teams and respective
users added from those teams.

Maplytics - Manage Users B X Maplytics - Manage Users B X
@ Add O Remove @ Add ) Remove
Type Type Users v » Dave Butler | »Gerard Smith
LA » William Anderson
Teams

Dave Butler
Kelly Johnson
Gerard Smith

‘William Anderson

Ashley Swift
John Pinto
Sam L
Add Add
Maplytics - Manage Users B X Maplytics - Manage Users B X
@ Add ) Remove () Add @ Remove
Type | Teams ~| || xHR | xMaplytics | | » Marketing Type | Users ~| || %Dave Butler || » Gerard Smith
1T Kelly Johnson
User Maplytics ‘Gerard Smith
Ashley Swift Marketing William Anderson
Dave Butler orga5210b38 Ashley Swift
Gerard Smith Sales John Pinto
John Pinto Maplytics SamL
Kelly Johnson HR Maplytics
Sam L Maplytics Marketing
‘William Anderson Maplytics
Page (T )71 0~ 1t070f7

Note: A Maplytics Security template can be assigned to the users belonging to any team, however,
they should also exist into the Maplytics team.
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Go to Action Configuration > Select the required actions to be made available to the users assigned with

this template and save.

Sales - saved
Maplytics Security Templates

General Action Configuration Related

Mass Actions

Select All Mass

Actions

Change Owner
Manage Territory
Execute Workflow
Send Email

Auto Scheduling

Associate Records

Sales - saved
Maplytics Security Templates

General  Action Configuration

Actions
Select All Actions O

Save Template -

Public o
Create Route
Frint Map
Create Mew Record [m]
Related Records
Territory
Management o
Shape Files
Configuration o
Travel Distance [m]
O

(0 innovative logic
@il‘IDEiC

Related

ﬁ@ MAPLYTICS™

Export To Excel

Add To Route

Save Data -
Marketing List

Save Data - Personal
View

Create Activities

Save Template -
Persona
Update Route

Download Map

Send Route Emal

Truck Route
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Along with using the ‘Remove’ button, to unassign any template to a user, admins can also Go to Maplytics
App > Settings > Maplytics Configuration Details > Select the record of the required user> Remove the

lookup value for the field of ‘Maplytics Security Templates’

Maplytics

Map Configuration Details

General Auto Scheduling Related

Google

50

o8

B sales

Route Option Shortest Time Navigate In
G Map Center —— Records Per Page In
Grid
Heat Map T
eat Map Type Boundary Zoom Level
Summary Groupin Cj
v ping y £ User
Default Template - Maplytics Security
Template
Set As Origin Other
Set As Destination
Other - Set As Origin 819 Catalpa Dr, Montgomery, AL 36112
Other - Set As
Destination
Note:

Other

819 Catalpa Dr, Montgomery, AL 36112

o All the actions will be visible to a user, if no template is assigned to the user
e Only System Admin and Maplytics Admin will be able to access the Maplytics Security Template

Entity

@ih'g“%""i"’é ﬁo MAPLYTICS™
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Individual Record Map

A tab to display an Individual Map section has been added by default on the Account, Contact and Lead
records as a part of the Maplytics solution.

Enterprises Inc - savec £2,013,833.00 1,555 AdalL
Account Annual Revenue No. of Employees Owinel
Summary Route Map Project Price Lists  Details Servicing Related
No Auto Geocoding = Address Relations Ocala Wildlife Management Area & b
catl 3
L g Port,O1
Street 1 2060 S Bay St 2060 S Bay St FL Eustis LAKE FL 32726 nu 28.8344 -81.6858
Samsula
Street 2 FL W.‘,‘, Deland New Smy
\ Lake/Helen
Street 3 b
Orange City
The Villages
ity ; - Lady Lake © Deltona
City Eustis Nl () L4
Wildwood lake £ Lake
State/Province FL nverness Eustis : Monroe
Inverness Leesburg e Moot »
~ hlands South S Mot s ac a7}Sanford
ZIP/Postal Code 32726 (e
Floral City "
Country/Region
Wekiwa Springs — WVinter
_ Springs
Apopka Altamonte Oviedo
Latitude 28.83442 o1 Springs
Lake Apopka
Longitude -81.68579 @ Winter Park University
Mascotte. Minneola Winter Pine Hills
ville Groveland larmont Garden -
Territory b Bing s - Orlando

Here, two types of pushpins are plotted on the map:

Orange color pushpin: This always indicates the record location on the map. This pushpin is
movable on the map. If the user is not satisfied with the automatic geocoding information stored
for the record, they can click on the pushpin and drag it around to the required location on the
map. As the user moves the pushpin, the geocoding information (Latitude and Longitude) and the

address is updated in the bar at the top. Use the Update button ﬂ to save the updated
geocoding information. It will ask the user whether they would like to update only the Latitude &
Longitude values or the address as well. They can select the required option. This will help the

user to geocode the address as per the requirement.

innavative logic

imnoGic

©

ﬁo MAPLYTICS™
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Confirm

Would you like to save also the address?

253 Martin Ave

South Lake Tahoe, El Dorado County
California, 96150

United States

Yes, save also the address Mo, save Lat Long only

Set the ‘No Auto Geocoding’ option to ‘Yes’ available on the left-hand side, if the user has manually
set the geocoding information and do not want the automation to override the geocoding
information.

e Address: If users wants to modify the geocoding for any record, they can click in the Address text
box.

v i
Address ! Kirklar!ld Redmond

s i = sl 00N i | J
| 253 Martin Avel nn 47 4444 122 1520“

= Bellevue Sammamish
i A
o 253 Martin Ave _ . G 1
South Lake Tahoe, California 86150, United States e
" Mercer (
o 253 Martin Ave lsland" < S
Stafford, Kansas 67578, United States (| Issaq'uah'- g ﬁ
ulevard Puvkﬁ p— A
o 253 Martin Ave Bryn Mawi) Tiger Mountair % ] Mount Si
Bangs. Texas 76823, United States o J — (90} 1270 m
wils" Repton —_—
e @ _ <
Q 253 Martin Ave E Tad | 03 e
Port Orchard, Washington 82288, United States i 4 g%! / —
b &i f East Hill-Meridian
in 2 ing v | y o
~ 253 Martin Ave 9> ks Mapid Valley (5o
J | Kent P
Co‘vir‘:gtor.
‘ v
Federal Way
s W AER e
] o |
X N, Tacoma f \
island b} | — - \
Fircrest, ,‘? = yallug \ 10 %
McNel | IR
Migroson 3ingy s ; vd University Place | 2 Erumclaw S :::zﬁm'*‘!wc;wc:.:».r Corperaton Ten

After that, they can click on ‘Update’ button n to update the address and Latitude & Longitude
values. It will ask the user whether they would like to update only the Latitude & Longitude values
or the address as well. They can select the required option. Apart from this, users can also click

@..—,DE.:‘-‘: P mapLYTICS™ Page 17 of 284
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on the orange pushpin, drag it around to the required location, and then click on update to update
the address and/or Latitude Longitude values.

Confirm

Would you like to save also the address?

Yes, save also the address Mo, save Lat Long only

Note: Users can be restricted to update the address and Latitude & Longitude values by
assigning them a security template where ‘Allow Push Pin Update’ is not selected. Please
refer to the Maplytics Security template in this User manual to know more about the same.

e Related Records: User can use ‘Relations’ drop-down to select the available relationships for this
Entity. Related records correspond to all 1:N relationship between the plotted Entity. The user
can further see related record information by clicking or hovering on it. The required attributes
like Email Address, Phone Number etc. can be selected within the entity map to be seen on hover
or click. At a maximum, user can view 5 relationships at once. Default relationships can also be
selected that will be plotted by default whenever this map is loaded. At a maximum, user can
select five Default relationships. User can also select the color and pushpin icons for the related
records. Check the Entity Map settings (refer to Installation Manual) to set Default relationship,
colors & pushpins and adding more relationships to ‘Relations’ dropdown. In the image below,
two relationships (Account-Contact and Account-Lead) are plotted for the account “Adventure
Works”.
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Dynamics 365

Maplytics

= ¢ Save @ Save & Close New &% OpenOrgChart [ Deactivate & Connect T Add to Marketing List &, Assign  [%) Email a Link
@ Home
= Adventure Works $450,000,000.00 5,800 amitjna
® Recent v Account A e No. Cwner,
57 Pinned N Summary Route Map Details Project Price Lists ~ Servicing Related
My Work
i No Auto Geocoding
& Dashboards
Activities e SYRIA s— S CHINA
MOROCCO 4 A iraQ 1RAN AFGHANISTAN [ ¢
; A
Select relationships V3 - PAKISTAN/ g
{ ALGERIA g s N
Customers = LIBYA EGYPT 4 -
I A Accounts U f T { | SAUDI ARABIA [\ C INDIA
HAITI  pR. MAURITANI. | ( 3
Q ¢ (us) § MALL J SUDAN e
ontacts N\ — YEMEN
ribbean X ( cHap {4
Caribbean Sea = BURKINA FASO \ \ Arabian Sea
{ SUINEA / NIGERIA / e Y
Sales ![NEvZU[LGAu‘Y‘ANA GHANA | = SOUTH SUDAN B
COLOMBIA -~ SURINAME SO g stmatia e s
& Leads o GABON [ adkenva INDONESIA
’ CONGO (DRC) '+
» X Java .
[ Opportunities TANZANIA e
PP BRAZIL i kS
PERU g ‘ >3
y \ ANGOLA™
Quotes Rt 2.
/ BOLIVIA SRR A e
= | NAMIBIA‘ ZAM!A!\{VE MADAGASCAR Indian
" PARAGUAY O5zameiaue Ocean
CHILE - S ESWATING
% SOUTH AFRICA
URUGUAY .
5 (aRGENTINA
B Sales T Adive Save
Steps to add the Map to other entity
fO rms Ay Microsoft Dynamics CRM

Open the Entity form and go to the ‘Insert’
tab.

Click on ‘Web Resource’ button, as shown
in the screenshot.

innavative logic

imnoGic

=

OO o O = =

Quotes

55| FranE
Section Three  Three Two Two Two One Sub-Grid Spacer Quick View Bing Navigation
+  Columns Columns Columns Columns Columns  Column Form Notes Maps Link
3 Tabs 2 Tabs 1Tab Control
. Solution: Default Solution Web Resource
4 Opportunity
Summary Form: Opportunity Add an existing Web resource to this
Map form.
t Line Item: 4 _
Product Line tems Summary You can also define how the Web

resource will be named and formatted |
on the form.

ﬁ MAPLYTICS™

Page 19 of 284




Maplytics™ — User Manual

A Add Web Resource - Webpage Dialog

Add Web Resource

Add an existing web resource to the Form.

General Formatting Dependencies

Web resource

‘Web resource * @] ikl_/Maplytics/Maplytics.IndividualMap.htm|

(ij

Field Name and Properties

Name * WebResource_ |Map

Label * Map

[[]Display label on the Form

Visibility

W visible by default

Web Resource Properties

Custom Parameter(data)

1 Restrict cross-frame scripting, where supported.

i Pass record object-type code and unique identifier as parameters

Cancel

In the Add Web Resource dialog, select
“ikl_/Maplytics/Maplytics.IndividualMap.html”
web resource and check the Pass record object-
type checkbox as shown in the screenshot.

Click OK, then Save and publish the form to see
the Map on the entity form.

Note: To plot a particular address on the Map, it should be geocoded and the Latitude & Longitude
should be set for that address. For geocoding you need to execute Maplytics Geocoding workflow for

the records.

) innavative logic
@il‘lDEiC
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Area of Service

The user can view the data in a proximity or a region around an individual record as defined by the user
in the Area of service.

ACCOUNT Annual Revenue No. of Employees Owiner
ADV Hotel $200.000.00 2 A sams

Summary Map Template onRecord Kanban Board for Case  Attach2Dynamics  Map My Relationships ~ Area of Service Map  Assets and Locations ~ Accounting Details  Details

Select Datasource

Account v Accounts - Staten islar v/

Lower New York Bay

Add Area of Service tab

Contextual Search Layer Mem‘_ _ Isstlaatneg )'
&

Search Option | PlotRecords o X fw R@

Proximity v % /

Proximity g

® Distance O Time ¥

234 Miles v

Add Web Resource 2

Add an existing web resource to the Form,

To add Area of Service tab, Open the Entity
form and go to the ‘Insert’ tab. Click on Web
Resource button, as shown in the

Genersl Formatting Dependenciss
screenshot.
—web resource

Web resource * [#] ikl_/Maplytics/Maplytics.AutoSearchFilters.tH 3
] ¥ =3 | ¥ 3 y v [ B Web Resource - :
e [ : r— Field Name and Properties
Dm0 o8= 8%
Secton Thee Thee  Two  Two Twe  Onme  Sub-Grid Spacer QuickView Name * e |"'r“a of servics |
+  Columns Columns Columns Columns Columns Column Form Timeline .
Label * |ArEa of service |
3 Tabs 2Tabs 1Tab Display label on the Form
— Visibility
In the Add Web Resource dialog, select #) visible by default
. . . . ¥ Enablz for m
“ikI_/Maplytics/Maplytics.AutoSearchFilters. e

html” web resource and check the ‘Pass record

: - [
. —Web Resource Properties 1oz
object-type’ checkbox.
. . . Custom Parameter(datz)
The preferred number of rows in formatting is
15 - :le;trict :rss;—"f’;".e scripting, whers s.Jpp.or.e:I.._
i-<H ‘ass record object-type code and unigus identifier a2 parameters.

Click OK, then Save and publish the form to see
the Map on the entity form.
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Create an Area of Service field

To save the values entered in the Area of Service, the user needs to create a field for the Entity for which
Area of Service has been added. Go to Entity form > New field. Enter the following values:

Name - Area of Service

Data type — Multiple Line of Text

Maximum Length — 10000

Select the field in the respective Entity map for the Area of Service field.

ENTITY MAP
account

General  Attribute Mappings Tooltip Mapping  Category Configuration  Configuration  Advance Settings  Related

Title ® [ Account Name | Area of Service [ Area of Service

Template I |

The values when entered and saved into the Area of Service, the corresponding data will be plotted on
the map.

View Area of Service data on a map

To view the Area of Service data on the map, there are two ways:

e Using Map button — the results are shown in a map opened in a different tab
e Adding Detail map on form —the results are shown in a map added on the same record

Using Map button

The user can open the Detail map to view the corresponding Area of Service data plotted on the map.

(@] New &a Open Org Chart I:;‘. Deactivate A Connect ~ 7 Add to Marketing List A, Assign CF Email a Link m Delete O Refresh

ACCOUNT Annual Revenue No. of Employees
A. HANSA PERSAUD & SONS 366,466.00
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Adding Detail map on form

To add a Detail map to show the data of Area of
Service, follow the steps mentioned below:

Open the Entity form and go to the ‘Insert’ tab.
Add two columns.

After adding Area of Service tab in the entity form
as mentioned above, follow the steps mentioned
below to add the Detail map on the entity form.

To add a detail map, Click on ‘Web Resource’
button. In the Add Web Resource dialog, select
“ikl_/Maplytics/Maplytics.DetailMap.html”

web resource, add “form” as custom parameter
(data) and check the ‘Pass record object-type’
checkbox as shown in the screenshot. The
preferred number of rows in formatting is 15.

Click OK, then Save and publish the form to see
the Map on the Entity form.

Enter the required values into Area of Service,
save it and click on the refresh button on the
Detail map to view the data plotted.

h HOME "
1= T

Section Three Three TWO
= olumns Cclumns JColumns

Two

i Twoe
Col

umns Columns

3 Tabs

Web Resource Properties

Modify this Web resource’s properties.

General = Fommatting  Dependencies

~Wweb resource

¥ ii_/Maplytics/Maplytics.DetailMaphtmi

Web resource *

r—Field Name and Prope

frame scripting where supported

ject-type code and unigue identifier 32 parameters.

ACCOUNT

ADV Hotel £200,000.00

Summary Map Template onRecord Kanban Board for Case  Attach2Dynamics

Contextual Search

Layer Menu

Plot Records
Search Option

Proximity
Proximity
O Time

@® Distance

234 Miles

Select Datasource

Account » Accounts - Staten islar v

innavative logic

inoGic

Annuai Revenue

Map My Relationships

6@ MAPLYTICS™

No. of Employees Oviner

2 sams

Map  Assets and Locations

Area of Service Accounting Details  Details

Staten
Island

Lower New York Bay
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Detail Map

Maplytics buttons are added to the Entity forms as well as the Entity Homepages so that it can be easily
accessed from anywhere.

[©)] T New ﬂgﬁ Open Org Chart [‘é Deactivate ’oﬁ Connect e 3 Addto Marketing List .QA Assign & Email a Link IEI Delete O Refresh

ACCOUNT Annual Revenue No. of Employees
A. HANSA PERSAUD & SONS $366, v

Summary Tab Map Project Price Lists  Details  Field Service  Scheduling  Related

o

ACCOUNT INFORMATION Timeline -+ Primary Contact
Account Name N -
. Enter a note... 0
A. HANSA PERSAUD & SONS CONTACTS

Using this button, the user can invoke the Maplytics application for detailed geographical analysis.
Maplytics provides both ‘Heat Maps’ view as well as ‘Detail Map’ view of the Dynamics CRM data. These
views can be easily accessed from the buttons added to the command bar in entity home pages and other

views.

] Show Chart T New IE Delete ~ O Refresh I &@ Detail Map 69 Heat Map I B2l Email a Link ~ o Flow Run Report
i My ACt|Ve ACCOU nts e Search for records 2
v Account Name T Main Phone T Address 1: City Tl Primary Contact Tl Email {Primary Contact) T
0969 Qcean View Road (415) 555-9933 Jersey - ---
10003 Account 4578735 - Adrian Dumitrascu Adrian@adventure-works.com
A Damc == Alberta == ==
A, Datum --- -
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Selecting a few records and clicking on the ‘Detail Map’ button on a particular Entity Grid view will open
the following window;

Layer Menu

Plot Records

| TodtHill
a e

© 2021 TomTom. € 2021 M

It will automatically plot the selected records from the view on the map. Records that do not have their
latitude/ longitude will be ignored and will not be plotted on the Map.
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Plot

There are five different search options to plot the data on Map:
e By Location

By Region

By Drawing

By Territory

By Template

Note: The user can also configure the ‘Search Options’ to be visible on the map. Refer ‘Setup Entity

Map’ section of Installation Manual for further instruction.

By Location

This helps the user to plot the data using the geocoding of each record.
By Location search option also allows the user to perform
Proximity/Radius Search based on Distance or Time.

The Current Location is fetched from the user’s personalization record.
The user can also set a new current location using the contextual menu.

Refer to the section of the Contextual menu.

Plot Records, o
Select View

Plot Records

Q@8 2™k
L., Fa - L J
Filter -~
Cluster Map
Current Location
9 Amy Ct, Staten Island, NY 103 L
Proximity
® Distance O Time
Miles A

[ Show Travel Distance

@ Q Personal Views Datasource ~
=] Account - London
Filter 2C<cun:; - ;D"D'S Select Datasource
ccounts - bermany
) Accounts - India Accour % | | Select Vien v | @ .
| Clug Accounts - New premium clients +
Cument lLocd  Accounts - NewYork Select Category
9 Amy Ct Accounts - Staten island . =g9en
= Accounts - UK Account || Select...
Proximity Accounts -Banking & social
. Active Accounts - Australia Overlay -
® Distance Actiy ounts - France venay
Actiy ounts - Qutside USA H 2
A By drawing - 30 Oct - -
-~/ Show Trg My Address Book Accounts
Personal View Test
Datasource |  Resellers
SIC Code
|| SelectDatag USA Accounts ® 1~ Select Datasource dropdown will list out all the Entities (OOB
Accour ™ | | Select Vie v | '@ ) . . . .
. (7 and Custom) configured for Maplytics and the active views
Select Category e (System views, Personal views, Maplytics Dashboards and

g
Account | | Select.. 58

o e Marketing Lists) that are available for the selected Entity type.

Overlay - The user can choose one of the views to plot all the records

H o

available in that view.

Note: The user can also configure the ‘Views List’. Refer ‘Setup Entity Map’ section of Installation

Manual for further instruction.
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The user can select additional entities using the ‘+’ button. The user is
allowed to specify a maximum of 3 Datasources for plotting the data at

a time. This allows for viewing Dynamics CRM data across Entities in a
single view on the map.

After selecting multiple entities, the user can click on the ‘Search’
button to plot the records for the selected entities. This helps the user
to visualize three entities on a single map.

Note: User can define the colors as well as pushpin shapes of the
Entity — view combination. Refer to ‘Setup Entity Map’ section of
Installation Manual for further instructions.

inoGic

QS8 20

Filter ”~

Cluster Map

Current Location

(]
Proximity
@ Distance OTime
Miles hd
Show Travel Distance
Select Asset
Select Ass v Select Haz v
DataSource ~

Select Datasource
T
Accour ¥ || Accounts - v | X \.f.

Contac ¥ || Contacts - v | X L/

Llead | Leads-Sk™ Xi.;.

) S WO Vo V
< Tremley Point. N\ / £ & @® > 7
g X V. ik R v (f) College \/ odt Hill
\ ,// \’ of Staten ( e
™~ island 7
@ Y
‘8 Filter ~ EAvIS V @ =
/ 4 Freshkills Park \/ =%
sy ® @® z
N 4 2 = v
Cluster Map (.J %.>
Current Location o b | X
“Osevep| % Sbitén Latourette Park
Island
Carteret | S—— Mall
Proximity g
@® Distance O Time %
Miles v Y ;1

Show Travel Distance

-

oA PUOWILIY

Select Asset

Select Ass v || Select Haz v

DataSource N

%
1
Z
§
Select Datasource

% Accour ¥ | | Accounts - v | X .‘.
Contac ¥ || Contacts - v | X (/)
Lead V|| Leads-sStiv| X .‘.

Barber

LG WIN

Stazg

o
[T GR— /
I View Data E?f i
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By Region

This helps the user to plot the data by the region of records, i.e., Plot Records

20 2™ 0

City, State, County, Country, PostalCode, PostalCode Sector,
Postal Code(Outward Code), Postal Code Areas. The user can plot
multiple regions under a particular region type.
e Postal Code: The smallest postcode category, such as a zip
code.
e Postal Code Sector: The second ‘1’ is called “Postcode
Sector”. Example: CA1 1
e Postal Code(Outward Code): This is called Outward Code,
the part of the postcode before the single space in the
middle. Example: CAl
o Postal Code Areas: The next largest postcode category
after Postcodel that is created by aggregating Postcodel
areas.

Note:

o The regions that were plotted using the option of
Post code Areas before will now be plotted by using
the option of Post code sector.

o The regions will be plotted as per the Bing maps.

Filter

Cluster Map

Select Region Type

Select Region

v]

County

Country

Postal Code

Postal Code Sector

Postal Code Area

Select Region '
State

Pastal Code(Qutward Code)

Account || Select ...

Overlay

A

Q

& Lhat | (1)  Linden;

Filter

Cluster Map =
Select Region Type | Rahway ‘(\9‘?

|/

"""" County v | o= River ,&/” \

/ i~ :é o TRAVIS ﬁ
Staten Island 1 N j m

& =
Please Enter State : & Avenel Carteret rytsu KLLS

¢
USA 4

Port'Reading
DataSource ~

Sewaren

\ Select Datasource
Accour ¥ | | Accounts -V | £ .
L+
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By Drawing

This helps the user to plot data by defining their own shapes. The user can use the ‘Drawing tool bar’ to
draw the following shapes:

e Freehand drawing

e n-sided polygon

e (Circle

e Rectangle
The user can further edit the drawn shapes by using the following options in the Drawing tool bar:

Edit

Erase

Fill color
Stroke color

f— = — - .
IO Layer Menu P \_‘)

& | Plot Record; )
W ‘ Filter ) - C’ @/

Bl a» e
: Define shapes.

PEOEOZ 8

Datasource ~ P

Select Datasource

‘.A“ounv IActiveAcc(V‘ n.
+

Select Category ‘ A: ot
‘Vf-\ccwnt Hsam.‘. V‘ A /

Overlay ol
Sovrce [ e |}

| Note: While creating an n-sided polygon, use the ‘Esc’ key from keyboard to close the shape. |

@“_‘.%Ek 60 MAPLYTICS™ Page 29 of 284




@,

Maplytics™ — User Manual

By Territory

This helps the user to plot the data defined in a particular sales territory.
The user can select multiple territories in ‘Select Territory’ option and
respective Datasource & view to plot the territories along with the
records assigned with them.

ESthSt

r& - Territory List

j Plot Records ) ; 3 Wi dwin Markham
»| N 0 Bk =
3 25 4 Q Q Castieton Ave 48
\ vQ )
A
() Cluster Map
Select Territory

10301, 10302, 10303, 10304

. Datasource

Select Datasource

b e $@)
+
Select Category

Account || Select... v

Overlay

e @Mnmﬂcs"

| Plot Records

&E82PE

Filter

(" Cluster Map

Select Territory

| 10301, 10302, 10303, 10304

~

Datasource

Select Datasource

|Aocuurrv||Accounis— V| @.
+

Select Categary
Overlay

Save Template
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By Template

This helps the user to plot the predefined search criteria in Detail Map. The user can save the search
criteria as a template and use the ‘By Template’ search option to quickly plot the data with that search
criteria. This helps the user to save a considerable amount of time.

Szl For example, if any user is assigned with a task where

Q ’? P @ the requirement is to regularly plot ‘My Active Accounts’
= i e AT records in 2 miles of a particular location and filter a
Filter ~ particular Industry, then the By Template option can be

beneficial.
Cluster Map
Select Maplytics Template
Australia- proximity Brisbane b
Select Owverlay
R Select Cverlay ¥

The User can plot the required criteria on the map

+

and use .the. button ‘Save template' to save the T TR T
search criteria as a template and define the access —
level of the Template while saving the template as

described below:

e Personal — The users can limit the usage of
this template to themselves

e Public — Anyone in the organization can
use this template

Save The Template %

Add to existing template
® Create new template
Apart from saving information of Plot Records,
Category card, and filters from Grid, it also saves
the Zoom level & Center of the map.

1Golf Course - 2 Miles|

Access Level :

Personal ¥
Note: Please assign ‘Maplytics User’ security
role to Team Maplytics before exploring this E
functionality.
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Default Template
User can set the Default Template within their respective Configuration Detail record and view the
predefined search criteria saved in the template plotted by default on the Detail Map.

To set a template as Default, user need to Go to the Maplytics App > Settings > Maplytics Configuration
Details > Respective User Configuration Detail record > General > Default Template > Select required
template.

r G Q

Dynamics 365 Maplytics

= « [E HEsave @ saveaclose () Refresh € Check Access [ Emailalink 2 Flow @ Word Templates Run Report ™

i Home

Maplytics
(O Recent v Map Configuration Details
s Pinned ~ General Auto Scheduling  Related
ve Tra Along The Route
Live Traffic No Along a
Maplytics Distance 00
=] Maplytics Dashboard.. Current Location 9 Amy Ct, Staten Island, NY 10314 Records Per Page In
Grid 200
E Entity Maps
B Meplytics Templates e Foad Navigate In Google
ytics Templa
| B wapiytics configurat.. show area on Card Yes Zoom Level 12
6] Maplytics Security Te.. ._ —— -
Heat Map Type Boundary 0O Map Center 40.5824367,-74.1508567
B Tenitories
Default Template B Active customers within 10 milesy, X o Region Area Unit i
Acced Wit 0 = g Al Square Kilometer
[ Assets JL']
© Other - Set As Origin 10 Ellsworth Ave, New York, NY 10312
A Teams 9 i Summary Grouping Postal Code
B Routes .
Set As Origin Other Maplytics Security
© Inogic License Details Template
& License Registration Set As Destination Other
Other - Set As 123 Harold St, Staten Island, NY 10314
Destination .
E Settings ~ B2 Adive | Status  Active Bl save

Note: Default Template will not open if;,

e User selects a few records in Entity home grid and then clicks on Detail map button.

e User expands a dashboard to open on Detail map.

e User has saved Default template with search criteria other than Proximity Search and uses
the ‘Map’ button on a specific record and opened the map

When clicked on the ‘Detail Map’ button, it will plot the default template selected in the respective user’s
Maplytics configuration detail record by default on the map.
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New York
Manhattan.. g
> Hoboken 2

Maplewicod | . 0
Millpfn

Jersey City.

= View Data Sandy Hook Bay

Default Template will not open if,

User selects a few records in Entity home grid and then clicks on Detail map button.

User expands a dashboard to open on Detail map.

User has saved Default template with search criteria other than By location/ Proximity
Search and uses the ‘Map’ button on a specific record to open the map. In this case, the
respective record will be plotted on map.

User has set Area of Service on a record and is using the ‘Map button’ on the record to open
the map.

Note: Below are some exceptional cases for Default template where the plotted data might vary.

innovative logic

imnoGic

If Default template has been saved with search criteria By Location and the user uses the
‘Map’ button on a record to open the Map, in this case, the respective record will be plotted
as the current location along with other records selected within the Default template.

If Default template has been saved with search criteria Proximity Search and the user uses
the ‘Map’ button on a record to open the Map, in this case, the respective record will be
plotted as the current location replacing the initial current location set in the template. Thus,
the records will be plotted within the specified radius from the respective record’s location
which is now the current location on the map.
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Cluster map

The user can select this option to group the closely positioned pushpins into a cluster. A cluster shows the
number of pushpins in the cluster. The user can zoom in further to break down the cluster into smaller
clusters or zoom out to group closely positioned clusters into one.

Cluster Area

The user can hover on any cluster to see the ‘Cluster area’ which shows the data spread. The data spread
is based on the area covered by the pushpins existing in the cluster.

fOR Layer Menu ¥ Road

. Plot Records

35 at FAIRWAY LANE Staten L..

L ‘L Account: Active Accounts: 50

b oz
VA N, ria..m.:u,

, L
P —
‘ ‘ Account Name 4 Y- ‘ Main Phone b & ‘ Address 1: City Y | Primary Contact Y ‘ Email h ‘ Full Name Y. ‘
=) Concalves & Sons 2128402600 Staten Island &
=] Dejohn & Sons 2128409565 Staten Island n
B J.NJ KATZ & ASSOC.INC. & ... | 14141242839 Staten Island I
= e o s SRS lizeee ey

[T 6 >y 50 v | items per page (50 Selected) 1 - 50 of 50 items
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Spider cluster

The user can click on any cluster to view the pushpins existing in the same in the form of a ‘Spider cluster’.

Layer Menu

Plot Records

35 at FAIRWAY LANE Staten I...

[£3]
o 22 at WOEHRLE AVE Staten Is...

Account: Active Accounts: 13

== Ay (
Active Accounts (13) * Related Reco...

‘ ‘ Account Name 4 Y | Main Phone Y | Address 1: City Y | Primary Contact Y | Email Y ‘ Full Name Y ‘
@ E. STEVE ZERVOUDIS & SONS 29989046845 Staten Island i
@ E. TERRENCE LULAY & SONS 20438760356 Staten Island
@ L TUCCI NICHOLAS & SONS 9073974539 Staten Island
= e el = | IS, 1 | 3l 4]
- 0 > 50 v | items per page (13 Selected) 1 - 13 of 13 items

| Note: Spider clusters can be visualized only for records less than or equal to 50. |
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Category

Users can choose any attribute for the selected entity to categorize the data on the map and visualize the
pushpins color-coded based on the selected attribute. The category card will further help the user to
differentiate between the pushpins.

Multiple categories for multiple entitles

User can plot a maximum of three entities on the map and can also select one attribute for each of the
three datasources selected to categorize them. The screenshot below shows the categorization of the
records of Account, Lead and Opportunity based on the attributes Annual revenue, Rating and Estimated
Revenue respectively.

Note:
e User can choose respective categories for at a maximum of three different entities.
o The user can define the color as well as shape of pushpins for each parameters of category.
Refer to Pre-Define Colors for Category section for further details.
e Usercan also choose the field attributes to be visible in Category list. Refer to ‘Setup Entity Map’
section of Installation Manual for further instruction.

o : YT
8 [ R ' 4 . 0 9

Q 2 W 7 ’ e Sl
| Filter ~ Grasselli iz - ‘ ] *
: - . .
@ =% * /e Y
® ® NG v
V a &
\‘;5‘\ DataSource ~ ; 5 = % 3
:\9 o Carteret :. FRESH Kl i | >
; Select Datasource g o o o
“ C o
o ®
oD .0 ot
o 0 9 o
| e /% © e

G

Q

Q
Q

b> 8ing.__

) innavative logic
@il‘IDEiC

O o o
°°g:§’o,°

= viewpata | @

ﬁo MAPLYTICS™
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Multiple categories for single entity

Users can also plot a single entity records categorized by multiple
attributes e.g. Account records categorized by Open revenue,
Originating lead, Owner. The user can choose an entity twice or
thrice with two or three different views respectively and choose
required attributes for the respective views to categorize the
same entity with different attributes. User can select a maximum
of three attributes to categorize a single entity.

Note: User can select a maximum of three attributes
to categorize a single entity.

While plotting a single entity categorized by three attributes,
three category cards will open up for the three attributes. For
example, the screenshot below shows Accounts plotted on the
map which is categorized by three different attributes viz. Annual
Revenue, Industry and Owner and three different cards have
opened up for each of them.

QK 2w [0

e )
Filter -

Cluster Map
Current Location
9 Ay Ct, Staten Island, NY 103
Proximity
® Distance O Time
Miles

O Show Travel Distance

DataSource |
owd

et < Annual Revenue

YR < Industry
« Owner
+ .
Select Catec O Ownership
Account || Annual .. v
Overlay B
voTerpcte [ seach |

Grasselli

Pralls soghiFiE 9
istand

— Pralls isiang sl - = oL Q @
£ Tremiey Point : 9 mlEE Q% - 7
0-300000 B LOwROT @ S @ Q % @
© 300000 - 750000 * Q s \ Q - @
i : Freshiils Park Q ¥ \:; Q 9 99 Q
7 750000 - 1000000 * Q% 9 2
’sag' >=1000000 * ) ! - e % .Q 99 @ .
- - < Carteret g _ el 4 &
fi Account - Industry X % ; % TS @Q Q 7
R A ¥ ¥ ¥ = _Q .Q %
ccount - Owner } X 3 S ¥ Q
Plot Records % = 9 Q 9 g Q 2
: Lower New Yor]
Graat Kills Park
2506 et fim
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Account - Annual Revenue Account - Industry

Select Al Select All
0 - 300000

Banking
300000 - 750000 x

Consulting
750000 - 1000000

O O O

>=1000000 * Insurance

Social Service

Select Al Transportation o
Joe Smith
Sam S

el

William Smith

The category cards shown above states which category is represented by which pushpin. The categories

are represented with the following three different parts of every single pushpin, ﬁf, ©, <

All the above three icons combine to form a pushpin gwhich will represent the plotted records. Each of

the three parts represent three different categories with different colors shown within the category card.

For example, the category card ‘Account — Annual revenue’ shows that the 4 icon represents the

Account records that belong to different ranges of Annual revenue with different colors. The

category card ‘Account-industry’ shows that the icon represents the Account records that belong

to different industries with different colors o and the category card ‘Account-Owner’ shows that
the icon represents the Account records that belong to different owners with different colors.

In case, the user has selected only two attributes in order to categorize the entity records, the
i

O
pushpin that will be used to represent two categories will be <.

The plotting of categories follows AND condition. This means that if the user deselects a category in one
category card, then all the pushpins for records that belonging to that category will be hidden from the
map even if any of the records belong to any other categories as well. For instance, if the user deselects
the category of Annual revenue between 5000-10000, then all the pushpins for the records that belong
to this category will be hidden from the map even if any of these records belong to other category like
owner or industry.
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In the screenshot below, three categories have been selected viz. Annual Revenue, Industry and Owner.

OB Layer Menu

= .
# | Account - Annual Revenue

Select All

0- 300000

300000 - 750000

% 750000 - 1000000

>=1000000

Account - Industry

Account - Owner

Plot Records

Layer Menu

Account - Annual Revenue

Select All

0-300000

300000 - 750000

750000 - 1000000

% >=1000000

- = Account - Industry

Plot Records
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Set colors and shapes for pushpins

The users have the ability to define colors and shape of the pushpins to visualise the records plotted on
the map as per the requirement. This will help the user to differentiate between the records that belong
to different views or categories.

Set pushpins from map

Users can select the pushpin of their choice with the desired color, right from the Detail Map while

visualizing CRM records on the map.

Set pushpins for views

While plotting records using the Plot card, users can select the required colors and the shape of the

pushpins for the records of the view within the Datasource section in the Plot Records card. Once the

color or pushpin are selected, it will instantly reflect on the map.

Layer Menu

! Plot Records

o Q8 2 & B
™
i,

L Current Location
/

Filter o

Cluster Map

Proximity
® Distance i
Miles
Datasource
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+
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Set pushpin for categories

While plotting CRM records along with categorization, user can select the color and shape of the pushpins

and also save the selection for future use. Once the categorized data is plotted, user can go to the

respective category card, change the color and shape of the pushpins and click on ‘Save’ to save the

pushpins selected for future use.

(0 innavative logic
@il‘IDEiC

6@ MAPLYTICS™
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Configure pushpins in Entity map for new category

To set the colors and shape of the pushpins for the categories for any entity, the users have to follow the

below steps:

e Go to Maplytics App > Settings > Entity Maps > select the entity map for required entity > Category
configuration.
account
Entity Map

General Attribute Mappings  Tooltip Mapping | Category Configuration |Configuration Advanced Settings

I +  New Entity Category I O Refresh

V| Name T Entity Map Data Type
industrycode account picklist
revenue account money

e C(Click on the plus ‘+ New Entity Category’ in the subgrid to open the new Entity Category form. Select
the name of the category attribute in the Category text box and save the form.

e The user can select only OptionSet, Two options, Numeric, String, Lookup and Money attributes to
define category colors.

e Colors and shapes will be auto-populated, the user can further set their own preferences.
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Category configuration for users

User can open a category from the Category Configuration tab by going to Maplytics App > Settings >
Entity Maps > select the entity map for required entity > Category configuration. They can change the
colors and shape of pushpins to view the same on the map using the following buttons. If user has saved
some colors and pushpins for categories from the map then those saved selections will be shown here.

e Save B : User can change the colors and pushpins and click on this button to save the selection
° Auto-Setx : This button helps to set the colors and pushpins randomly

e Discard Changes [3 If user has made any changes to the colors and pushpins, they can click on
this button to discard the changes done

e Set to default O: User can click on this to set the selection of the colors and pushpins to default
which has been selected by Maplytics admin or System admin.

Dynamics 365 Maplytics

= € Save J Save & Close MNew Dg. Deactivate C_)'
{1 Home .
- industrycode
C Recent o Entity Category
57 Pinned ~ General Category Mapping  Related
Maplytics
User - Option List Hm o
Viaply D ard...
LT e il e Options Color Pushpin

Entity Maps
Maplytics Templates

Maplytics Cenfigurat...

Assets
Teams Consumer Services
Routes Financial

B
B
B
@A
B Territories
B
"
a
0]

Inogic License Details
nsurance

ﬁ
1 i ) -

Legal Services

H Seiting: C m adie

Category configuration for admins

System Admin and Maplytics admin can also check the colors and pushpin selection in the entity map.
Along with this, they will also have the ability to set the required colors and pushpins for all the Maplytics
users as well. To do this, admins can go to the Maplytics App > Settings > Entity Map > Respective Entity
map > Category Configuration > Select required category.
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Admins will be able to view two Option lists, one for themselves as a user and one for Default selection.
The User Option list will work the same as explained above. The admin can further take some actions
within the Default Option List using the following buttons.

e Apply to all £ : Admins can select the required colors and pushpins and click on this button to
save the selection for all Maplytics users

° Auto—Se‘c:M‘t : This button helps to set the colors and pushpins randomly

e Discard Changes [3 If admin has made any changes to the colors and pushpins, they can click on
this button to discard the changes done.

Dynamics 365 Maplytics

= LS Save J Save & Close Mew D Deactivate @[
{ar Home -
- industrycode
3 Recant o Entity Category
57 Pinned v General Category Mapping Related
Maplytics
User - Option List Default - Option List B >4 I%
Viaply D

= Maplytics Dashba Options Colar Pushpin
=] Entity Maps ank
Maplytics Templat... -

Accour
! Maplytics Configu...

oroker
A Maplytics Security...

Consulting -]
M Territories T
B Assets Consumer Services -
B Teams Financia o
Routes -

r ramn
@ Inogic License Det...

Settings 0

Note:

e Selecting pushpins and saving the selection for categorized CRM data is only available for entities
plotted with single category.

e The selection of pushpins saved will be available for the respective logged-in user only.

e If a category does not exist in the list of categories created in the respective entity map, then
while saving the pushpin selection, the category will be created automatically for all the users.

e [fa user has not selected any preference for pushpin colors and shapes for any category, the user
will be shown the visualization of the pushpins on the map as per the selection saved by the
Maplytics admin or the system admin in within the Default-Option list of the category in the
respective entity map.
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Data Grid in Detail Map

The Data Grid is available at the bottom of the Detail map which can be opened using the yellow button
‘View Data’. All plotted pushpins represent a unique record in Dynamics CRM and data grid helps the users
to access these records from the map screen, filter the data further and perform some mass actions. Order
of columns in the grid depends upon the Dynamics CRM View selected to plot the data and in the case of
Marketing Lists & Maplytics Dashboard records, it is same as that of the Entity-View selected in Entity

Map. The users can also customize the data columns to be visible in the grid by adding/removing columns
from the Entity view.

L.
Layer Menu <
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ey -~
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0305000 ¥ - Teemley Point
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[*] | EtideData | © oo o
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a usa Banking 10306 wwwinogic14285,
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o)« items per page

(262 Selected) 1 - 200

Filter & Sort Data:

The user can use the filter present on the top of every column to filter the data further selecting any of
the conditions and entering the respecting value.
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User can see the filter icon at the column header to understand based on which column the data has been
filtered. Further, user can also click on any of the column header to sort the data and can see the arrow
icon at the column header to understand based on which column the data has been sorted. User can
deselect some of the records and see at the bottom the number of records selected from the list

Accounts - Staten Island {21) o < Related Reco...

[, Account Name Y | Main Phone Y  Address 1: CitD Y  Annual Revenue No. of Employees T | Website Y | Email T
[, Abbas & Sons 7188520069 Staten Island 64801 www.inogic12952.com meird439@inagic.com -
. Abdelmessih & Sons 2122501122 Staten Is\and 259962 200 | www.inogic14580.com michael11030@inogic.c...
®. Abraham & Sons 2127510545 Staten Island 861945 200 | www.inogic14015.com ely10491@inogic.com
H. Adams & Sons 2122068501 Staten Island 763923 200 www.nogic13828.com bruce10306@inogic.com
. Addeo & Sons 2126618995 Staten Island 161278 200 | www.inogic14272.com robert10733@incgic.com
M. Aguayza & Sons 2123082665 Staten Island 378729 500 | www.inogic13856.com david10334@inogic.com
H. Ahmad & Sons 2129205723 Staten Island 132192 500  www.nogic14433.com william 10937 @inogic.com
. Ellison & Sons 2126867933 Staten Island 325947 500 | www.inogic14043.com nader10519@inogic.com
=] [O. Falconite & Sons 7182217672 Staten Island 793294 500  www.nogic13987.com yosi10464@inogic.com -

¥ | items per page (5 Selected) 1 - 21 of 21 items

=
.
v
L 4
w
=1

Reset:
This will reset the grid to the initial search.

Parent Record / Related Record:
This is useful when the user is dealing with plot related records functionality. The user can switch between
child data and parent data using this button.

Resizable Data grid:

Double click on Expand button to view the data grid in full screen. Double click on Collapse
button to view the default size of the data grid. Use can also click once and drag to resize the data grid to
the desired size.
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Highlight pushpins

User can click on any record within the Data Grid to highlight the respective pushpin on the map. User can
also click on any pushpin on the map to highlight the respective record in the Data grid.

Layer Menu <

Proximity

Accounts - Staten island (262)

a

nt Name 4 y

o e TR T e

Mass Action Buttons

The user has the option to take actions on the plotted records like adding to route or executing the
workflow on selected records in the grid. Defined mass actions are as follows:

o Add To Route: This option will add selected data points to the route. The user can add at max 25
data points to the route
e Save Data: The selected records can be saved as static Marketing List or Personal View in
Dynamics CRM
e Change Owner: The user can assign the owner of the plotted records by selecting a user or a Team
e Manage Territory: The User can assign or change the territory of selected records
e Send Email: The user can send a mass email to the selected records. User can select any one the
available email templates or a new email to write their own content. User can also choose to keep
the recipient as To/Cc/Bcc in the email.
Select Email Template.
New Email hd
Select Email recipient
To A
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Select regarding: If user needs to send bulk emails and also wants to keep a specific record in the

Regarding field into the email. They can select the option of ‘Select Regarding’. To view this option,

they can follow the steps mentioned below.

o Open the respective record to be set in Regarding field from the ‘Map’ button on the record.
In the screenshot below, we have taken an Account ‘Gourmet to your door’ as an instance.

Save @ Save & Close b New &% Open Org Chart [® Deactivate "8 Connect | F Add to Marketing List R, Assign [ Email a Link Til Delete
Gourmet to your door () Refresh ast
Account
& Map
Summary Map Details Related 03 Process 5
: 1 9 Geo Code
Account Name* L Search timeline
|# Share
Gourmet to your door Enter a note U
¢ Follow
Phane

o Now plot the required records to whom the mail has to be sent and Go to Mass actions to
choose the option of ‘Send email’. Here, we have plotted Contacts.

LayerMenu <
*
' CECE

Filter ~

- @ : @ =z . z G Sector )
Cluster Map - £

Current Location

Concord Fort Wadsworth
<] Todk Hi

Proximity e .. (2]
@® Distance O Time L4 3
Miles v : = L]

0 Show Travel Distance

® Add To Route
[ X ] Save Data
Q DataSource ~ Change Owner

©4. Coloct Dotaconco

Manage Territory
Send Email

=
® °

Accounts - Staten island (262)

° = Execute
Workflow i

Account Name & y

ADV Hote

S T T T R

items per page

o Once clicked on ‘Send Email’ from ‘Mass Actions’, user can select the option of ‘Select

Regarding’ and the Account that we plotted earlier ‘Gourmet to your door’ will be set by
Default within the Regarding field.
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Select Email Template.

New Email hd
Select Email recipient

To hd

Select Regarding

Gourmet to your door

Note: This option will be visible only if the map has been opened using map button on a record.

o Execute Workflow: The user can execute any on-demand workflow with this functionality

e Export To Excel: The user can use this feature to export data from the map to excel. This
functionality adhere to CRM security roles, if the user does not have the permission to ‘Export
Data to Excel’ in CRM then that user will not be able to export data from Maplytics

e Create Activities: User can create activities for non-activity Entity records currently selected in
“View Data grid.” The user can define the Activity, Subject, Duration, Owner(User/Team) and
Priority. The user can also select the number of activities they want to create from Mass actions.
The activity selected in respective Entity maps can be seen in the Mass actions list under the label
of “Create activities”, by clicking this label below window will open which will list the activity
selected in respective entity map.

e Associate Records: This helps the user to associate a record with the plotted record(s) on map.
To do this, user needs to open the map using 'Map' button on the record they want to associate.

In the below screenshot the Account record is being opened using the ‘Map’ button.

B save @ Save & Close New % Promote 3 Update Geolocation &% OpenOrgChart [} Deactivaste S Connect ; Addto Marketing List &, Assign
e ACCOUNT £nnual Revenue (% Email 2 Link
5. LOUIS RAMUNNI & SONS ] Delete
1] Attach2Dynamics
Summary Kanban Board for Case  Map  Attach2Dynamics  Map My Relationships ~ Area of Service Map  Assets and Locations 4 B clicetport
N () Refresh
ACCOUNT INFORMATION Timeline F v IE }
~ Q Check Access
Account Name * 5. LOUIS RAMUNNI . A2 search timeline :
& map
& Enter anote..
Phone 21710669683 8 . © Check-in
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Once the map is opened, plot the required Entity & View to associate the Account. Now, click on
‘Mass actions’. In the below screenshot, Contacts are plotted on the map using Proximity Search.
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Within Mass Actions, click on ‘Associate Records’to open the window. Here, the relationships
between both of the entities, the records plotted and the record from which the map has been
opened will be listed. User can select the relationship through which they want to associate the
records . Here, the record from which the map was opened earlier has been selected by default.
User can also select another record as per their requirement to associate with the plotted records.

Associate Records x

Select Associate Relationship
Contact (N) : (1) Account (contact_customer_accour
Select Azzociate Record

5. LOUIS RAMUNMNI & SONS

Note: This option will be visible in Mass Actions only if the map has been opened using map
button on a record.

o Associate records with many-to-many relationship: ‘Associate records’ feature can
also be used for many-to-many relationship. Users can associate multiple records of
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an entity with another related entity record. The related entity record can be an
existing or new one.

For an instance, we have two entities Doctor and Patient with many-to-many
relationship. Let’s say, the user opens the record of ‘Dr Danny’ of the entity ‘Doctor’
and clicks on ‘Map’ button to plot the record on the map.

©

innovative logic

imnoGic

Dynamics 365

Maplytics

= < E B sae @& Save&Close New [ Deactivate [i] Delete () Refresh @ Check Access | Map | & Assign 12 Share
@ Home
- Dr Danny
G Recent v Doctor
s Pinned Y General Related
My Work
Name * DrDanny
¥ Dashboards
[ Activities Owner * R samRoy
Address1
Customers
Accounts Address2
2 Contacets
Latitude 1899117
sales longitude 72.82208
& Leads
[1 Opportunities
B quotes
| £ Doctors
&% Patients
4% DoctorPatients
a-- e

Now in the map, user can choose entity Patient as Datasource to plot multiple patients
on the map. In this case, the Active patients are plotted.

Maplytics - Detail Map

Layer Menu < gt o) v " > D “.;
Mike @
curr
® Dista Time . Saki Naka
Miles v ma|  Vile Parlé
ataSource =
]
= Santa Cfuz
+
Select
3 s v . Kurla
\ 8z Rive
Overlay
Bandra W
=] »
Dhara

Now user can click on a record of Patient and select the option of ‘Associate Records’ from
the Tooltip card to open the window. Here, select the relationship Patient N:N Doctor.
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Associate with Existing Record: This option can be selected in order to view the list of the
Existing Records of the Middle Entity. Here select a record from the list and ‘add’ to
associate the records of the Entities Doctor and Patient.

Maplytics - Detail Map B X

Associate Records

ationship

DoctorPatient (patientid)]

Lookup Records X
Select record

] Or Dan_Mike X

Note: Associate record for many-to-many relationship can only be performed through
the tooltip card and cannot be performed from the Mass Actions.

e Auto Scheduling: This can be used to create a schedule for one or more users automatically. Refer
to the section of Auto scheduling to know how Auto Scheduling works.
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Tooltip Card

User can click on any pushpin to open a tooltip card.
This card will display the data like Address, Account
name etc. along with the Image set for the record.
These attributes and image can be configured within
the Tooltip Mapping section of the Entity Map so as to
show on the Tooltip card.

¥ R WALTER PRATHER

= DIRECTION =¢ SETASCU.. =p SETASP..

280N F SstAs Origin IN ISLAND NY
UsA =+ Set As Destination
=+ Add To Route

Full Name: = WALTER FRATHER
card.

Email: some_26443@inogic.com

Business Phone: 5183734439

Take An Action

COOROOE

User can also click on the pushpin of that contact to
open the tooltip card to view the respective image on
the card.

(ﬁ“:’))u-liiﬁ’fik&ic

3 R WALTER PRATHER

= DIRECTION =p SETASCU... = SETASP..

280 MEREDITH AVENUE STATEN ISLAND NY
USA

Full Name: R. WALTER PRATHER
Email: some_26443@inogic.com

Business Phone: 5183734439

Take An Action

COCHOOE

6@ MAPLYTICS™

User can also set a particular record as ‘Origin’,
‘Destination’, ‘Add to Route’ under Direction, ‘Set as
Current Location’” and ‘POl location’ from the Tooltip

Ricky Miller

= DIRECTION =»SETASCUR... = SETASPOIL..

~

w

14606 135th Ct NE King Co. WA 95072 U __.

Full Mame: Ricky Miller
Business Phone: 4088761236
Company Name: Francine Duran

Take An Action

CO2BOOE

Page 52 of 284




Maplytics™ — User Manual

m Moreover, the user can hover on the image appearing in tooltip

ﬂ card to zoom in the image.
(CUR... =» SETASPOI_]

Co. WA98072 U...

Full Name: Ricky Miller
Business Phone: 4088761236
Company Name: Francine Duran

L

Take An Action

| OOOO0O®

Quick Call to Action Buttons

User can associate quick action buttons. This helps in saving time while switching between screens to take
actions. First four actions are the default actions and cannot be changed by the user. User can further add
actions for creating records for activities and related entities. The default records are as follows:

e Change Owner D) : Assign an owner to the respective record by selecting a user or a team
e Open Record O): Open record directly from this screen to edit any field

e Plot Related Record &2 : Plot One-to-Many Relationships/Related records of a particular record as
shown below:

Plot Related Records

Select the relationship to plot related record

[J account - contact (contact_customer_acco

[ account - iki_checkinentity (ikl_account_iki..

O account - lead (lead_customer_accounts)

Select the required relationships from the list and click on ‘Plot Records’ button. Related records will be
plotted as shown below. Use ‘Parent Records’ button to switch between Parent and Related records data
points.
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e Run workflow @& : The user can execute on-demand
workflows on an individual record. When clicked on this Execute Workflow
button, it will open a window which will list down all the
on-demand workflows available for respective Entity as

Select Workflow

shown below: nogic.Maplytics. Assig Norkflow v
Inogic.Maplytics.AssignTerritoryWorkflow
Inogic.Maplytics.GeoCoding
CATLULE

The user can customize the rest of the actions according to their requirement. For example, user can add
Email, Add Task, Appointment and Quote and many more.

e Email €): Send email to this record * M. WILLIAM ROCKWELL & S...

e Add Task(Z): Add task to this particular record

. . . . = DIRECTION = SETASCU... =p SETASP..
e Appointment &): Schedule appointment with this record .
e Quote(®): Create Quote related to the plotted entity record 8A at FRANKLIN LANE Staten Island

The user can define these actions under ‘Advance Settings’ in Account Name: M. WILLIAM ROCK)

Entity Maps. Go to Setting > Entity Map > Select Required Take An Action
Record > Advance Settings > Tooltip Card Actions or refer to

‘Setup Entity Map’ section of Installation Manual for further @@@@@@. -

instructions.
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Hover

User can hover on Dynamics CRM Records plotted on the map to have a quick glance at its details and the
record image. The user can have a maximum 6 different attributes here apart from the title attribute.
Refer to the ‘Setup Entity Map’ section of Installation Manual for steps to configure attributes and image
on hover.
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Reset Map

User can use the button of ‘Reset Map’ to reload the map with the initial Detail map

settings.

Note:
e This action will clear all the data plotted on map
e The refresh map button will show the same data on the map in the following conditions:
o Expanding the map or plotting a route from a dashboard
Using the map button from an individual Entity record page
Plotting a route or a template
Plotting records by selecting the records from the Entity records page
User had set a default template for the Detail map

O O O O
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Summary Card

The user can click on any enclosed area to get the summarized information of the plotted records in that
area in a summary card. The area clicked will get highlighted and the respective data will be visible in the
data grid. The user can customize the settings for this under the Summary card section in the respective
‘Entity Maps’. Refer to ‘Setup Entity Map’ section of Installation Manual for further details.

EOM Layer Menu <
v&f | Territory List
T s e

& (@ Linden/ y

7

e A v ( : /

e . /) /

%@’ & Sy < E NEW mi@
& y
3 @) Z

= Area: 39.17 Square Kilometer $ Rahway ff‘ ‘o

~garwaym AN
~ " Territory Name: 10314 e V- e \

A o S

L Manager: Robert Butler TIEXS, f

4 2

~ Take AnActi & 7
£l eAnAcuon & Avenel

7 Carteret
§ OO 4

Port Reading
Total Records: 37 &

/&
¢ a% Sewaren
\ Account - (Accounts - Staten island): 37 <
Avg. Annual Revenue (Average): )t
$295,405.41
Sales (Sum): $12,080,090.00
Sum Annual Revenue (Sum):
$10,930,000.00

”(z:’/w PR
o 0/ R
&

b Bing ‘

Lower New York Bay

9

William

DunfaprHomes

j—ﬂl’[‘ L.

Sieisuspis

1 miles 1km
Raritan | [E View Data |

182021 Tomjom. € 2021 Microsoft Corporation erms.

With territories plotted on the map, Summary card also provides a button to ‘Open Record’ that can be

used to open the respective territory from the map itself and ‘Change Manager’ to change the Territory
Manager for the selected territory.

10314

Area: 39.17 Square Kilometer
Territory Name: 10314
Manager: Robert Butler

Take An Action

oo

Total Records: 37

Account - (Accounts - Staten island): 37
Avg. Annual Revenue (Average):
$295,405.41

Sales (Sum): $12,080,090.00

Sum Annual Revenue (Sum):

$10,930,000.00
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Layer Menu

This helps the user to select the required data among the multiple data plotted on the map. The user can
use the toggle buttons on the Layer menu card to show or hide the required layers of the data to be shown
on the map without removing the same from map.
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Note: Layer menu card is collapsible but a user cannot close this card exclusively.

The layer menu card will show the following icons for the respective layers mentioned:

Layer type Icon Layer type Icon

Data source ® Territory I,j
9

Route .n. POI @

Proximity (@. Cluster Pushpin @

Drawing Shape Shape Operation ‘

Region Shape

Overlay- Shape file

Plot-child

?

Territory Management —
Shape file

Note:

e Layer icon for Data source layer, POI layer and Plot-child layer will change depending upon

pushpins visible on map

e [fcategory is selected in the plot card, the layer menu card will show only the default pushpin

for the Data source layer

) innavative logic
@il‘IDEiC
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Show/Hide Labels

User can click on the ‘Show label’ @ button to view the labels for the pushpins, regions as well as
territories plotted on the map. User can again click on ‘Hide Label’ @ to hide the labels showing on the
map. The option for showing/hiding labels is available for every individual layer of data plotted on the
map.
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Show/Hide Territory List

With territories plotted on the map, layer menu
will also show an option of Show/Hide List for the =
@ Territory Layer i=
layer of territories. User can click on the —" v -8y m
show/hide list button *= option to open the list
of territories plotted on the map. B @ AllAccounts @
":‘.\' . -
ol s User can select or deselect the territories which are
Select Al Actions ~ required to be plotted on map. User can further

change the name, select a color and select the
. manager for the respective territories and also save
|ﬁ\L. USA ‘ ; 3 . K the same with the ‘Save’ button within the ‘Territory

List’ card.
AR, UsA e . 3
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Download map

Using the Download map button, the user can download the
map as visible on the screen.

78 Layer Menu

Account - Address 1: Count...

Note: Download map is not supported for Internet
Explorer.

This helps the user to get the map download for using offline.

Plot Records X

% Houses

W
seagate West Brighton
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If the user has plotted data with categorization, the map will be downloaded with a legend showing the

categories.
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Non-Durable Merchandise Retail
Social Services

Transportation

Page 61 of 284




Maplytics™ — User Manual

Contextual Menu

User can right click on the map to open Contextual menu. It provides
commonly used features in Dynamics CRM like creating a new record, set Create New Record
origin/destination or selecting map zoom level on the map, etc. The
contextual menu provides the following options:

Directions |
Add To Route

Set As Current Location
Set As POI Location
Save Settings | 2
Show Territory

Create New Record:

User can right-click anywhere on the map or POI result e —— - x
icons and create a record for that particular location. This
will save the record with the details of the address and
the geo-coordinates (Latitude & Longitude).

What would you like to create?

Note: Create new record option will not available Ecccmt
ontact
for existing record pushpin Lead
Directions:
e Set As Origin: This option will set the address of the pushpin/map location as the start location of the
route.

e Set As Destination: This option will set the address of the pushpin/map location as the end location
of the route.

Add to Route: This option will set the address of the pushpin/map location as a middle waypoint(s) of the
selected route. For example, the user has selected Point A & B as orgin & destination respectively for a
route and now clicks on the ‘Add To Route’ option, the Point B will remain as the destination and will
become the Point C. The address of the selected pushpin will become the Point B of the route.

Set as Current location: User can click on any pushpin or anywhere on the map to set the address of the
pushpin or the location as the current location respectively, which can be used for Proximity search.

Set as POI Location:

This option helps the user to set the location for the Point of Interest (POI) searches like ATMs, restaurants,
Airports, etc. Setting the POI location, user can search for various Geo-tagged & Bing mapped locations
around it.

Save Settings:
User can save the default settings for the following options. These settings will be saved in the

Configuration details record of the user:
e Current location: This will save the location as the default current location.
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e Map zoom level: This sets the zoom level and map center for the Map. After this setting is done,
whenever the user will open the Detail Map, it will be zoomed down to the location set here.

e Origin: This sets the location as the default origin.

e Destination: This sets the location as the default destination

Show Territory:
User can right click anywhere on the map or at any record to select the option ‘Show Territory’ from the

Contextual menu. This will plot the respective territory to which the selected location or the record
belongs to. Further, user can click on ‘Hide territory’ from Contextual Menu to hide the plotted territory.
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User can also click on any pushpin to get a contextual menu. Along with the

Open Record
options mentioned above, this will provide the following options:

Directions [
Open record: User can open the record form right from the map and can Add To Route

further edit the details for the record. )
Set As Current Location
Actions: User can perform the following actions on the pushpin selected: Set As POI Location
e Add Task: This option helps the user to create a new task in Dynamics Actions >
CRM regarding the selected record.
e Schedule Appointment: The user can use this option to create a new
appointment for the selected record. Show Territory
e Manage Territory: The user can assign/re-assign a territory to the
selected record from the map and hence can manage the territory.

Save Settings -
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Multi-Address Plotting

If the entities in CRM contains more than one addresses, users can plot the records based on multiple
addresses at once. This feature will enhance the visualization experience of those records that have
presence in multiple cities or states etc. Admins can configure required addresses within the Entity map
of the entity so as to view the option of selecting the addresses to plot the same on the map. Please refer
to the Entity map section of the Installation manual to know how to configure multiple addresses in
Maplytics to plot records based on multiple addresses.

While selecting the Datasource and View within the Plot records card, user can click on the ‘Select address’

@ to select the addresses based on which they would like to plot the records. This will open the window
that lists out all the addresses saved within the ‘Address Attribute’ Section of Entity map. User can select
the required addresses and click on Search.

Note: The icon for ‘Select Address’ & will only appear if multiple addresses are configured in the
Attribute Mapping section of the respective entity map.

Select Address x

Select Address

(] Billing address

[ Shipping address

The below screenshot shows the Accounts plotted based on the two addresses, Billing address and
Shipping address. Here 4 records have been plotted and due to the two addresses of each of the records
the map is showing 8 pushpins in total.
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@ Distance O Time | < ( ((
Miles ¥ |

Fairmount *

O show Travel Distance

——Fort-Osage.

| DataSource A P
gu | Tonganoxie

De Soto
Account || SelectC.. v

= Sunflower
Accounts - Kansas (8)
M. Account Name Y | Main Phone Y | Address 1: City Y | Email Y | Status Y | Address Name &

@& .. Gourmet foods 9864627622 Shawnee Julie@gourmetfoods.com Active Billing address =
& .. Gourmet foods 9864627622 Shawnee Julie@gourmetfoods.com Active Shipping address
B .. Electro Power LLC 9865727212 Kansas City Brunn@Electropower.com Active Billing address
3R .. Electro Power LLC 9865727212 Kansas City Brunn@Electropower.com Active Shipping address
=] .. Bolt Fencing solutions 9857267287 Kansas City PeterJ@Bolt.com Active Billing address
@& ... Bolt Fencing solutions 9857267287 Kansas City Peter)@Bolt.com Active Shipping address
=] .. Woodgrove Bank 9867825611 Kansas City darren.parker@woodgroveba... = Active Billing address
=] .. woodgrove Bank 9867825611 Kansas City darren.parker@woodgroveba... = Active Shipping address =
AL EAY) |BCEE ftemspecpage (8 Selected) 1 - 8 of 8 items

adslof>/ “Orrick ! Road

Stranger
Select Datasource
[ g & : :
Accour ¥ | | Accounts - v @ Reno &~ \* \ i
Bolt Fencing i 5 = msp'rmgs
solutions (e S e T ey, 70
; select Category : Oak Grove Odeses

The Layer menu will list both of the addresses, the Billing address and the Shipping address for Accounts.

<

m @ Accounts - Kansa... |

m ® Accounts - Kansa... L

. . ===l Accounts - Kansas- Shipping- address ;

While working with any enclosed shape like proximity, drawn shape or a territory, user can click on the
enclosed shape to view the Summary card. The below screenshot shows Proximity search performed on
the above Accounts that were plotted based on two addresses Billing address and Shipping address.
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Total Records: 7

Account - (Accounts - Kansas): 4
Annual Revenue (Average):
$39,766,797.00

No. of Employees (Sum): 56,940.00
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;‘. am o NEIGHBORHOOD \ —
UNITED FOR
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| [@ View Data Leawood ©2021 TomTom, & 202 @SR Corporation Terms

With the click on the outer circle it is showing the

. the summary card, Fruximity 2 : 9 Miles
the Total Records will show the count based on the

Summary card for the same. Within

total number of pushpins plotted
pushpins in total.

The second section of the Summary card shows the

classification of the count of record

types of the addresses i.e. 4 pushpins are plotted
based on the Billing address and 3 pushpins are plotted

based on the Shipping address.

In the third section, it shows the summary of the
Annual revenue and the no. of Employees based on
the actual(unique) count of the records plotted i.e. 4

Accounts.

@in'&?ﬂ“ &

on the map i.e. 7 Area: 660433871.71 Square Meter
Total Records: 7

s based on the two
Account - (Accounts - Kansas)

Billing address: 4
Shipping address: 3

Account - (Accounts - Kansas): 4
Annual Revenue (Average):
$39,766,797.00

No. of Employees (Sum): 56,940.00
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Point of Interest (POI) Locations

User can search for any geo-tagged Bing-mapped locations called points of interest (POI) like ATMs,
restaurants, hotels, coffee shops, etc. near a specified location. This can also be plotted alongside the CRM
data. User either can right-click on map to set the location as the POI location or can directly enter the

required location in the POI card.

| Plot Records

A | por

9all PO!Location

|
[0 [cameerweLL BusINESs CenTRE © 9

Nearby

| 0008060

Directions
Add To Route

f \ . 4 "\ cm‘slehurstM’

ST MARY CRAY

), T
L e

User can either click on any of the POl icons or manually search for required POI location by entering the
respective keyword in the search bar.

]

4 Road

Plot Records

POI Location

‘ 84 Beard St, Staten Island, NY 1031 ‘ 9

Nearb)

QOEHCO®
[Dentisll ]
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Based on the selected POI location icon or the entered keyword, the results will be loaded.
4 >

Note:

2655 Richmond Ave, Staten Island, NY, 103

(718) 370-3529
https://restaurants.applebees.com/en-us/ny

Burger King
. 2557 Richmond Ave, Staten Island, NY, 103 |8

b Bing

Marsh Ay,
3
3

I [ View Data |

Roc,
@ Layer Menu Ko AL
il &/ (%
5, gt S,
-.g| Plot Records < %
24
POl g o 3de
= Tompkins
5 " N \\‘L & Sehool ;
Dentist & 5 % ¢
, = oo o NG
i © &
@ o :“ A & Rockland'’AVE
Casa Verde Restaurant & 2 7 7 =2
3471 Richmond Rd, 3471 Richmond Rd, St ] f ‘e 2 TS
. (718)980-1049 oy :e“ :\ g
http://www.casaverde.biz/ @ & Parshin Dental %Oq“ 2
Bario's Pizza reshkills Park "0/1
446 Nome Ave, 446 Nome Ave, Staten Islar %
(718) 370-0100
http://bariospizza.com/?utm_source=organi \C@
20
Applebee's Grill + Bar @@ ¢
h
S ;5 &
3
<&

La Tourette Golf Course

The option to enter a keyword to search POI locations is only available while searching in USA.

For each POI location search, only 25 locations will be plotted on the map.

Latourette Park

Apart from plotting POI data, user can also add the plotted businesses in Dynamics CRM record as leads,
accounts, contacts, or any custom entity by using the Create New Record option in the POI card or

Contextual menu. (Refer to Contextual menu section)
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Proximity Search

User can search for the nearby records around a required location using Proximity Search. This will help
the users to understand the proximity of the nearby records in regards to the selected location. There are
two different options to perform a Proximity Search:

1. Proximity by Distance

2. Proximity by Time.

Current Location: User can select any location or a record as the current location. This is used to specify
the center point for the Proximity search. By default, this field displays the address stored in the Maplytics
personalized record of the logged in user. This is always represented by a green color pushpin on the map
and also indicated right next to the current location message box.

Proximity by Distance

This option will calculate the straight-line distance between the current location and all the points which
fall in the proximity parameter as shown below:

- Kingsland
£ | Plot Records < i
Q £ W sal Rise e L
o L > Regents Park Islifigton
A Ibur 2 e

L
=] Regent's Park % el Grays Inn = SHOREDITCH SRS :ei‘.Lcjﬂ‘a:e

North Maryiebone -

L e =2

[th Kensington South Marylebone

Coalmakers W

Osh Holland Park JADWE
NORLAND English Heritage Company = U &
= Hyae Park Line-of-Sight Distance: 0.70 Miles . =
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Kensington o2 Annual Revenue: €500,000.00 FRRSIDE
3 L % cnad Surrey Docks,
nsington ANS
S \ (2] North Lambeth "¢ 50roug" .
— SoUtH Kensington ; o
vern QUdy
[ Axane]
Lambeth & E
Thames
(&7 2\ e e
WORLD S EN Nine Eims - — AL
Walham Green Batterses Dark = — R
& ) T . f
i South-Lambeth Peckham
bt Camberwell__g=
L = View Data ©2021 oo

Enter the radius for the Proximity search. The user can also add decimal values with a scale of 2 for the
radii. The Proximity can be provided either in Miles or Kilometers. The User can also hover over a pushpin

and see the distance from current location.
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Concentric Proximity Search

This new addition to Proximity based on Distance allows users to perform up to 3 proximity searches
simultaneously. The user needs to enter the distance values separated by a comma (,) and all the points
that fall in the defined proximity parameter will be plotted.
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The Concentric proximity zones are represented by different colors for easy visual analysis. The user can
also click on individual proximity zones to highlight the circle and open the Summary Cards for that

p

roximity parameter.

The user can also filter the data points based on the proximity zone and their proximity distance from the
current location in the ‘View Data’ grid.

Accounts - Staten Island (130) ZJReset | & Related Records | - Mass Actions
¥ | Account Name Y | Primary Contact Y | Main Phone Y | shortest Travel Distance T | Line-of-Sight Distance Y | Proximity Zone A
=] @ | Abbas & Sons 7188520069 25 184 2~
&= @ | Abdelmessih & Sons Abraham McCormick 2122501122 204 132 2
¥ | Adamita & Sons Adrienne McMillan 2124180645 0432 0.39 1
@ | Adams & Sons Benno Kurmann 2122068501 1.55 11 2
¥ Aguayza & Sons 2123082665 3.21 2,96 3.56
= @ | Aiello & Sons 2128165282 388 285 356

Note: User can enter integer value from 0.1 to 2000 for distance proximity search.
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While performing Proximity Search by Distance or Time, if the user wants to see the actual travelling

distance from the current location till each of the individual pushpins, they can select the checkbox of

‘Show Travel Distance’ to view the Shortest Travel Distance on the hover and view data grid.

Accounts - Staten Island (103)

Y | Pnmary Contact

& %o

td

W  Abdelmessih & Sons
W | Adamita & Sons Adrienne McMillan
v

Adams & Sons Benno Kurmann

Show Travel Distance for Truck

Plot Records
Q8 2™
Filter ”~
Cluster Map
Current Location
9 Amy Ct, Staten Island, NY 103 o
Proximity
@ Distance O Time
1,23 Miles hd

Show Travel Distance

Select Asset

Select Ass v || Select Haz v

Datasource ~

Select Datasource

Accour ¥ | | All Accour v | @ .

Select Category

Note:

A

= pased s

Main Phone Y |Shortest Travel Distance v | Line-of-Sight Distance Y  Proximity Zone T

184

Once the user selects the option of ‘Show Travel Distance’, user
will get an option to an Asset and Hazardous material. This will
provide the list of the assets created in the Asset entity within
the CRM. If the user wants to search for the shortest travel
distance for truck, they can choose to select the respective
Asset and if any Hazardous material is being carried out or select
none from the following list:

e Combustible

e Corrosive

e Explosive

e Flammable

e Flammable Solid

® Gas

e Goods Harmful To Water

e Organic

® Poison

e Poisonous Inhalation

e Radioactive

e Other

® None

e If user has not selected any asset here, by default, the travel distance will be calculated as

per driving by car.

e The feature of ‘Show Travel Distance’ based on driving by truck uses a separate key. Every

time the travel distance is searched based on driving by truck, 3 transaction limits of the key

are consumed for each pushpin that appears within the proximity.

(0 innovative logic
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Proximity by Time

This option will calculate how many points fall in ‘x’” minutes or hours of driving distance from current
location. The Proximity can be provided in either Minutes or Hours. The User can also hover over a
pushpin and see the distance from current location.

08 ‘ Layer Menu

g Of 2™E
| Filter
O Cluster Map
Current Location
|2 Amy ct, Staten stand, NY 103 | ®

Proximity

O Distance @ Time ot

@® with Traffic O without Traffic i 5t West Brighton

} 15 |[Minutes v/

[ show Travel Distance

~ DataSource

Select Datasource

[ Accour v ‘ [ Accounts - v ‘ Q .
+

Select Category
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Overlay

This helps user to view the Dynamics CRM records along with
shape/excel files and existing territories plotted on the map. User
can also view the ‘layer menu’ to select or deselect the layers so @ & 2 W [

as to show or hide the same respectively. Using Overlay user will ' o
easily be able to understand and analyze the data spread in
required shape file regions and territories.

Filter v
Datasource ~
Select Datasource
User can select the following two options:
e Territory — This option helps the user to select among the
list of existing territories
e File—This option helps the user to select among the list of
shape/excel files. The file should be in a territory in order
to be visible in the list.

Accour v | | All Account v | '@ .

+

Selact Category

Account Select.. w

Overlay ~

Select Overlay

Select Overla v

0
Territary

File

User can select the option of Territory and select the territories they want to plot. Along with this, they

can also select any datasource & view. This will help them view the datasource records along with the
Overlay of territories selected.

Overlay by Territory

Territory List

E 3 ve
)
port Re

9 | Plot Records
ol

Datasource

Select Datasource
Accour v || All Accour v| @ .
+

Select Category

Account || Select.. v

Overlay

Select Overlay

Territory v

10307, 10308, 10309

2500 fest 14m
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Overlay by File

User can select a excel/shape file saved in CRM to plot the same on the map. Further users can select the
following options as well.

Category Attribute: An attribute can be selected to categorize the regions plotted by file.

Summary Attributes: One or more attributes can be selected to show the same in the Summary card. The
attributes selected within the ‘Configuration’ of the saved file in the Territory Entity will be selected by
default. User can deselect them in the plot card and can select other attributes.

Users can also uncheck the option of ‘Plot All Regions’ if they do not want to plot all regions from the file.
In this case, they can right click at any location on the map to select the option of ‘Show region’ from the
Contextual Menu. This will help them to view the region for the respective selected location. User can
again click on ‘Hide Region’ from the Contextual Menu to hide the region for the respective selected
location. Further, user can also open the respective territory within which the file is saved using the ‘Open
record’ button on the Summary card.

Layer Menu
o — = —
& | Census data - States in USA - ...

Select All

< 1000000

Covse

WY I

1000000 - 2000000
> 2000000 L CIOREN |
Area: 180711.93 Square Kilometer
Name: Missouri

Plot Records

: .| Directions | 2
| Add To Route

| SetAs Current Location
Set As POI Location

/'j Hide Region o

22 Save Settings

Show Territory
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Save Shape/Excel file in territory

A file should be saved in a territory in order to be visible in the list of the files to be plotted as an Overlay.
Follow the steps mentioned below to save the shape/excel file in a territory:

Go to Settings > Business Management > Sales Territories > Create a sales territory > Save
Go to Territory Map Preview > Select Option > Shape file/Excel file > Save

Dynamics 365 Maplytics

= < E] Save EJ Save & Close T New ]E Delete O Refresh Q Check Access @R Convert To Territory 03 Emailalink 2 Flow
2 New York_shape file
ﬁ Territory
B General  Define Territory  Territory Map Preview Configuration  Related
B =

3.

S >
. ‘Roxbury Bover

Huntington
o Station Comm@
=
= {-centra
B @/ood
=
st W\ e
= :
o 3 Lt reat Sout|
5
ﬁ Freeport =3
& / Oceanside 5 ]
Plainfield Joness =
0 _Beach
sndge\vg{& o Long Beach
Somerville & )
Manville =
Franklin
Hillsbs h
R New Brunswick o4

ﬂ =] Active Save

Save Shape file
Within the Territory Map preview, user can select the option of ‘Shape file’ and select the color to view

the regions in the same.

©

Wigan-England
Territory

General Define Territory ~ Territory Map Preview Related

Shape File v

Choose File | Wigan_kml

Supported file type: .shp, .kml and .geojson
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Save Excel File

Within the Territory Map preview, user can select the option of ‘Excel File’ to select an excel file to the
territory. User can also select the color to view the regions in the same. They further need to select the
following options in order to save the excel file as per their requirement:

Select Region Type: User should select the region type based on which the boundaries of the regions from
the excel file is to be plotted.

Select Region Value: User needs to select the column from the excel file that contains the values for the
selected Region Type.

Select Main Region: User needs to select the column from the excel file that contains the value for the
biggest region for the selected Region type in order to plot the regions accurately. For example, if the
Region type selected is Postal code, so the Main Region should be preferably Country. If the column of
country is not available then the column with the values for respective States or Cities can be selected.

Wigan-England

Territory

General Define Territory  Territory Map Preview Related

Bayonne Upper PARK SLOPE > D ]

Excel File 4 i (=
e f Elizabeth & New York

| Bay
Choose File | Staten ...es xlsx

-y
8
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&
&

Staten

Select Region Type Linden

%,

Gap,

Postal Code v

a8 PARKVILLE @
&

=

&

. BERGEN BEA

5 Rahway )
¢ gFloyd
zip v Bennett
Field
state_name aaf &
Fort
Tilden
v
oxe 9 Lower New York Bay
(220
[

River
New Brunswick; &

Raritan Bay
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Convert Overlay to territory

O] | Mew [il Delete () Refresh [ Convert To Territary 21 Email a link o

User can use this button to convert an overlay record
to a territory. After the overlay record is converted, it @ TERRITCRY
becomes a territory which can be searched in the USA Census by State
option of ‘Territory’ in Overlay.

General Define Geography  Configurations  Territory Map Preview  Relatsd

Territory Name “ USA Census by State

Note:
e Supported file types for shape files are .shp, .kml and .geojson and excel files are .xlIsx, .csv
e In a territory, either a shape/excel file can be saved or geographies can be created
e Only one shape/excel file can be saved in one Territory
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Census data Visualization

This feature helps the user to visualize census data on the map. Census data provides the information
about the population for a whole country or parts of country. Visualization of this data on Maplytics will
help the user to analyze various information of the required area in a country like Housing units, Area
land, Area water, population demographics, etc. and take strategic decisions. A few census data are
available by default within Maplytics. These default census data are provided by Bing maps for USA. User
can also plot their own census files on the map which contains census data. User can configure categories
to see colored regions as per the configuration and also configure attributes to see on Summary card and
hover on region.

To plot the census data, user can choose the option of ‘Files’ in the feature of Overlay. Please refer to the
section of ‘Overlay’. Further users can select the following options as well.

Category Attributes: An attribute can be selected to categorize the regions plotted by file.

Summary Attributes: One or more attributes can be selected to show the same in the Summary card. The
attributes selected within the ‘Configuration’ of the saved file in the Territory Entity will be selected by
default. User can deselect them and can select other attributes.

GREENLAND
(DEN)

DataSource A
Davis

Select Datasource

v || Select Viev v

(P
of Alaska

CANADA

Pacific

Atlantic
Ocean Atlanti

Ocean

Sargasso Sea

MEXICO CuBA
Philiy 4 HATL  pg MAURIT
'sy

GUATEMALA

Hol Caribbesn Sea
NICARAGUA e

"\VENEZUELA 500 miles 1000 m
b Bin: = GUYANA
9 & View Data COLOMBIA |, ©2021Sabinfode 2021 TomiTom, € 2021 Microsoft Corporation Terms

Configuration for Census data

User can configure the Census files provided by Maplytics in the Dynamics CRM. Please refer to the section
of ‘Configure’ in Installation manual for the steps to configure. This will save some census files in CRM
provide by Maplytics.

While configuring the census data into Dynamics CRM, territories will get created within which the
respective census data will be saved in the form of geographies. To view the saved census data, Go to
Settings > Business Management > Sales Territories. Following are the territories for census data saved
on configuration:
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e England-Cities

e Germany-Postalcodes

e NewVYork-Postalcodes

e USA 111th Congressional Districts
e USA Counties

e USA States

e USA-Postalcodes

Configuration for attributes

User can configure the attributes available in the census data/shape files to show on the map, create
categories for attributes and select the colors to visualize the categorized data on the map. This allows
the user to frame the data how they want to view on the map.

Go to Settings > Business Management > Sales Territories > Territories with census data/shape files
saved > Configuration

e Attribute Configuration:

o Summary Attributes:
User can select the attributes to show on the Summary card shown on the click on the
regions in the census data/shape file plotted on the map.

o Hover Attributes:
User can select at a maximum of 6 attributes that will be shown on the hover on the
regions in the census data/shape file plotted on the map.

o Data grid Attributes:
User can select the attributes from the census data/shape file to be shown as columns in
the data grid in Detail map.

4 Attribute Configuration

Summary Attributes Actions Hover Attributes Actions Data Grid Attributes Actions

+
+

Name Name

Population

& = 8 +

Population

Area_Land

e Category Configuration
User can create categories for the attributes in the census data/shape file. Creating categories will
help the user to view the categorized census data for the required attributes in the desired colors.
Some categories are provided by default for configured census data. User can click on # new New
button to create a new category for any attribute. User can also click on # ‘Edit’ and T ‘Remove’
to make changes or delete the existing categories respectively.
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Create Categories + New
Mame Actions
Population AT
Area_Land i}
Area_Water i}
Pop_Overl6 i
Pop_Male_Overlt i}
Pop_Female_Owverlf AT

= Create filters and define colors
After clicking on Edit/New button, user can filter the attributes and define colors for the
ranges of the filtered attributes.
Attribute: This shows the name of the Attribute for which the category has been

o

o O O O O

Attribute
Attribute
Population
Population

Population

innavative logic

imnoGic

created/will be created.

Display Name: User can type a name for the category which should be displayed in the

list of the categories.

Save: User can click on save button to save the changes made.

Discard: User can click on Discard button to discard the changes made.

Filter: User can set various filter conditions for the category.

Value: User can set values for respective filters set.

Color: This can be used to set colors for individual filters set. The user can click on the
32 Auto Set button to set random colors for all the values.
Add/Remove: Click on Add or Remove to add a new filter or delete the filter respectively.

Population Display Name |Population

Filter Value

H = X

Color Add Remove

|Is Less Than Equal To v| |1E|E'UE'DE|

|#aad3‘. + x

| s Between v/ [ 1000000 | = [2000000

|-+ x

|Is Greater Than Equal v| |EUG'UG'EHJ

|-+ x

6@ MAPLYTICS™
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After the user has created categories, user can plot the census data along with an attribute selected to
visualise the categorised Census data on the map as shown below:

Census data - States in USA - ...

Select All

< 1000000

1000000 - 2000000

> 2000000

Plot Records
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Shape Operations

©

With the help of Shape operations, users can perform Binary operations on the shapes drawn on the map.
These operations can only be performed under the Search option of ‘By Drawing’ in the Plot card and
Territory management section. Please refer to the section of Territory management for the shape

operations in Territory management.

User can open the ‘by drawing’ search option and right click on the shapes and can choose the option of
‘Shape operations’. The following five operations can be performed on the shapes:

Difference

This highlights the shape(s) obtained by subtracting the overlapped ones from the selected shape

Plot Records

& 2Q™[E

5 Filter «

Cluster Map
Define shapes

#) &1 (o) (0)(#)(~ .

Accour V| | Select Vie\ v

S+

/““
(&}
dwins National Park Authority

Select Category

innavative logic

imnaGic

7, Woking
Datasource -~ = — m 4 J
m”‘; ?uil'aford
= Select Datasource North Downs

Account || Select.. v
[
S ePReD _ - ok South Downs
j{ Natigriar park \_kv\:/raterlooville
8 ) e &
b Biﬁggwood Fare *E0™ " Chichester

” Hertfor
lint Alban§ {

bt |
R Sl o

/
(8

Horsham

Worthing |
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) ="Harlow

Witham

Chelmg@rd

) . =
[ wattord Loughton\ _Millericay
=3 o ] Breritwood Riyleigh
Basilr}pg.
= o /- ‘Southend-on-Sea
= London [t Canvey

Island

Page 82

Clactonron> ! Road

OO @

Herggﬁgy:ﬁ Margate
Whitstable Ramsgate
~“Canterbury
8 Create New Record Deal
Shape Operation P Difference
: Dover
Directions P | Intersection 7 rz0 P
Ikests
Add To Route Union s
Set As Current Location | Union Aggregate
Set As POI Location Disjunctive Union
Save Settings | 2
Bexhill _Hastings UNTe R
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Intersection

This highlights the shape(s) where the selected shape and other shapes overlap.

2 ‘ Layer Menu g .’ K o e = harloy - { . . 5% 4 Road

& Plot Records

& 2Q™E

Filter

D cluster Map

Define shapes

Datasource

Select Datasource

1 Accour v ‘ Select Viev v
+

Select Category

|Account || select... v

Union

This adds all the shapes overlapped on the selected shape

(o8 Layer Menu I { v s e st Sy — lacton-on

L Q™ B

Filter

O cluster Map

Define shapes

Datasource

Select Datasource

| Accour v | | select Vie v |
+

Select Category

iAccoun! HSeIect. v
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Union Aggregate

This performs union operation on all the shapes that are drawn on the map. If a shape does not overlap
with any other shapes, it highlights such shapes and the union of the rest of the overlapping shapes.
Hertford

e
- s - —Ha rlo;/ acld
@ | Plot Records X Hemel Hempstead Saint Alban$

V Chelm{f rd ’ @
L 8@™E b | m AN
Filter * Sfviaqn o, @
SQuth'eh&-;m:.Sea‘{ @

Canvey
Island

Welfyn ]

| Layer Menu Ayigsbur
O Lay < yiesun—

Cluster Map
Define shapes

/) =(0)(0)(s)(2) @

o hester o oo}

\ / Hern
sittirigbourne
I R I:Ef' i Iy wh tstable.
o ‘\’\} anterb
tert
Maidstorie P
Select Datasource

))” Accour Vv | | Select Viev v

Select Category P ks

Account || Select.. v

South Downleanona! Park Authority |

LDt v -

it 15,} /.‘.l S | IS thampton South Downs

bB"u 7 Waterlooville = -
landford Forum A Fare

EI ..o L VoW Daln

Disjunctive union

This highlights the shapes that are not overlapped and lie in the selected shape & the shapes that are
linked with the selected shape.

Layer Menu ) { Aylesburys..m Wi m{

Plot Records b 7 \ Chejm{for:;/ & i 7 @
i \ - W ~ i - pa i
§ ‘ ) £ : ==
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Undo — While performing operations, user can use the option of ‘Undo’ to go only one step back
into the binary operations performed

Reset — Using the option of reset, user can remove all the operations that are performed on the
shapes drawn on the map

Note:
e To perform any operation, two or more shapes should overlap.
e For Union Aggregate, there should be more than one shapes with or without overlap.
e The highlighted shapes are new shapes as resultants of the operations performed. User
can click on the highlighted shapes to view the summary card and the data in the view
data grid.
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Territory Management

Territory management helps the user to create new territories manually as well as automatically and align
the existing territories as well to get proper distribution of territories. User can plot required regions, draw
shapes or directly upload shape files/excel files to get the required regions plotted on the map to create
territories for the same. User can create territories multiple automatically based on count of records or
use the territory Alignment tool to select the required regions and create new territories for the same.
While creating multiple territories automatically, user can also save the territories as a draft and rework
on the draft to get the territories created as per the requirement. Further, user can plot the existing
territories and edit them to get proper distribution of territories.

To access Territory Management, Go to Detail map > Territory Management m

Plot Records

X

Terrtory Management

Search Option

By File

CEW, .5Np, K El

Note: Users other than System Admin, can use Territory management only if they are given the role

of Maplytics Territory Manager

User can use the search options to plot shape files,
excel files, search by region, draw a shape or plot
existing territories on the map. There are five
search options:

e ByFile

e By Region

e By Drawing

e By Territory

e By Overlay
@in‘gi%’ih’é

6@ MAPLYTICS™

Plot Records »

Territory Management

Search Option
By File A

By Region
By Drawing
By Territory
By Cwerlay
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By File

This helps user to plot the shape files and excel files on the map that store geographical information and
attributes of the geographic features. User can plot the following two types of files:

e Shape files: The supported file formats are .shp, .kml and .geojson

Layer Menu

Plot Records
#> | Territory Management

Search Option

By File

NY_co..._clip.zip. .

Supported file type: sk .csv, shp, kmi and
.gecison

G

L Jeiton—7

' Layer Menu

Plot Records

E’] Road

Search Option

I .
| By File

Choose File |Staten .. des.xIsx

I Supported file type: xisx, .csv, .shp, kml and
| .geojson

| Sselect Region Type

| Postal Code

1 zip

; state_name
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By Region

This options helps the users to search for regions on the map by
City, State, County, Country, PostalCode, PostCode Sector,
PostCode(Outward Code), PostalCode Area.

2| Layer Menu ' ROl rak S
- / b Roselle
il Plot Records X Garwood

25 | Territory Management

=

Search Option

4 ‘ By Region v|

Select Region Type

| Postal Code v

‘ 10301,10302,10303,10304,10305,10306,103C

[ Please Enter Gity

‘ Please Enter State

| usa

© e &P MapLYTICS"

Territory Management

Search Option

| By Region hd |

Select Region Type

City v|

Select Region

State
County

Country

Postal Code

Postal Code Sector

Postal Code(Outward Code)
Postal Code Area
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By Drawing

This helps the user to draw a shape on the map using the Drawing Tool Bar.

Territo anagement

Search Option

By Drawing hd

Define shapes

GlLloelalc] |

98 Layer Menu ¥ Road

Plot Records

Territory Management

g j  Search Option

By Drawing

Define shapes

Bl [
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By Territory

This helps user to plot the existing territories on the map.

Layer Menu

Territory List

Plot Records

Territory Management

Search Option
corest e

2
2

2
z

Ny By Teritory
Select Territory

‘ 10301, 10302, 10303, 10304, 10305

© e &P MapLYTICS"

Castieton Ave
NEW BRIGHTO!
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By Overlay
Users can select this option of ‘By Overlay’ to select any ' Territory Management

shape/excel file saved in CRM to plot the same on the
map. Users can also select an attribute within ‘Category
Attribute’ to categorize the regions plotted on map. Also,
they can select one or more attributes within ‘Summary Select Overlay
Attribute’ to show on Summary card when clicked on any

Search Option

By Owerlay hd

. lotted on th Census data - Counties in USA Al
region plottea on the map.
glonp P Category Attribute Summary Attribute
Population || Population, Pop...

Layer Menu :Q ’

& L 5 | ; ALBERTA MANITOBA
Census data - Counties in US... X , ; @
NEWFOUNDLAND

BRITISH
COLUMBIA SASKAICHEWAN e QUEBEC AND LABRADOR
e S

PRINCE

NB g .
Rt St-Pierre

Search Option
By Overloy e Yy NOVASComA
Select Overlay -

Census data - Counties in USA v
Category Attribute Summary Attribute

Population V| Area_LandNam.. v

Gulf of
Mexico

Sargasso Sea

MEXICO Havana
CUBA 250 mies 500 km

Grand Turk.
HAITI é@ 202 e s %! Mierossh Carporston Terms

Note: If user has plotted any territory or shape/excel file using the feature of ‘Overlay’ within the ‘Plot
records’ card and moves to ‘Territory Management’ card so the option of ‘By Overlay’ will retain the
selection of the same while working with Territory Management.
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Layer Menu

This helps the user to select the required data
among the multiple data plotted on the map.
The user can use the toggle buttons on the
Layer menu card to show or hide the required
layers of the data to be shown on the map
without removing the same from map. If user is
using the ‘Plot Records/POl/Directions card’
and has plotted Datasource Records, POI
locations or Route and has proceeded for
Territory Management, the plotted layers of
data will be retained and will be listed in the
section of ‘Plot/POIl/Direction Layers’ of the
Layer menu. The data plotted using the
Territory Management card will be listed in the
‘Territory Management Layers’ section of the
Layer menu.

Territory Alignment Tool

This tool has four options respectively as mentioned below:

e Select/Deselect: User can select

regions/shapes/territories one by one on the map
the selected

e Deselect All: User can deselect all
regions/shapes/territories on the map

Plot / POl | Direction Layers

-:) ® Account - Staten Isla...

Territory Management Layers

-:) @ Territory Layer

e Select Multiple: This is a freehand selection which helps the user to select multiple

regions/shapes/territories on the map

e Delete: User can delete the shapes/regions/geographies plotted on the map
Note: If the delete option is used on the existing territories, it will delete the selected

geographies from the existing territories.

@ih‘g"&"i"&“ 6@ MAPLYTICS™
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User can select some of the regions/shapes using the ‘Alignment Tool’ and right click to create a new

B

.
Create new territory
territory. User can also select the required manager who will be responsible for the respective territory.
Layer Menu < & A\g Ny GREENVILLE YARDS, T I
— — "7‘ ;‘( é" Bay ®
| ) & Y Bayonng @ Ebbets Field
Elizabeth 7k ) Upper New York Bay / \ Flouses
& ‘GREENWOOD
1T et \
' 4 L27)
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By Region v| evS . 2'@'{')‘5&0 J ﬁw\\séuﬁsn 7 PARKVILLE
4 %,/r ariners Marsh &
Select Region Type ) By BRIGHTONIS & J s
£ 4 ffeavrice J/  sorouGH Park
Postal Code v & > 5 5 y,
i " <" Create Temitory 1
10301, 10302, 10303, 10304, 10305 & B ’- * T SHSTRT
Pralls 1& < 54 .e:\Fc'{ BERGEN §
Please Enter City Island ol Hamilton
- & ges
# x”uy P /)
jTRaviS \‘%é Marlboro Gerritsen g
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\ @® R TP
2 Staten Island 0 SEAGATE West Brighton
Y
BREEZY POINT
1 miles 1km

Please Enter State
'f‘kssn KiLls

m Carteret
77 )
{17 ,
Port/ﬁ{eading
/ ;: /
GREENRIDGE
/

/ Weods of Arden

Bay Terrace

O Add To Existing Territory
@ Create Single Territory
10301-5taten Island
Select Manager

Select Mamager
(O Create Multiple Territories

the list of users to be selected as a manager

e s
Toke: ; N i §
3 william 1 -/
Create Territory x
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Lower New York Bay

of the territory.

Note: Users who have already been assigned as a manager for another territory will not be visible in
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Plot Records
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Auto Territory creation

User can create territories automatically based on a shape/excel file and count of records plotted on the
map to get the desired number of balanced territories. To do this, user can go to Territory Management
and use the option of ‘By File’ to upload a Shape file or an Excel file to get it plotted on the map. User can
also choose the option of ‘By Overlay’ to plot a saved shape/excel file on the map.

‘ Layer Menu

Plot Records

9= ;‘ Territory Management
o “
Search Option

By File v

Choose File |Staten .. des.xIsx .

§  Supported file type: xisx, .csv, .shp, kml and
| .geojson

Select Region Type

| Postal Code v|

\7ip A

\ state_name

Now, user can go to the ‘Plot Records Card’ and select the required ‘DataSource’ and the respective ‘View’
to plot the same on the map. These records will be distributed among the territories that are to be created.

@,

i Plot Records

D cluster Map

Current Location

Proximity

@ Distance OTime

(O show Travel Distance

Datasource

Select Datasource

[Accour v [account - v| @ ()
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Note: Only those records which lie within the regions selected will be considered while creating
multiple balanced territories.

Using the options of ‘Select’ or ‘Multi-select’ from the ‘Alignment Tool’ user can choose the required
regions and right click to select the option of ‘Create Territory’ to open the window. Here, user can select
the option to ‘Create Multiple Territories’ and enter the number of territories they want to create out of
the selected regions on the map. In the screenshot below, we have entered 4 for an instance.

Create Territory b
) Add To Existing Territory Create Territory 4

® Create Single Territory
Please enter the name of territory ) Add To Existing Territory
Select Geography Name O Create Single Territory

Select Geography Name = . y .
graphy '® Create Multiple Territories
Select Manager 4

Select Manager

O Create Multiple Territories

This will calculate the number of records and divide the selected regions automatically to get 4 balanced
territories. By default, territories will be named as Territory_0, Territory_1, Territory_2 and so on. User
can change the names as per their requirement.

Note: The count of records in the territories created automatically might vary slightly.
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98 ; Layer Menu
/& | Territory List

25 | Select All Actions +
|

W |
. K=l e

Records: 171

s 0@

Records: 108

oz 0@ @ 9 20
Records: 355 | g 4 Q - '&‘O’j SQ
s D QAT OV

o7 Z9%
: QQ@QQQ
“E=se w

Plot Records

Territory Management

© 2021 TomTom. € 2021

User can also set the required user as a manager for the territories processed, by clicking on the ‘Select
manager’ icon.

Select All Actions =

Territory_0 2

Records: 171
| Manage | Q

Territory_1 Select Manager

Records: 108 Bill &
Jon P
Records: 355
10
Records: 307 -

Note: Users who have already been assigned as a manager for another territory will not be visible
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User can also set the colors for the territories using the option of ‘Fill color’.

Select All Actions «

|Territor)f_2
Records: 355

@ eI @ =En

’Territory_a I
Records: 307

User can further choose to take an action on the territories Territory List

processed on the map by using ‘Actions’. There are three

o

Actions available: Select All Actions -
Create

Create: If the user is satisfied with the territories processed, -

_— ) ; o Territory_0 Save

then they can choose this option to create the territories Records: 171 Realign

processed on the map within the CRM.

o - 0
Save: If user needs to work on the territories processed to 4 = : 3

o Records: 108
further make any changes or take an opinion on the same from

a colleague, they can use this option to save the territories :
1@

processed as Draft Territories within the CRM. Records: 355

Realign: User can further rework on the territories processed

using this option. This will allow the user to revise the number 8 |[rerritory 3 ) | .

Records: 207

of territories processed.

Assign territories to record

If user chooses to create territories from the ‘Actions’, then .
Confirm!

after creating the territories, user will be asked if they want to
Territory(ies} created SUCCSSSTU”Y. Click on confirm

assign the territories created to the respective records plotted _ -
to assign territories to records.

on the map. User can click on ‘Yes’ to do so.
CONFIRM  CANCEL

@inig%“i% 6© MAPLYTICS™ Page 98 of 284




Maplytics™ — User Manual

Register to Windows Service

If the number of records is more than 9K, then user needs to register to Windows service in order to create
multiple territories. With more than 9K records plotted on the map when user tries to create multiple
territories then the below message will be shown and these records will be processed by Windows Service.
When the user clicks on ‘Confirm’ then it will create the territory records with the status ‘Process by WS’
and Windows Service will process these territories by distributing the records to create the specified
number of balanced territories based on the number of records.

Confirm!

Records are more than 9K, these will be processed
by windows service. We will email you once the
process completes.

CONFIRM CANCEL

Windows service runs at the interval that user will set. For example, user can set it for every 1 hour. When
windows service runs and finds territories with the status ‘Process by WS’ then it will process them one
by one. It takes one territory and performs the logic and distributes the records properly to create the
respective number of territories and while updating these territories it changes the status of those
territories to draft. User can plot this draft territory and create the respective territories into the CRM.

To install Windows Service, user can go to the ‘Batch processing tool’.

1. To get the tool, Extract the Batch Processing tool .zip file from the extracted Zip folder of
downloaded Maplytics solution.

I : BatchProcessingTool_2_0_0_11 I
& Maplytics - Installation Manual
@ Maplytics - License Registration
@ Maplytics - Presentation
@ Maplytics - User Manual
@ Maplytics - WhitePaper
@ Maplytics Terms of Use

%] Maplytics-Presentation
|j Read-Me
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2. Run the BatchProcessingTool as Administrator as shown below.

Mame Date modified Type " Size
Territory_Distribution_Windows_Service (9202020 4:02 PM File folder

I_E] BatchProcessingTool.ex I LR 0000 A0 DR Aeelicatign 274 KB
[85] BatchProcessingTool.vs Open ion 24 KB
ClosedXML.dlIl % Run as administrator ion exten... 1,023 KB
DocumentFormat. Open 6 Share with Skype ion exten... 5,564 KB
ExcelMumberFarmat.dll Troubleshoot compatibility ion exten... 27 KB
FastMember.dll Pin to Start ion exten... 23 KB
%] Microsoft.Crm.Sdk.Prox s Move to OneDrive ion exten... 275 KB

3. Once the user runs the tool, the following window will open where they need to enter the
credentials and click on ‘Next’.

Cancel

4. Once user clicks on ‘Next’, it validates the credentials and if credentials are valid then the below
window shows up. Here, user needs to select the option to Install/Uninstall Territory Distribution
Windows Service and click on ‘Install’.
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@ Maplytics - Batch Processing Tool (2.0.0.10)

f 0]
y©

Maplytics Batch Processing

Install Uninstall

Once clicked on ‘Install’ the ‘Territory Windows Service’ will be installed in the PC as shown below.
User can click on ‘Uninstall’ to uninstall ‘Territory Windows Service’.

User can start and stop windows service using ‘Start’ and ‘Stop’ button.

(ol i
Lo Services

File Action

View Help

&= | FHEQE HE »onwp

innovative

noGi

Cosenicesocal [T semiees(oca) T

Inogic.Maplytics.TerritoryDistribution Mame
8115 Admin Service

Start the service

£k Intel(R) Content Protection HEC! Service

To update the windows service run interval, user needs to change “RUNINTRERVAL” in the app
config of windows service (Inogic. Maplytics. TerritoryDistribution.exe.config).
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This PC » Downloads » Batch Processing Tool » Territory_Distribution_Windows_Service

] Marme Date modified Type Size
' [] Inogic.Maplytics. TerritoryDistribution.exe 09/20/2020 10:51 PM Application 82 KB
! I ¢ Inogic.Maplytics. TerritoryDistribution.exe.config I 09,20,/2020 10:53 PM XML Configuratio... 1KB
r |%] Microsoft.Crm.Sdk.Proxy.dIl

f %] Microsoft.ldentityModel.Clients ActiveDirectory.dll =] Inogic.Maplytics TeritoryDistribution.exe.config - Notepad

|%] Microsoft.|dentityModel.Clients.ActiveDirectory.Pl...
|%] Microsoft.dentityModel.dll )
|%] Microsoft.Rest.ClientRuntime.dll 08/27/2

File Edit Format View Help
<7xml version="1.0" encoding="utf-8"?>
<configuration>

<startup=
%] Microsoft.Xrm.5dk.Deplayment.dll 09/27/2 <supportedRuntime version="v4.0" sku=".METFramework Versi
%] Microsoft.Xrm.Sdk.dll 2 </startup>

L %] Microsoft.Xrm.Tooling.Connector.dll

%] NewtonsoftJson.dll 01728/ <appsettings file="">

< clear/»
I | <add key="RUNINTERVAL" value="30" /> |

Fa

Note: Make sure the PC in which the Windows Service is installed is running all the time because if
the PC is turned off, the Territory Windows Service will also get turned off and it will not perform
any task.
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Draft territories

If the users need to further work on the territories

processed or needs to make any changes, they can choose Select Al Actions «
the ‘Save’ from the Actions and save the territories . .
processed as a ‘Draft territories’ within the CRM. Create

‘Territory_{] I Save I

Records: 171 Realign
Save As Draft b4 e

Territory_1 1 .

@ Create New Draft Territory Records: 108

Territory_2 1 .

( Update Existing Draft Territory Records: 355

- a s |1 @
Y e &

Records: 307

Staten Island

After saving a draft, user can use the option of ‘By Territory’ within the ‘Territory Management’ card to
plot the draft territories saved in CRM and rework on them. Further, user can choose to save it again as a
draft with the updates done or create the respective territories in the CRM using the option of ‘Create’
from the Actions. If user wants to create the respective territories from the draft, they can also choose
whether or not to delete the respective draft territory.

IO Layer Menu <

Linden//

:}6‘

&

k-

s

§ INEW UTRECHT @
L

% _Marlboro

Search Option ““.Rahway™ ¢/ _
River &7~
&

By Territory N, 8
B "i Houses
Select Territory & ‘-&Wl
Draft - Staten Island v Carteret. g 0 SEAGATE West Brighton

“ tReading

Lower New York Bay

Tmiles,  {km

© 2021 TomTom, © 2021 Microsoft Corporation Terms
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Create territory on one click

User can create multiple territories with a single click on ‘Create Territory’ button. User can plot shape
files or excel files on the map to view the shapes required as geographies and follow the steps mentioned
below to create territories:

By Shape file

After plotting a shape file on the map, user can click on the ‘Create Territory’ button to create a new
territory with the plotted shapes as geographies or create the plotted shapes as geographies into a
selected existing territory.

Layer Menu 2 4

\,Hbrwxh ASTLEVBRIDGE |
Blackr’od\ Y |

L Bolfan

DEANE 5 \
3 { 2566 Radcliffe | ) @
Far:\

Search:Gption Skelmersdale \ es(houghton \ Whitefield
> = I

By File v € B> \_7{ faco} .
g arsley / \ I e~
Choose File | Wigan.kml S = Pregfwnch 7 =
Y Supported file type: xisx, .csv, .shp, .kml and Nt 5 . , g f \ |
geggon / = Y, HARPURHEY
Rainford R —[= &

Billinge

\

L°Wt° INTON
Fon m

_ Newton-| le-Willd

Saint _He’ylensl urms(on
Wigan (25) Create Temtory < Related Reco...
name A 4 OBJECTID Y
Ashton 1 Z
Aspull New Springs Whelley 2
Golborne and Lowton West 3 2
e < @ » » 50 v items per page (25 Selected) 1 - 25 of 25 items

Create Territory b4

( Add To Existing Territory
@® Create Single Territory
Please enter the name of territory
Select Geography Mame
Select Geography Name
Select Manager
Select Manager

) Create Multiple Territories

User can provide the name for the new/existing Territory to be created and select the column from the
excel file for ‘Select Geography Name’ and the respective names of geographies will be fetched from the
file.
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By Excel file

After plotting an excel file, user can click on the ‘Create Territory’ button to create territories with the
shapes plotted on the map as Geographies. The names of the territories and the respective Geographies
will be fetched from the excel file.

The excel file should in the supported file format as mentioned below.

Name: Name of the Geography.

Search Option: Bulk geography feature is available only for the ‘By Region’ option, so this value should
always be ‘1’

Color: Color should be in Hexadecimal format i.e. (#DAF7A6). If the user enters the color in other format
then the default color (Blue) will be set.

Edit Columns x

Edit columns for the saved view. These columns represent the data that will be displayed in the view.

Name. color Reqgion Filter Region Type Region Value Search Option Termitory Common Tasks
« >

|

Add Columns

hange Properties

Remaove

x| ml

Region

Type: There are 6 region types that the user can define to create the geography. (Country, State, County,
City, PostalCodel, PostalCode2).

Region Value: If the user needs to create the geography based on Postal Code, then they can define the
postal code values in this column. To define multiple geographies in single territory, use the comma
separator (,).

Territory: This is a lookup value to define which geography belongs to which territory.

Manager: The names of the users can be provided here. While creating territories, the managers for the
respective territories. However, the column of ‘Manager’ is not mandatory to be in the excel file.

Note: For Territory management:
e The column of ‘Territory’ should contain the Names of the territory(ies)
e Color: Color should be in Hexadecimal format i.e. (#DAF7A6). If the user enters the color in
other format then the default color (Green) will be set.

o There are 8 region types that the user can define to create the geography. (Country, State,
County, City, PostalCodel, PostalCode2, PostalCode3, PostalCode4).
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Alignment of Existing territories

User can plot the existing territories and align them to get the proper distribution of the regions. User can
use the following two options to align the territories.

Move to

User can select some geography(ies) of one or more territories and move it to another plotted existing
territory or create a new territory. This will remove the geographies from the original territory.

2 | Layer Menu

: Territory List

H Territory Management
|

W

Select Territory

| 10301, 10302, 10303, 10304, 10305, 10... |

© 2021 TomTom. © 2021 Micr

® Existing Territory
10312_Staten Island

() Create New Draft Territory

Proceed
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Copy to

User can select some geography(ies) of one or more territories and copy it to another plotted existing
territory or create a new territory while keeping the geography in the original territory.

O8N Layer Menu

/& Territory List
- —

2 | Territory Management

‘ By Territory

Select Territory

‘ 10301, 10302, 10303, 10304, 10305, 10... v‘ EoN

® Existing Territory
10305_Staten Island

() Create New Draft Territory
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Users can modify the boundaries of the drawn shapes in existing territories using this option. To do this
first plot the existing territories on the map. Now, go to the ‘Territory List’ and click on the ‘Edit’ button
for the required territory and click on the required shape to modify.

fg\ Territory List

Select All Actions v

[ramer-ios] (2) @ 7]

) Plot Records

rg\ Territory List

Select All Actions v

-~y

Lower Place

- =3

Note: Only the territories that contains shapes created using the Drawing tool can be edited by Edit

(o) e
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Shape Operations in Territory Management

User can perform Binary operations on the shapes, regions or territories plotted on the map. User can
select the shapes on which they want to perform operations and right click on them to select the Binary
operations. There are five Binary options available: Difference, Intersection, Union, Union Aggregate and
Disjunctive Union. Please refer to the section of the Shape operations to know more about these Binary
operations.

Note:

e The shapes should overlap each other to be available for performing shapes operations
e There should be a layer of drawing overlapped with the shapes on which binary operations has
to be performed

o The required shapes should be selected before performing Binary operations

() =TT o mapLyTICS” Page 109 of 284




Maplytics™ — User Manual

Defining Geographies for Sales Territory using Maplytics

The users can create sales territories using the native Dynamics CRM ‘Sales Territories’ feature and define
geographies for the sales territories on a map using Maplytics.

To create geographies for sales territory, go to Settings > Territories and click on ‘New’ to create a sales
territory. With Maplytics a ‘Geographies’ Entity is added on the territory. User can use this feature to
visualize and create geographies for the sales territory. To create a new geography, click on ‘Add New

Geography’.

NY_USA

Territory

General | Define Geography | Territory Map Preview  Related

Geographies + MNew Geography :

Status

| Mame T ~

In the section ‘General’, provide a name for the Geography.

NewYork
Geography

General Map Preview Related

Mame * MewYork

Territory 10 NY_USA

Within the section ‘Map preview’, the user has the option to visualize the geography on a map ‘By Region’
or “By Drawing’. The ‘By Region’ option lets the user to plot the geography based on region types and the
user has the freedom to choose the color for the plotted region.
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'/ \‘ GEOGRAPHY
&t/ Postal code 10301

General Map Preview Related

7N e
Search Option
I By Region
Select Region Type
| Postal Code

The ‘By Drawing’ option lets the user to plot the geography by drawing a shape on the map and the user
can further edit the shape based on their needs.

\‘ GEOGRAPHY
5/ Drawn shape_Staten Island

pa
L
\

N

General Map Preview Related

Search Option

I By Drawing

Define Shapes
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Hierarchal Territories

Dynamics 365 supports the hierarchy of territory where user can manage multi-level territories. If an
organization has enabled the Hierarchical territories in the CRM, the users can plot the territories to plot
and manage multi-level territories. So, if there are any child territories created for the selected territories,
then those will also get plotted on the map along with the selected territories.

User can select and plot the territories on the map using the three ways as follows:

By Territory using plot card in Detail map

User can open the Detail map to choose the icon of ‘By territory’ @ in the Plot card. They can
select the territories from the list, select Data source & view and click on Search to plot the
same.

Layer Menu <
Territory List 6
.

oo ) i

Select All s ’.q'
P [ w {
P — i \‘L i o V-4
— s VA e s maa®an e A o
[au-2350-Nsw] (& [ ® O { 3
2 :
[ |(R) M @
[au - 2418- Nsw 3 ® : 3 Tord Ho
® V mﬁ = Multiple {
P — - ® Y E Zone
[au - 2440 - nsax\ 2 = @ oy z
= *
[au- 2460 - nsw] (& [ " Lord Hon
— A Marine P:
. @ NEWSOUTHWALES
[au-2795- Nsw| (R 3 y =
[au-2850 - Nsw| (& K ® N
R V' @®
[au - Nsw | (2 2] (U\\ @®
it ® ®
wnegide k\) ® v @® A
Plot Records X i V. N M
1siana \\ e B
VICTORIA 100 miles 200
b> Bing View Data £ 2021 TomiTom, © 2021 Microsof: Corporation, € OpenStreetilap Jemms

@nas.ug: 6@’ MAPLYTICS" Page 112 of 284




Maplytics™ — User Manual

e By Territory using Territory Management in Detail map

Within the Detail map, user can click on the icon of ‘Territory Management’ ﬁ and select the
option of ‘By territory’. Now, select the territories and click on Plot.

c

Territory List

Select All Actions v

8 (o] @) @K
8 (] (@) @ B
8 2 ) (2 @R
8 () @) @ B

] O @
o] @) @R
e | O@R

Plot Records

Territory Management

e OQOverlay in Detail map
User can use the option of Overlay within the Plot card or Territory management to plot the
territories.

Layer Menu : ; % ¥ Road

Territory List 7

Plot Records

£ Bt ] . 3t .' o Q .
Territory Management - ) o ~. @
Search Option 4“ N " ' < : : o - @
L. . Y 3 . :

| By Territory

Select Territory

[au-nsw
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Note:

e System admin and Territory Manager will have access to all territories

e The visualization of the territories to the rest of the users will be dependent on the usage of the
option of ‘Show All Territories’ within the Default Configuration Detail record > Advanced
Settings > Configure Option>Show All Territories. If the option is not selected then the user will
be able to view only the territories for which they are the Territory Manager or the member.

e Ifauser is the Territory Manager or the member of a parent territory, then the user will be able
to access the child territories as well, either using the Maplytics maps as mentioned above or
by going to the respective child territory records within the Territory entity to visualize it in the
Territory Map Preview.
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Bulk Geographies by uploading an Excel file

The users also have the option to upload multiple
geographies through an Excel files supported by
CRM using the Bulk Geographies feature in
Maplytics.

K DELETE ~ = EMAILALINK | = EXCEL TEMPLATES ~ ﬁ._, EXPORQ TO EXCEL

Create Excel Template

al My |mport5 v Create Excel Template

v | Import Name Status Reason Successes Partial Fg

Create template from Dynamics... To upload the geographies in bulk, the user
first needs to export an Excel template. Go to
Settings > Data Management > Imports >
Q5] Excel Template Q=] Word Template select the ‘Excel Templates’ and then click on
the ‘Create Excel Template’ option.
Select data Select the ‘Excel Template’ and in the ‘Select
Filter by entity Geography v data’ section, select the ‘Geography’ Entity in
the ‘Filter by entity’ field.

Use saved view Active Geographies T

Edit Columns

Click on ‘Edit Columns’ and select the below
columns;
@ Upload Download File

The excel file should in the supported file format as mentioned below:

Name: Name of the Geography.

Search Option: Bulk geography feature is available only for the ‘By Region’ option, so this value should
always be ‘1’

Color: Color should be in Hexadecimal format i.e. (#DAF7AB6). If the user enters the color in other format
then the default color (Blue) will be set.

Edit Columns X
Edit columns for the saved view. These columns represent the data that will be displayed in the view.
Mame . color | Region Filter | Region Type Region Value Search Option Territory Comman Tasks
« >

FF Add Columns

=: Change Properties

Remaove

sl
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Region Type: There are 6 region types that the user can define to create the geography. (Country, State,
County, City, PostalCode1l, PostalCode2).

Region Value: If the user needs to create the geography based on Postal Code, then they can define the
postal code values in this column. To define multiple geographies in single territory, use the comma
separator (,).

Territory: This is a lookup value to define which geography belongs to which territory.

Note: For Territory management:

The column of ‘Territory’ should contain the Names of the territory(ies)
Color: Color should be in Hexadecimal format i.e. (#DAF7A6). If the user enters the color in
other format then the default color (Green) will be set.

There are 8 region types that the user can define to create the geography. (Country, State,
County, City, PostalCodel, PostalCode2, PostalCode3, PostalCode4).
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Multiple Territories assigned to records

If a user needs to assign more than one territory to the entity records, user can enable the feature of
Multiple Territories for a record. This feature will help the user to visualize records which lie in single or
multiple territories. After assigning the territories, they can plot the territories to visualize the respective
records lying into them.

To start using the feature of Multiple Territories for a record, user can follow the steps mentioned below:
Step 1: Enable Multiple Territories

Go to Settings > Maplytics > Maplytics Configuration Details > Default configuration detail record >
Configuration option > Select ‘Enable Multiple Territories’.

Note: User cannot undo this option, once selected and saved.

Step 2: Creating N: N relationship of entity with Territory.

Go to Settings > Customizations > Customize the System > Entities > Select Entity > N: N Relationships >
New Many-to-Many Relationship

Step 3: View the list of territories assigned to a record

Territories + =H
User can add a sub-grid to show the territories that an (Eryy s Manager
entity record is associated with. This step is optional, Sales 3
even if a sub grid is not added, the assigned territories Services Territory

will get associated with the records in background.

Step 4: Select relationship for the field ‘Territory Relationship’ in Attribute mapping section of Entity
map.

Go to Settings > Maplytics > Entity maps > Attribute mappings > Territory Relationship > Select ‘Entity -
Territory’ relationship
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Step 5: Assign territories to records

User can either run Batch Processing tool or the Inogic.Maplytics.AssignTerritoryWorkflow on the
records to assign the territories to the records.

After assigning the territories, user can choose the Search option of ‘By territory’ to plot the territories
along with the respective records. The below screenshot shows two territories plotted on the map, ‘Staten

Island — 10306’ and ‘Staten Island- Mid’ which overlap on each other and have pushpins in common as
highlighted.

fOBl Layer Menu

el

rgN | Territory List

Select All

‘9 Iy
] 10
) r
e ons ] 2 @B

.
Woods of Arder

©2021 TomTom. €2
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Detail Map on CRM Dashboard

To include the Maplytics Detail Map component on the Dashboard, click on the ‘new’ button and select
‘Add Web Resource’. Select ‘ikl_/Maplytics/Maplytics.DetailMap.html’ web resource. The User can
further modify this web resource by including some custom parameter. For Example, if the user wants to
plot a route from a dashboard like Appointment Planner. The user can automate the complete process.

Add Web Resource 7 x

Add an existing web resource to the Form.

Genera Formatting Dependencies

— Web resource

Web resource ™ ﬂ kl_/Maplytics/Maplytics.DetailMap.htm .ﬂ

— Field Name and Properties
Name * WebResource_ |[Route

Label * Route

Display label on the Form

— Visibility

#l visible by default

— Web Resource Properties

Appointment Planner||Dashboard|jtrue

Custom Parameter{data)

Restrict cross-frame scripting, where supported.
Pass record object-type code and unique identifier as parameters

[+ Enable for tablet

OK Cancel

Custom Parameter(data) : You need to provide the Custom Parameter(data) as
o <Dashboard Name>| |dashboard| |true
e Appointment Planner| |dashboard| |true
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Saved Template Visualization on CRM Entity Form

Users can include the Maplytics Detail Map component that loads a saved template associated with the
Entity record on the Entity Form. For this, the user needs to create a ‘Template’ lookup field on the Entity
form where user can select the required Maplytics Template. The user also needs to select the name of
that field in the ‘Template’ field under ‘Define Attributes’ section on the Entity Map for that particular
entity.

ENTITY MAP
account

General  Attribute Mappings Tooltip Mapping  Category Configuration  Configuration — Advance Settings  Related

Title * Contextual Search Tax Exempt Numb
| Account Name |

Template

| Land Area |

On the Entity form, the user needs to ‘Insert’ a new Tab and select ‘Add Web Resource’. Select
‘ikl_/Maplytics/Maplytics.DetailMap.html’ web resource. The user now needs to add a Custom
Parameter for the saved templates.

e Custom Parameter (data): Provide the Custom Parameter(data) as savetemplate

VAL D § - - 3
Web Resource Properties ? X
Muodify this Web resource’s properties.

Gzneral Formatting Dependendies

* B
— Wisibilty
=) Visibdz by d
[~ Web Resource Properties
savetamplats
Custom Parameter(datz)
ere supported
and unigue identifier 2= parameter:.
-
oK Cancel
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Now, when the user selects a Maplytics Saved Template on the ‘Template’ lookup field on the Entity form,
the selected template will be plotted on the Detail Map component added on the Entity form.

° A. HANSA PERSAUD & SONS

Summary Map Project Price Lists  Details  Field Service  Scheduling Related

Ticker Symbol

Relationship Type

Product Price List

Template %
Bl Land Area
ACCOUNT Annual Revenue No. of Employees
A. HANSA PERSAUD & SONS $366,466.00 L

Details  Field Service  Scheduling  Related

Summary Tab Map Project Price Lists

SPOl o9 DIRECTION

Layer Menu

Plot Records

50 feet 20m
©2018 HERE. © 2010 Microsoft Corporation Terms
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Routing Optimization

User can select some locations on the map as waypoints to plot an optimized route. User can follow this
route to visit the required locations and complete their meetings. User can also redirect themselves for
turn-by-turn navigation in order to reach the right location on

time.
Directions Card @ = A

Directions card provides the user with all the routing features.
The user can open the Directions Card directly by clicking on

Directions tab. ® iles O kilometres

O Shortest Time ® Shortest Dista...
8 optimize Dire.. [J Avoid Highways
The Directions Card also opens up when the user adds a [ Avoid Toll Roa... [ Traffic

waypoint(s) to the route either through the Contextual Menu,

X R . , X DAIong The Ro...
ToolTip Card or using the ‘Add to Route’ mass action. User can
select the required waypoints and the leaving/arriving time. The
user can drag and drop the waypoints to change the order of =@  From
route
=Q To

 faesinater
e f =m R 9@@ @O Leave now

Options v Open Saved Routes -

*x
=@ | YUJIKANEKO & SONS: 620 ¢ | select Start Date

=@ R TAHIR DEMIRCIOGLU & SOI | x
Select End Date *

- @ R PETERCHIANG & SONS: 1¢ | x

) Add destination

o
o)
1 15 AM Note: The user can add a maximum of 25 waypoints in
v the direction functions.
May 2021 -

S M T WT F S
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Once the waypoints are selected, the user can choose the

mode of transports like Driving, Walking, Transit or Truck
to view the route.
The user can select different options to reduce the time, @ + m B 9 @ @

toll, highways, etc. by clicking on the Options button. Some
of these can be auto-selected using Maplytics Options -
Configuration Settings.

® Miles O Kilometres
Note: To start using Truck route, please contact () shortest Time ® Shortest Dista..
crm@inogic.com Optimize Dire... [ Avoid Highways

[ Avoid Toll Roa... [ Traffic
(J Along The Ro...

Truck Route

To start using Truck route, please contact crm@inogic.com. Once the user has contacted us at
crm@inogic.com for the truck route, the user will be provided with a Maplytics license with Truck routing
enabled into it. To start using Truck route, user needs to update the license and then configure as
mentioned below:

Update the license: Go to Maplytics App > Settings > License registration > Click on Activate.
Configure: Go to Maplytics App > Settings > License registration > Configure Tab > Configure. Here the
Asset data will be configured to the users Dynamics CRM.

Maplytics Configuration

Core Records Sales Customer Service Field Service

Shape Layers Assets Data

Name

Trailer 1
Trailer 2
Trailer 3
Trailer 4
Trailer 5
Trailer 6

Create Personalized Records

@.nc‘i“s.i"": 69 MAPLYTICS" Page 123 of 284



mailto:crm@inogic.com
mailto:crm@inogic.com

Maplytics™ — User Manual

Assets data configuration will create some sample records for Trucks which user can select while using
the feature of Truck routing. User can click on the ‘New’ button to create new records of Assets. They can
also edit and save changes to the configured Assets.

Dynamics 365 »  Maplytics  Settings > Assets

= ’:1__| Show Chart @I Delete N O Refresh CZ Email a Link - " Flow : Run Report ™ BE Excel Templates ~

{m Home

Active Assets Search for records ¥el
(® Recent N
| Name T ¥ | Crested On
5% Pinned \4
Trailer 1 3/18/2020 3:34 PM
Maplytics Trailer 2 3/18/2020 3:34 PM
E Maplytics Dashbo... Trailer 3 3/18/2020 3:34 PM
Entity M
Bl Entity Maps Trailer 4 3/18/2020 3:34 PM
E Maplytics Templat...
Trailer 5 3/18/2020 3:34 PM
-] Maplytics Configu...
Trailer 6 3/18/2020 3:34 PM
B Maplytics Security...
B Territories
B Teams
E Routes
(=] Inogic License Det... A_ # A B C D E F G H J K L M N [o] P Q R S T u v w X Y z

n Settings & 1-60f 6 (0 selected)

After the sample records for trucks have been configured, user can enable the truck routing. To enable
truck routing, go to Maplytics App > Settings > Maplytics Configuration Details > Default Configuration
Detail record (with no user) > Advanced Settings > Enable Truck Route.

Maplytics

Map Configuration Details

General Advance Settings Check-In  Auto Scheduling  Real-Time Tracking  Related

Configure option

Enable Travel Enable Truck Route Map in New Window O
-
Distance

Enable Territory & Enable Multiple
Show All Territories O o ! ] o e
Assignment Rule - Territories
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User can choose the truck icon on the Direction card to plot
the route for a truck. On the selection of the truck icon a

Maplytics™ — User Manual

window will pop up to enter the Asset details.

Within the Asset Details, user can either select one of the
sample truck types or select the custom option to enter their

own details and then click on ‘Go’ to plot the route.

Note: Optimization of the route with the Shortest
Distance will not be available when Truck is selected as

the mode of transport.

The Asset Details will be as follows:

o

©

innovative logic

imnaGic

Options

® Miles
® shortest Time

Optimize Dire...
(1 Avoid Toll Roa...
[ along The Ro...

=t 20REBD

h

O kilometres

Shortest Dista...
[ avoid Highways
I Traffic

Asset type: The asset for which the route has to be plotted. It can be selected from the following

Asset Details x

list of configured sample records. User can also
select ‘custom’ to enter their own details.

e Trailer1

e Trailer 2

e Trailer 3

e Trailer4

e Trailer5

e Trailer6

e Custom

Axles: The number of axles.

Dimension Unit: The unit of measurement of
width, height, length. Can be one of the following
values:

o Meter

o Feet

Height: The height of the vehicle in the specified
dimension units.

Length: The length of the vehicle in the specified
dimension units.

Width: The width of the vehicle in the specified
dimension units.

Truck Type

Select Asset v
Dimension Unit

Select Dimenszional ¥

Length

Weight Unit
Pound v
Hazardous Material

MNone v

Axles

Height

Width

Weight

Go =

Weight Unit: The unit of measurement of weight. Can be one of the following values.
Weight: The weight of the vehicle in the specified weight units.
Hazardous Materials: List of one or more hazardous materials for which the vehicle is

transporting. Possible values are:
e Combustible

e Corrosive

e Explosive

Flammable

6@ MAPLYTICS™
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e Flammable Solid

e Gas

e Goods Harmful to Water
e Organic

e Other

e Poison

e Poisonous Inhalation
e Radioactive
e None

® & = oe @ @ This can be selected from the Options. This option will

provide the users with the optimized route direction

Options - between their waypoints keeping Origin & Destination
as fixed waypoints based on Shortest Time or Shortest
Distance as per the selection.

® Miles O Kilometres

® shortest Time Shortest Dista...

Once the user clicks on ‘Go’ the route will be plotted and

U Avoid Highways the directions will be available on the Directions Card.

8 Optimize Dire...
(] Avoid Toll Roa... [ Traffic
(J Along The Ro...

= @ 10 Ellsworth Ave, New York,

=@ 123 Harold 5t, Staten Island
() Add destination
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User can view all the details regarding the pushpins on the route in the view data grid in the tab named
as entity_Route. for example: Contact_Route. Each waypoint on the route will be represented by a
pushpin. User can hover or click on any pushpin to view the details of the waypoint. If the waypoints are
records saved within Dynamics CRM, it will open the tooltip card on its click showing the respective data
configured for tooltip card.

If the waypoint is just a location, on a click it will open a 3730 Victory Blvd, Staten Isla...
tooltip card showing its address and an icon which can be
used to create a record for the location. This includes the
Default origin and destination pushpin as well.

= DIRECTION = SETASCU.. = SETASPO..

3730 Victory Blvd, Staten Island, NY 10314

Take An Action

User can also choose to show or hide the layer of
route from the layer card.

:)' Route
m @ Accounts - Staten isl. . @'
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Send Route email:

Maplytics also helps the user to send the route
details in an email using ‘Send route email’
button. This will automatically fetch all the
details of the route like the account details,
waypoints, links etc. in the mail.

Ot ==:QOE®

Users can click on ‘Show Complete Route’ to see the entire route with all the waypoints or use the
individual ‘Route link’ to see the routes between two waypoints. The user will be redirected to their
preferred navigation app, Google or Waze, to visualize the route on the map based on the app selected in
their Map Configuration Detail Record

& Tahoma - 10 -

Hi,

Please use the below link to access route in Desktop / Laptop:
https://maproute.page.link/9z71

For Smartphone [ Tablet user, please use following links:
Please use the below link to follow complete route:
Show Complete Route

Please use the below link to follow individual routes:

Waypoint Name Address Navigation

Turbhe MIDC Road, Inogic Tech India Pvt. Ltd. Turbhe

Navi Mumbai Maharashtra Route Link

Inogic Tech India Pvt. Ltd.

Plot No. 22-26, Krishna Govind Tower, Opp. Sanpada
John & Sons Railway Station, Sector 24, Vashi, Sector 24, Turbhe Route Link
Navi Mumbai Maharashtra

107, Janta Market Rd, Sector 23, Turbhe Navi Mumbai

Maharashtra Route Link

Johnson & Sons

Vishnu Shankar Kadam Marg, Thane, MH 400703 Route Link

Opposite Sanpada Railway Station, Sector 18, Vashi
Navi Mumbai Maharashtra

Sans Pyt Ltd

Maplytics admin or System admin can add four more columns to the existing route table to view more
details on the same. To do this, they can go to Maplytics App > Settings > Entity maps > Entity map of
respective entity > Advanced Settings > Route Email Configuration > Attributes > Select Attributes > Add.
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account
Entity Map
General  Attribute Mappings  Tooltip Mapping  Category Configuration  Configuration  Advanced Settings  Related
Route Email Configuration
Attt sienlanh —
Attributes Attribute DisplayName Remove
Annual Revenu Annuzl Revenue hd
Display Mame Email Email %
¢  Tahoma 0 - B £- - = A & -
Hi,
Please use the below link to access route in Desktop / Laptop:
https://maproute.page.link/psFc
For Smartphone / Tablet user, please use following links:
Please use the below link to follow complete route:
Show Complete Route
Please use the below link to follow individual routes:
Waypoint Name Address Annual Revenue Email Navigation
262 at BETHEL AVENUE Staten L .
A R. VLADIMIR CONSTANT & SONS Island MY 10307 USA $1,000,000.00 charles10723@inogic.com Route Link
B L. DAL CHUN & SONS 5714 at AMBOY RD Staten Island NY | .40 g0 gg stavros776@inogic.com Route Link
10309 UsSA
255 at VINELAND AVENUE Staten . .
C K. FRANK MARTARELLA III & SONS Island NY 10312 USA $300,000.00 david11016@inogic.com Route Link
2795 at RICHMOND AVENUE Staten _
D K. DOMINICK DEPINTO & SONS Island MY 10314 USA $290,000.00 josh10399@inogic.com Route Link
1932 at RICHMOND AVEMUE Staten - - .
E Y. JEFFREY GOLDBERGER & SONS Island MY 10314 USA $290,000.00 louisa10348@inogic.com Route Link

innavative logic
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Save Route:

Save The Route x

O Add to existing route
® Create new route *

Route taday

Select route date *

2021-05-03
Users can also save their route plotted. The route record
will also save the information like number of waypoints, Owner
total distance and time for the route. User can add the Select UserTeam
route to an existing route or save the route with a name
& owner as a new route. m

User can also update any route using the ‘Update’

Open Saved Routes ~ button. User can search for routes existing in the
required duration using the option of ‘Open Saved
Select Start Date * Routes’ and click on the ‘Update’ button for the

required route.
2021-04-27

Select End Date *

Save Routes
2021-05-01 —
roure - 21 april

4/21/2021 5:30 AM

Meetings today - 27 April
4/27/2021 5:30 AM
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Clear Route:

The user can use the Clear Route button to clear the
route from the map. This will just clear the route and
directions card will still be opened for further use.

Ot =aQEO3M

Unified view for Route and Records

While user plots the data and then creates a route, both the plotted data and the route will stay on the
map for an easy Route Management. This makes it easy for the user to add more waypoints to the route

and also update the route with the added waypoints.

S SUNSET PARK

Wy

Layer Menu

* Plot Records

> | Directions

Options

® Add destination

)“ =wRahway® ¢

[A) 10 Ellsworth Ave, New York, NY | x

® M. WILLIAM ROSS & SONS: 64 | x
[C) R. PETER CHIANG & SONS: 1¢| x |
(0}

123 Harold St, Staten Island, NY | x

elt g,

| River ,a
£

§
Ry
K
3

nel %RESH KILLS V =S
5 Carteret @

| Port'Reading

BAY RIDGE
/

P

)

BOROUGH PARK

@

NEW UTRECHT @
\%7_ Marlboro

% Houses

Tl e

SEAGATE West Brighton

% L
Met ® Leavenow | Lower New York Bay
o \
% Open Saved Routes ~ ML
\ T‘@T
/ Select Start Date * 8] .
//, 2021-04-27 Amboy é‘.
4 — | hvia Y Jhvd
¥ o g W
é\ @;ﬂ&:“"’i dmies  1km
? g L —
b> Bing 3 | B ViewData | 52021 ToriTom, © 2021 Microsoft Corparation Terms.

Note: The route will remain on the map unless the user clicks on the ‘Clear Route’ button or closes the

Directions Card

©
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Default Origin and Destination

User can set default origin and destination for Route management.
Go to Settings > Maplytics > Maplytics Configuration Details > Record of the user

Maplytics

Map Configuration Details

General Auto Scheduling  Related

Defaults
Distance Unit Mile Region Area Unit Square Meter
Map Mode Road Plot Data Non Cluster
‘Optimize Direction Mo Along The Route
Distance
Live Traffic Mo Current Location
Route Option Shortest Time Navigate In Google
B Map Center Records Per Page In
Grid 50
Heat Map Type Boundary Zoom Level
Summary Grouping City A User @A
Default Template Maplytics Security
Template
Set As Origin Other Set As Destination Other
Other - Set As Origi 819 Catalpa Dr, Mont AL 36112
r - SetAs Origin alpa B, Montgomery, Other - Set As 818 Catalpa Dr, Montgomery, AL 36112
Destination

There are six options to select:

User Mailing Address - Reads address from User mailing address

User Other Address - Reads address from User other address

Business unit Bill to Address - Reads address from logged in user’s Business units bill to address
Business unit Ship to Address - Reads address from logged in user’s Business units ship to address
None - If user do not want to set default origin/destination

Other: It will have its own multiline textbox associated where user can enter their own address

Note: If a user uses the “Plot route” button to plot a “Route” activity record on the
Detail map, the Default origin/destination will not be set in the Direction card
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Snap waypoint

This helps the user to edit a plotted route just by dragging the route to the required point on the map.

Plot Records X ¢ i £
( > =
Q 2 W [ M e
§ ] o { ~~ )
Q8 2wE o /8%
@ V
Filter ~ v z ® e~ 6
Freshkills Park” (@ v - < v ' Y )
P : T Ve : O
{ A 3
| X ® o0
= 4 Latourette Park @ X v
9 Amy Ct, Staten Island, NY 103 ® i )) ) @ @
= -1 F LLS \ W >
Proximity 8
o - 2
@® Distance O Time = .
g = /
Miles v 5 ), : )
[ show Travel Distance = .z Q B
DataSource ~ ) cea > 7
\f =~ (@ = = View 4 \: s
Select Datasource \ @) SNV
Sewz ¢ b
Accour ¥ | | Accounts - v 7' £ Power Newdvel
+ ‘ | @l e
B\ 5 SVAG) % Great Kills Park
Select Category @ / @ i \
| L hY A’. P \/ Y,
Account Select.. v 0 ( M \/ Q ) ()
Overlay v M A
J
12) Y (¢ Seaside
5 >‘ @ () W, ()]
T Barber @ Nl : E v
bgﬁ e = : @ !

2500 feet 14m

View Data

© 2021 TomTom. © 2021 Microsoft Corporation Terms

Drag to a location: User can drag a point on the route to a required location on the map. This will add the

location as a waypoint at the dragged point in the route. This will also update the Directions card with the
newly added waypoint.

Drag to a pushpin: User can also drag a point on the route to a pushpin plotted on the map. This will

detect the record and add the record’s location at the dragged point in the route. This will also update
the Directions card with the newly added waypoint.

Note: The option of snapping waypoints is not available for a route create for trucks.
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Layer Menu “ e(m"d

C12aQOE0

5

= X. FELIX PUSTYLNIK & SONS:

= 123 Harold St, Staten Island, NY |

(® Add destination

§ | Open Saved Routes

b
N e

b Bing
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Along the Route

. & Point = @
! Plot Records B¢ (® f 8 v WILLOWBROOK
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= | Directions / 2\ sland ]
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=
i Options v | ® ‘k% )
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- | I\“‘].Er‘ £
g sland =
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= @ M. WILLIAM ROSS & SONS: 64 | x ‘ g
= : I
= Y. OKEY ORAEDU & SONS: 12! x w £
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Great Kills Park

Lower Nev|
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182021 TomTom. © 2021 Microsoft Corporation jenms,

This feature provides the user the ability to search the
records that fall in the defined proximity along the route.
The default value for Along the Route search can be
configured in the Maplytics Configuration record. This will
find all the records with the defined search parameter and
that falls in the entered proximity along the route.

Options

® Miles
O shortest Time

(J optimize Dire...
J Avoid Toll Roa...

O Kilometres

® Shortest Dista...
(J Avoid Highways
(] Traffic

Along The Ro...

0.5 Miles

Note: The user can add the value between 0 — 25. The user can also add decimal values with a scale of 2

for the radius.
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The Along the route records is also saved when the user saves the route. However, if the user has selected

multiple Datasources on the Plot Card, only the first Entity and View combination in the Select Datasource
will be saved for along the route search in the saved route.

If the user has plotted data on the map and opens a saved route

Confirm!
that has along the route parameter saved as well:
. . . . , This action will clear the plotied records and will plot

e The user can either click on ‘Confirm’ to clear the plotted the Datasource saved in the route. Click ‘0K to

records and search along the route records with the continue Or Click 'Cancel' to plot the route using the

A emstlng search criteria.

Datasource saved in the route.

e Or, the user can click on ‘Cancel’ to search along the route EELER | LTS

records with the existing plotted data, ignoring the
Datasource saved in the route.

If the user opens the Directions card directly without plotting the

. ~ Options
data or opens a saved route without the along the route parameter ® Miles Clometres
saved, they have the option to select the Datasource for the Along _ _
. i X ® Shortest Time Shortest Distance
the route search directly on the Directions Card.
Optimize Direction Avoid Highways
Avoid Toll Roads Traffic
¥ Along The Route 5 Miles

Select Datasource

i
-
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Route Redirect and Copy Route Links

After plotting the route, user can use the
‘Redirect’ button to open the ‘Navigation Links’
popup on the browser as well as the Dynamics
365 App for Phones and Tablets.

The user can click on individual links for route
navigation from point A—B, B—C, and so on. User
can also select the application within the User
Configuration record to navigate the route. Refer
the section of ‘Maplytics Configuration Details
(Personalization)’ in the installation manual to
select the application. These links will redirect the
route to the app selected in the configuration.

MNawigation Links x

For turn-by-turn navigation, please use the
following links

Show Complete Route

From: 22 Depew PI, New York, NY 10309
To: 994 Arthur Kill Rd, New York, NY 10312

From: 984 Arthur Kill Rd, Mew York, NY 10312
To: 2880 Victory Blvd, New York, NY 10314

From: 2880 Victory Bivd, Mew York, NY 10314
To: 218 Rosedale Ave, Mew York, NY 10312

& Copy Links

innavative logic
@ihmsii’g:

6@ MAPLYTICS™

Open Saved Routes ~

Driving Directions ~

9.7 mi

7

44 Light traffic - 7
min min delay
Via Woodrow Rd,
Drumgoole Rd
E - Local roads

9 min (2.4 mi) ~
from 10 Ellsworth Ave, New York, NY 10312
to M. WILLIAM ROS5S & SOMS: 640 at
LEVERETT AVE Staten Island NY

) 10 Ellsworth Ave, New
York, NY 10312

1+ Head northwest on
Ellsworth Awve toward
Woodrow Rd
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Redirect with Google Maps

User can view the turn-by-turn navigations on Google Maps site on desktop and Google Maps App on
Phones and Tablets. User can also choose to view the complete route.

Note:

o The maximum waypoints to show the complete route is 10 waypoints.
e By Default, the navigation will be redirected to Google Maps.

Redirect with Waze

User can view the turn-by-turn navigations on Waze site on Navigation Links =

desktop and Waze App on Phones and Tablets. This will show
the navigation links from current location to the waypoints.

Note: The checkpoints should be under 3000 miles from
the current location to view routes on Waze.

Redirection on mobiles: User can click on the route navigation
buttons to redirect on the Google maps/Waze.
The user can also use the ‘Copy Links’ button to copy the links
to send them as an email or save it into a note.

Note:
e By default, the links will be redirected in Google

Maps.

e The links redirect on the Dynamics 365 App for
Phones and Tablet works with Dynamics 365
v9.x

e For other devices and Dynamics 365 v8.2, users
can use the ‘Copy Links’ button.

@.nas.'tg: &D MAPLYTICS™

For turn-by-turn navigation, please use the
following links

From: Current Location
To: Ismael Tadao

From: Current Location
To: Estela Gopaul

From: Current Location
To: Mathilda He

From: Current Location
To: Rachele Babaev

From: Current Location
To: Vennie Tsitiridis

Navigation Links X

For turn-by-turn navigation, please use the
following links

From: South Brunswick Township, NJ
To: 420 Swedeland Rd, Upper Merion
Township, PA 19406

From: 420 Swedeland Rd, Upper Merion I:I
Township, PA 19406

To: Deakyneville Rd, Townsend, DE
19734

From: Deakyneville Rd, Townsend, DE |:|
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Print Route

User can print a Route as well as the adjoining Map.
User can plot a route on map, click on the ‘Print Route’
button to print the route. It will also print the Driving
Directions as well.
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Clicking on the ‘Print Route’ button will open a new window with the map and Route on the page, which
can be seen in the below screenshot. Click on the Print Icon to print the map and route instructions.

Route:
- e F 4 RDRACE Eim Prk 2 | FATLA
; BAYRIOGE /| BOROUGH PARK . Rosd ¥
¥ £ /
4 £
fpeoriors & 4 e o D)
F Bralis A
Ash K St < sl Non
SRRk ST Rahway (3 R 1 N. BRIAN GILLER'&'SONS: 170 at PURDY = -
~Rgarn A (i AVENUE Statef Island NY 10314 USA @
7
& .5
¥ AvS Linderi-Park “ﬁ"bm Ge
Colhia 3 ¢ South Beach Weflanas, =~ tog
£ Grant City
& Avenel
& ver Carteret P SEAGATE West Brightoh

etin N. GLEN IRWIN & SONS$149 at ELKHART
Port/Reading JSTREET Staten lslag@ NY 10308 USA
gewarks / f Bay Terrace BREE

E. OLE SONDRESEN & SONS: private

Metuchen % O j bag 10306 Stten Island NY 10312,USA Lower New York Bay
e '”" {
e \
William
rds /| Dunﬂ?"ﬂomes /
W larbaro & Sons: 5714 at AMBOY!

\
(e :
RD Staten Island NY,10309

| Perth Amboy _ dmies  ikm.

baing £ s
Driving Directions:
29 Light traffic 9.0 mi
min Via Amboy Rd - Local roads
34  Lighttraffic - 3 min delay 89 mi
min Via Korean War Veterans Piwy N, .
Note:

e Routing requires a minimum of two waypoints provided to create a route.
o A4 size paper with landscape mode is recommended while printing.
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Route to a record

Users can add the ‘Route to a Record’ tab to any entity to view the route plotted to a record’s location
from their current location automatically. If user needs to meet any client, they can open the client’s
record, go to this tab and view the route to reach the client’s location directly. Further, they can click on

the Navigation button oto navigate themselves with the turn-by-turn directions. They can also use the
map to perform other Maplytics actions like Along the route, plotting more records etc.

User's location will be represented by ‘A’ in map, while the record’s location will be denoted by ‘B’

i Dynamics 365 | Maplytics

Fabrikam Robotics - savec Adal
® Recent Account Annusl Revenue o: of Employees | Owne
Pinned Summary Route Map Project Price Lists Details Servicing Related

Y optons - s . > []
. ‘ &
s of g " |
Customers D Add

&n hid Sukhdev Singh @
I S MH 410210 India
R Con

Open Saved Routes
&
Driving Directions
€& Student
& Admins 26
min
Sales M
& Lexc =
[ Opportunities
= View Data

B Quotes

(- P

Steps to add ‘Route to a Record’ tab to an entity form:

Go to Settings > Advance Settings > Customize the system > Entities > Account > Main Form > Add a tab.
Here we have taken Accounts form for an instance.

Now select the tab and click on Insert > Add Web Resource (ikl_ /Maplytics/Maplytics.DetailMap.html)
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Web Resource Properties
Maodify this Web resource's properties.

General Formatting Dependencies

—Web resource

|lﬂ ikl_/Maplytics/Maplytics.DetailMap.html

Web resource ®

Q

—Field Name and Properties

Mame ¥ |'-.-".fel:| Resource_r1

Label * | Route to a record

: Display label on the Form

— Visibility
*.-'is'tl e by default
Er'al:ule for mobile

—Web Resource Properties

Custom Pararneter{data)

k&i‘ 6@ MAPLYTICS™

Cancel

Page 140 of 284




Maplytics™ — User Manual

Auto Scheduling

Auto Scheduling helps users to create an optimized schedule to be followed on the field over a span of
days by the concerned field professionals. The user can perform Auto scheduling on the required set of
records (e.g., clients) to create Appointments and optimized routes, with the considerations of existing
appointments, the preferred days of working, different meeting durations, availability of the selected
users etc. This feature will help user to create appointments and optimized routes based on shortest time

in order to provide an effective plan, hence saving the time and increasing the field productivity.

Users can contact at crm@inogic.com to get the access of the feature and they will be provided with a
Maplytics license with Auto Scheduling enabled into it.

Note: The visibility of the option of ‘Auto scheduling’ into Mass Actions will be based on the Maplytics
Security Template if any assigned to the user. Please refer to the section of ‘Maplytics Security

Template’.

To perform Auto Scheduling user can go to the Mass Actions within the View Data grid. They can plot the
Entity records on the map that are needed to be visited and open the ‘view data’ grid at the bottom to
check the number of records plotted on the map and deselect the records that are not required.

Layer Menu & g
S
o =
B g g & 1
Plot Records > 42 g z <
o | g : ‘
49 2 CASTLETON SUNNYSID S A
—d E EOD.NEE.S SUNNYSIDE
o7

& OS82
( - @ 1 ® E @
5
) Perides EMERSON HILL 4’"%,3/@

Filter
% .
. x S \slandiEXPY =
st = ) mmStaten
Cu o yed a " Py
rent Loca ® ® ) A d
9 Amy Ct, Staten Island, NY ®
Proximity WILLOWBROOK £ ; 3
y ® Manage Territory 4
® Dist OTi Todt Hill :
® Distance 1 D Time | College ® R Send Emall
Miles v z of State )
! 3 Willowbrook nd Execute
_ e Park - "
[0 show Travel Distance B 2 ® 4 Workflow
! < Export To Excel
ol j Create Activities
~ Hide Data Auto Scheduling
=4 ~ Mass Actions
Co..Y | Ema ndustr A 4 Y | Annual Reven... Y

Accounts - New premium clients (17)
dress 1: City 'Y | Primary Cont... Y | Address 1

Transportation

Transportation
ected) 1- 17 of 17 items

Note: Auto Scheduling can be performed on a maximum of 100 records plotted on the map

After plotting the required records to be scheduled for, user can Go to Mass actions > Auto scheduling.
This will consider all the records that are plotted on the map and will proceed to the Auto Scheduling

page.
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Auto scheduling card

User can set the basic preferences as per the requirement so as to consider the same while creating a
schedule. Users can also have these prefilled by setting default values for the preferences within their
Configuration Detail Record. Please refer ‘Configuration Detail Record’ section Installation Manual to see

configuration for Auto Scheduling.

Auto Scheduling

m Consider Existing Meetings

Schedule Start Date *

07/08/2021 =
Select Users *

Joe Smith X
Robert Butler p
Period *

3 Day w
Duration *

75 Minutes e
Start Time *

03 v 00 v AM W
End Time *

05 b 0o b P w
Break *

o1 v 00 v PM v
Break Duration *

60 Minutes hd
Buffer Time *

15 Minutes e

Working Days *

O O
Su Mo Tu We Th Fr 3a

(0 innovative logic
@il‘IDEiC

Consider Existing meetings: Select this option to consider
existing meetings saved in CRM assigned to the selected
users.

Select users: Select the Maplytics user(s) to create
Automated schedule for them. A maximum of 10 users can
be selected to create an automated schedule.

Period: The number of days the schedule should be for. The
meetings will be distributed among the number of days
selected here. User can choose any one option from the
following:

e 1Day

e 2 Days

e 3 Days

e 4 Days

e 5Days

o 1Week
o 2 Weeks
e 3 Weeks
e 1 Month

Duration: The time frame required for each meeting. User
can choose any one of the following options. User can also
change duration for individual meetings in Advanced
Preferences. User can further change the duration of
individual meetings in the ‘Advanced Preferences’.

e 5 Minutes

e 10 Minutes

e 15 Minutes

e 20 Minutes

e 30 Minutes

e 45 Minutes

e 60 Minutes

e 75 Minutes

e 90 Minutes

e 120 Minutes
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Start Time: Time to start the schedule of each day. User can enter the time in 12-hour format (hh:mm)

End Time: Time to end the schedule of each day. User can enter the time in 12-hour format (hh:mm)

Break Time: Starting time of Break for each day. User can enter the time in 12-hour format (hh:mm)

Break Duration: Duration of the break during each day. User can select any one of the following options:

0 Minutes
5 Minutes
10 Minutes
15 Minutes
20 Minutes
30 Minutes
45 Minutes
60 Minutes
75 Minutes
90 Minutes
120 Minutes

Buffer time: User can add extra time to the schedule as buffer to be used in case of unforeseen situations

to avoid changing the schedule.

5 Minutes

10 Minutes
15 Minutes
20 Minutes
30 Minutes

Working days: User can select the days for which the selected users will be working. The meetings will be
distributed only within the working days selected here. User can select any day between Sunday, Monday,
Tuesday, Wednesday, Thursday, Friday, and Saturday. At least one day should be selected.

Note:
[ ]

If the logged-in user has set default values for the preferences in the respective Maplytics
Configuration detail record, while opening the Auto scheduling section, the preferences will

get prefilled with the same.

If the logged-in user selects any other single user, the preferences will get prefilled if there
are default values set in the Maplytics Configuration detail record of the respective selected

user.

If the logged-in user selects multiple users, the preferences will get prefilled if there are
default values set in the Default Configuration detail record.

) innovative logic
@il‘ll:lEilg:
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Advanced Preferences

®

; L Buffer Time
User can further click on ‘Advanced preferences’ within

the Auto Scheduling card to select further preferences to
be considered while creating an automated schedule.

10 Minutes e

Working Days *

O ]
Su Mo Tu We Th Fr Sa
User Details Meeting Details Existing Meetings X

Meetings Per Day Continuous Schedule Reschedule Existing...

20 W No o Mo W

Selected Users

User Origin Destination

Kelly John 1979 Davis Rd, Prattville,... 705 Grier Ln, Wetumpka, ...
Chris Butler 122 Grand Ridge Ln, Wet... 4759 Friendship Rd, Talla...
Gerard Grey 411 Beat Rd, Montgomer... 1801 Railroad 5t, Millbro. ..

Meetings Per Day: User can select the average meetings that should be scheduled for a day. A minimum
of 1 and a maximum of 20 meetings can be selected.

Continuous Schedule: Instead of starting the route from the origin every day, if the route should be started
on the ending location of the previous day, user can set it as ‘Yes’. For example: A user starts the first day
from Brookwood in Alabama, USA to follow the route assigned and reaches Alexander city, Alabama which
is the destination of the route for the day. Now, if the ‘Continuous Schedule’ is enabled, the user does not
need to go all the way to Brookwood to start the route for the next day, instead the user can directly go
to the first appointment scheduled for the second day, from Alexander City itself.

Reschedule Existing Meetings: If the option of ‘Consider Existing Meetings’ has been selected within the
Auto scheduling card, then the option of enabling ‘Reschedule Existing Meetings’ will be available. User
can select ‘Yes’ in order to reschedule existing meetings. This might change the respective owners as well

@.nas.'tg: ﬁO MAPLYTICS™
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to get the highest optimization. If the existing meetings are needed to be met at the set appointment

time, the user should select ‘No’.

Note: If both Onsite and Offsite existing meetings have been considered, then, enabling reschedule
existing meetings will make changes only to the Onsite meetings.

Update Address x

User Details

Selected users will be listed here along with the space
provided for the Origin and Destination locations for
the same. If the default locations for Origin and
Destination are set in the default configuration details
of the users, the same will be prefilled here. If not,
then user can click on ‘Edit’ and enter the required
locations for Origin and Destination for the respective

users. Location for Origin will be mandatory here.

Origin *
122 Grand Ridge Ln, Wetumpka, AL 36093
Destination

4759 Friendship Rd, Tallassee, AL 36078

User can also uncheck any users in this list if they do not want to create an automated schedule for any

user.

Selected Users

User

Chris Butler
Gerard Grey

Kelly John

innavative logic

imnoGic

Origin
122 Grand Ridge Ln, Wet...

411 Boat Rd, Montgomer...

1879 Davis Rd, Prattville, ...

6@ MAPLYTICS™

Destination

4759 Friendship Rd, Talla...
1801 Railroad St, Millbro. ..

705 Grier Ln, Wetumpka, ...
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The details of the records selected to create the schedule will be listed here. Users can also deselect any
record if they do not want to add the record to be considered while creating the schedule.

Maplytics™ — User Manual

User Details Meeting Details
Duration Account Mame Main Phone
30 3DInfotech 7990274947
30 Atlantic Eq... 6893992729
30 Sarah Ferh... = 5839467589
30 Gary Stenl... 653748293
30 David Murp... = 2563894559
30 Paul Coug... | 2345835467
30 Edward Bu... = 3548720974
30 David Bonif... | 3749576789

Page [ 1 |of 1

Existing Meetings

Address 1: City Email

Montgomery | vpratt@esp...

Wetumpka y.philbrick. ..

Shorter salesi@han...

Prattville sales@mrs...

Montgomery | sales@old...

Millbrook a.krueger...

Mt. Meigs admin@mr...

Millbrook akolawai(@...

Annual Revenl Status

369201

222321

Jeagz2

368290

600689

347922

328233

357292

50 v | & Displaying 1 to 17 of 17 items.

Active

Active

Active

Active

Active

Active

Active

Active

X

User can also click on the individual duration of meetings to change it for the respective meetings as well
as enter a value in the blank space to filter the data based on the entered value. In the below screenshots
the data has been filtered by meetings with the duration of 40 minutes and city Montgomery. User can
filter the data for with the values for other columns as well.

User Details Meeting Details Existing Meetings
Duration{Mins) Account Mam Main Phone | Address 1: City | Email Annual Rever Status
40 David Mu... | 2563894559  Montgomery salesi@old... | GO0GE9 Active
40 Robert C... | 4926482678 Montgomery dmayo@st... 689543 Active
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If user has selected ‘Consider Existing Meetings’ in the Auto Scheduling card, the Appointments, Bookable

resource bookings etc. saved in CRM owned by the selected users will be listed here. User can also change

the Meeting type of Onsite meetings to Offsite. They can further deselect the listed meetings or Activities

they do not want to consider and also filter the meetings based on specified values. User can choose one

among the options under ‘Select Meeting’, i.e. All Meetings, Appointments, Service activities or Bookable

resource bookings to view the same in the list below that. Admins can also select the Activities within the

Default Configuration Detail records that are needed to be considered here while Considering Existing

Meetings.

User Details

Select Meeting

All

Meeting Details

Subject/ll Regardir Owner

Prad...

(<.

Pres...

4]

Prod...

Rich...

Blue. ..

Prior ...

Chris...
Kelly ...

Kelly ...

Resourcy Start Time

2020/08/20 09...

2020/08/20 15...

2020/08/20 16...

Existing Meetings

End Time

2020/08/20 10:...

2020/08/20 16:...

2020/08/20 17:...

Dwuration Activity T Meeting |

&0 Appo...  Onsite
&0 Appo...  Oiffsite
&0 Appo.. + Onsite

Offsite

User can click on ‘Proceed’ to get the optimized routes and appointments scheduled for the respective
users based on the preferences provided by the user for the selected working days. Routes for each user
will be shown on the map with different colors. User can select the required users in the card to view the
route for the respective user.

® innavative logic
@il‘IDEiC
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I}
Auto Scheduling ) > Road
|
| v Routes Scheduled Bos ciein @
| A Wetumpka, AL 36092 B /z-_n
i Chris Butler - Deatsville Auburn
Gerard Gre - 4759 Friendship Rd, »
4 Tallassee, AL 36078 fie /,)
Kelly John - Tallassee 9/
- St Caesar Rutledge: 12218 Rifle /
i Prattville s Range Rd. ELMORE Tallassee 36078 A
~ Alexander Soskin: 1504 S Memorial \ 122 Grand'i 1 E":”/ — . g
Dr AUTAUGA Prattville 36067 s A T (R Wetumpkay AL 36063 Tuskegee
411 Boatid, Nl =t
Montgomery, A == - 3 = |
S >
7 css)
Thomas Anderson: Po Box 9007
MONTGOMERY Montgomery 36108
i A 'Pike Road ‘
\ ‘ |
\
| {
[
Hayneville 3 ) 5 miles 10km
‘\\ b mmwwﬁwjgg‘om Microsoft Corporation Terms

It will show the route for the selected user and the respective details of the meetings will also be available
into the data grid below.

| (¢ (e ] > [# p
Auto Scheduling \ | i | | 94| Road
Tit‘us
¢? Directions \
Holtville X Ecle
W Kelly John [===] 3
I i I 705 Grier Ln, @
[ ) 3
‘ Deatsville Welumpke, 8-36002
\ @) | 1979 Davis Rd, Prattville | @
% ; - cdi@um Products: 4211
{ @ | Gary Stenlond: 1802 Hig N ille Hwy ELMORE Deatsville 36022
\ ) Joseph Fischer: P.o. Box Graiden Clayton: Highway

f( [c) Cumberland Vacuum Pn N R e 231 ELMORE Wetumpka 36092
b @ | David Bonifacic: 5260 A \ . 197?“':”:: 4h o
{ ] \ Baret coatings: 637 Coosa River

() Dukes Basketball Camp | (o} Pkwy ELMORE Wetumpka 36092

| | |
[F) Joseph Fischer: P.o. Bo) ) \ | ! —af] {
N \ David Bonifacic: 5260 Airport . >
. t:A Paul Coughlin: PO Box | % n [E Hide Data ‘R{ELMORE Mlllbmok\?sg&.'/ ~— - — Blue Ridge  Redland
Schedule for 2020/08/20 (9)
Waypoint = Schedule Start Time Schedule End Time Account Name Main Phone Address 1: City Email Annual Revenue Status

B B 2020/08/20 8:30 AM 2020/08/20 9:00 AM Gary Stenlond 653748293 Prattville sales@mrsboomer... 368290 Active
= 2020/08/20 9:15 AM 2020/08/20 9:45 AM Cumberland Vacuu... = 3794057898 D jrajt dplaya... 368923 = Active
B D 2020/08/20 10:15AM  2020/08/20 10:45 AM  David Bonifacic 3749576789 Millbrook akolawa@stayandp... 357292  Active
& |E 2020/08/20 11:15AM  2020/08/20 11:45AM  Dukes Basketball C... 8938399298 PINE LEVEL johncarroli@carme... 995383 Active
&= | F 2020/08/20 12:00 PM | 2020/08/20 12:30 PM = Joseph Fischer 6740926739 j 268933  Active
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Transition bar

User can use the transition bar to view the route planned for the
selected user for different days. User can either click on the arrow
buttons to go to the previous or next day’s plan or they can also
select the date in the Calendar to go directly to the date required.

@ih'g“%‘"’i'“é ﬁo MAPLYTICS™
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Create Activities

User can save the schedule as Routes and Activities in the Py fr—
Dynamics 365 using ‘Create activities’ button. The user can < |_08/20/2020 > £
create the following activities:

e Appointments
e Service Activities
e Bookable Resource Bookings

User can also select the option of ‘Create Route(s)’ in order to save the planned routes into ‘Route’ Activity

Entity.
Creato ctiites X

Select Activity *
Select Activity *
Bookable Resource Booking
Appointment Name
Subject C New Clients
Meetings Schedule Start Date *
2020-09-21
Schedule Start Time Sehedule End Time *
2020-08-20 2020-09-22
Booking Status *
Schedule End Time *
In Progress
2020-08-21
Booking Status *
Priority In Progress
High Booking Type *
Liquid v

[
@ Greste Rout(s) ECH =

Note: To make the option of Bookable resource booking visible, user needs to enable the OOB or any
custom entity to create the bookable resource bookings.

Go to Detail Map: Using this button, user can go back to _ &,
’ z —
the Detail map | e < | os202020 f | > |#

Note: All the scheduled data will be cleared, if ‘Go to Detail Map’ button will be used. To save the
schedule created, user can use the option of ‘Create activities’.
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Configuration Details for Auto Scheduling

System admin and Maplytics admin can set the default settings for Auto Scheduling in the Default
Maplytics Configuration Detail record. They can also set the start time as the default start time for the
first activity as well as default values for other preferences for Auto Scheduling.

Go to Maplytics App > Settings > Maplytics Configuration Details > Default Configuration details record
for the user > Auto Scheduling

Maplytics
Map Configuration Details

General Advance Settings  Check-In  Auto Scheduling Real-Time Tracking  Related

Start Time 8:00 AM End Time 5:00 PM
Period 3 Day Duration 75 Minutes
Break 1-00 PM Break Duration 60 Minutes
Buffer Time 15 Minutes
Schedule first activity Schedule Existing
at start time - Meetings

Maplytics

Map Configuration Details

General  Advance Settings  Check-In  Auto Scheduling Real-Time Tracking  Related

Working Days

Mon Tue
Wed Thu
Fri Sat —
5un (N
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Admins can also select the Activities that are needed to be considered while Considering Existing Meetings
in Auto Scheduling. If no Activities are selected here Auto Scheduling will consider all the Activities while
Considering Existing Meetings. If Admins have selected Activities here then only selected activities will be
considered while Considering Existing Meetings in Auto Scheduling.

Maplytics

Map Configuration Details

General Advance Settings  Check-In  Auto Scheduling Real-Time Tracking  Related

Auto Schedule Activities Configuration

Select Entity Select Entit Entity Name Entity View Remove]
Appointment All Appointments e
Select View =
Bockable Resource Booking Active Bookable Resource Bookings e

Users can also set the default settings for Auto Scheduling in their respective Maplytics Configuration
Detail record. Go to Maplytics App > Settings > Maplytics Configuration Details > Configuration details
record for the user > Auto Scheduling

Maplytics

Map Configuration Details

General Auto Scheduling Related

Start Time 8:00 AM End Time 7:00 PM
Period 5 Day Duration 60 Minutes
Break 1:00 PM Break Duration 30 Minutes
Buffer Time 15 Minutes
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Maplytics

Map Configuration Details

General Auto Scheduling Related

Working Days

Mon Tue
Wed Thu
Fri Sat O
5un —

Note: Create Activities for Custom Entity:
e A custom entity should be linked to any OOB Entity into Entity Maps in order to Create
Activities for the Entity
e If a custom entity has its own address, the option to create Appointment and Service Activity
will not be available. The user can only create activity of Bookable Resource Bookings
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Check-In/Check-Out

Check-In feature enables users (sales person/service person) to register their arrival and departure time
for the meeting locations while navigating on field with the help of Check-In and Check-Out buttons. These
buttons will help to tag the geo-coordinates of the location while a user is visiting a client. This will also
help the management to track the activities of the field professionals as well as the time they have spent
on every meeting.

Configuration

To get started with the feature of Check-In, the first step is to configure Maplytics. Configuration will
create the Entity Map for the Check-In entity. Please refer to the section of ‘Configure’ under the ‘Initial
Setup - Maplytics License Activation, Configuration for Entity Map, Dashboards and Census data’ within
the Installation manual.

This feature can be enabled for any OOB or custom entity within their respective Entity Maps. To enable
this, System Admin/Maplytics Admin can follow the steps mentioned below. The following screenshot
shows the entity map of Appointment for an instance.

Go to Maplytics App > Settings > Entity Maps > Open Required Entity Map > General Tab > Enable Check-
In > Set the value to ‘Yes’ & click on ‘Save’.

ENTITY MAP
appointment

General Attribute Mappings  Toocltip Mapping  Category Configuration  Configuration  Advance Settings  Related

Entity Name * ‘ Appointment | Link To ‘ Regarding
B Total Records 22
£ Geocoded Records 22 £ Enable Check-In Yes
Note:

e The default value for ‘Enable Check-In’ is set to ‘No’.
e User cannot undo this option, once selected and saved.
e After enabling this feature, please wait for a while before using this.
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Related records for Check-In/Check-Out

User can use the feature of ‘Plot Related Records’ to view the related records (Appointments, Accounts,
etc.) for Check-In/Check-Out records that are plotted records on the map. using. This will help the
managers to understand for which record has the sales person/service person checked-in/out. To plot
related records for Check-In/Check-Out, user needs to select the relationship. To select the relationships,
admins can follow the steps mentioned below. We have provided the steps for Appointments for an
instance.

Go to Maplytics App > Settings > Entity Maps > Required Entity Maps record > Configuration > Related
Records Configuration > Relationship List > Select appointment - ikl_checkinentity

User can also refer to the section of ‘Related Record Configuration’ under the Entity Maps within the
Installation manual for the same.

Note: User needs to select the respective Relationship with Check-in for every entity within their
respective entity maps for which they want to see the related Check-In/Check-Out records.

ENTITY MAP
appointment

General  Attribute Mappings  Tooltip Mapping ~ Category Configuration ~ Configuration  Advance Settings  Related

Related Records Configuration View Configuration
Relationship List L] View List H ¢ x
Relationship List Relation Schema Default Relations... | Views T View Type Y| Color Pushpin
appaintment - annotation ¥ Al Appointments System View - .
appeintment - slakpiinstance ent
¥| Appointment Planner Dashboard Record - |
appeintment - syncerror Appointment_SyncErrors
appeintment - actioncard appointment_actioncard ¥ My Appointments System View -
appeintment - queueitem Appointment_Queueltem (
¥| Wy Completed Appointments System View - r
appointment - bookableresourceboo msdyn_appointment_bookableresour .
¥ Ny Draft Appointments System View -
appointment - msdyn_resourcerequir msdyn_appointment_msdyn_resource v
I 4 appointment - ikl_checkinentity ikl_appointment_ikl_checkinentity I

After enabling the feature, user can also enable the option of ‘Check-Out’. This way the user can first click
on the Check-In button while visiting the meeting and then can click on the Check-Out button while
completing the meeting. Here, as the geo-coordinates for both the locations will be saved, it will also help
the management to track the time spent on the meetings.
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In order to enable Check- Out, System
Admin/Maplytics Admin can follow the steps
mentioned below:

Go to Maplytics App > Settings > Map Configuration
Details > Default Configuration Detail Record (the
one with no user name) > Check-In tab > Set the
value for Enable Check-Out to ‘Yes’ & click on ‘Save’.

Note:

MAP CONFIGURATION DETAILS

Maplytics

General  Advance Settings  Check-In  Auto Scheduling  Related

I Enable Check-Out Yes I

Default Radius 0.20

Geofencing No

e The default value for ‘Enable Check-Out’ is set to ‘No’.

e User can anytime disable this option.

o Check-Out option can only be enabled for entities for which the feature of Check-In has been

enabled.

e Check-Out can be enabled/disabled only at Organization level.
e Check-Out button will only be available for the records for which the user has checked-in.

Default Radius

It is the distance that the System admin/Maplytics admin can set to consider the accuracy of the Check-
In/Check-Out records created by the field professionals. If the Check-In/Check-Out record do not lie within
this radius then it will be considered as invalid record and will be shown with a pushpin with this Red

Cross. For example: @

MAP CONFIGURATION DETAILS

Maplytics

General  Advance Settings  Check-In

Enable Check-Out Yes

Default Radius

Geofencing No

Auto Scheduling  Related

Note: By default, Geofence radius is 0.20 kilometers or miles depending on the unit set in User

Configuration Detail record.

) innovative logic
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Geofencing

Geofencing is creating a virtual geographical boundary of a specified Geofence radius around a record. If
Geofencing is enabled, user needs to be within this radius to successfully Check-In/Check-Out for a record.
If the user is not within this radius, the user will not be able to Check-In/Check-Out and will be shown a
message specifying that they need to be within ‘n’ Km/Mi of distance from the Check-In/Check-Out
location. This will help the management to have only valid Check-In and Check-Out records done by the
field professionals.

In order to enable Geofencing, System Admin/Maplytics Admin can follow the steps mentioned below:

Go to Settings > Map Configuration Details > Default Configuration Detail Record > Check-In tab >
Geofencing > Set the value for Geofencing as ‘Yes’

Maplytics

Map Configuration Details

General Advance Settings Check-In  Auto Scheduling

Geofencing Yes

Geofence Radius 0.20

Allow to create
pending -
Checkin/Checkout

Geofence Radius
After enabling Geofencing, System Admin/Maplytics Admin can set the default value for Geofence radius,
which will be considered while a user Checks-In, or Checks-Out.

Note:
e By default, Geofencing is disabled in which case the user can Check-In/Check-out from any
location.
e By default, Geofence radius is 0.20 kilometers or miles depending on the unit set in User
configuration Detail record.
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Enable Notes on Check-In and Check-out

Admins can enable this option to let the users add notes to the record for which they are checking in/out.
To enable this option, go to Map Configuration Details > Default Configuration Detail Record > Check-In
tab > Enable Notes on Check-In / Enable Notes on Check-Out.

The admins will have three options to select:

e Disable: This will disable the option to add notes while Checking-In or Checking-out.

e Optional: The user is shown the pop up for notes but they can check-in or check-out without
adding the notes.

e Mandatory: It is necessary for the user to add notes while checking-in or checking-out.

Maplytics

Map Configuration Details

General  Adwvance Settings  Check-In  Auto Scheduling  Real-Time Tracking  Related

Geofencing No Enable CheckQut Yes
Allow to create Enable Motes on <l o
pending (] Checkout —oelect--

Checkin/Checkout -
Enable Notes on Disable

Default Radius 0.20 Checkin Optional

Mandatory

Reasons for Requests

Pending Check-In/Check-Out Requests

System Admins and Maplytics Admin can enable this option to allow the users to create the requests for
Check-in/Check-out for meetings in the past. For example, if a user had an offsite meeting or missed to
check-in/out for any meeting, they will be able to create requests for check-in/out for such meetings if

this option is enabled.

To enable it, go to Map Configuration Details > Default Configuration Detail Record > Check-In> Create
pending Check-In/Check-Out Requests > Select the checkbox
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Maplytics
Map Configuration Details

General  Adwvance Settings  Check-In  Auto Scheduling  Real-Time Tracking  Related

Geofencing No Enable CheckOut Yes
Allow to create Enable Notes on
pending ‘ % Checkout -
Checkin/Checkout 4 h

Enable Notes on
Default Radius 0.20 Checkin

Reasons for Requests —

Note: Any user who would be inside the defined Default Radius/Geofence radius of a record
will not be able to create pending check-in or check-out for the respective record.

Once this option is enabled, the admins can also see the ‘Reasons for Requests’ which shows the

list of acceptable reasons that are predefined. The users can select anyone while creating pending

Check-In/Out records. The admins can also configure custom Request Reasons by going to Check-

in Entity within CRM Customizations.

©

Maplytics
Map Configuration Details

General  Advance Settings  Check-In  Auto Scheduling  Real-Time Tracking  Related

Geofencing No Enable CheckOut Yes
Allow to create Enable Notes on
pending Checkout B

Checkin/Checkout -
Enable Notes on

Default Radius 0.20 Checkin

Reasons for Requests --Select-- hd

Unable to find the gps location
Network issue

Forgeot to Check infout on field
Meeting on off-site location
Other
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Creating Check-In/Check-Out records

While navigating on field, user can Check-In and Check-Out for any record. This can be done in the
following two ways:

e From Record Form: User can open the respective record (Appointments, Accounts etc.) and click
on Check-In/Check-Out button on the ribbon.

[©] Save " Mark Complete O Refresh '&9 Map @ Check-In X Close Appointment E?J Process E Convert Toa ™ 2= Recurrence
Appointment: Appeintment Priority
Appointment for Insurance Plan B3 Norma

Appointment Tab Related

Required 1 Adventure Works Electronics
Optional -

Subject *  Appointment for Insurance Plan B3
Location -

Regarding L Adventure Works Electronics

Save " Mark Complete o Refrash &9 Map @ Check-Out X Close Appointment B3 Process - Z Convert To ™ Z Recurrence
Appointment: Appointment Priority
Appointment for Insurance Plan B3 Norma

Appointment Tab  Related

Required A Adventure Works Electronics
Optional -

Subject *  Appointment for Insurance Plan B3
Location —

Regarding 4 Adventure Works Electronics
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Appointment: Appointm...
Appointment for Insurance Pl..

~" Mark Complete
) Refresh
& Map

X Close Appointment

B1 Process >
£ Convert To >
= Recurrence
@ Delete
2 Email a Link
Adventure Works Electronics e
Optional
0
Subject *

Appointment for Insurance Plan B3

&« = g pel &

Appointment: Appointm...
Appointment for Insurance Pl...

]
~ Mark Complete

O Refresh

& Map

X Close Appointment

B Process >
% ConvertTo >

=~ Recurrence

W Delete
& Email a Link
£ Adventure Works Electronics P
Opticnal
0
Subject

Appointment for Insurance Plan B3

& = [} 2 @]

Note:

User needs to allow to read the GPS location of the device in order to Check-In/Check-Out.

Once checked-in, user can click on the same button to check-out.

e Through Detail Map: User can click on any plotted records (Appointments, Accounts etc.) to open

the respective Tooltip Card and click on the button to Check-In/Check-Out.

@in@%“i&k

¥ AMC Discussion

= DIRECTION =p SETASCU... =p SETASP..

340 228 Ave. NE Sammamish WA 98074 USA

Subject: AMC Discussion
Regarding: Trey Research Assembly
Priority: High

Start Time: 18-07-2019 15:10

End Time: 18-07-2019 15:10
Appointment Type: Not Recurring

Take An Action

6@ MAPLYTICS™

¥ AMC Discussion

= DIRECTION =p SETASCU... =p SETASP..

340 228 Ave. NE Sammamish WA 98074 USA

Subject: AMC Discussion
Regarding: Trey Research Assembly
Priority: High

Start Time: 18-07-2015 15:10

End Time: 158-07-2019 15:10
Appointment Type: Not Recurring

Take An Action
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Maplytics - Detail Map B X
th Or2 | ayer Menu <, <
plewor = e e

o PlotRecords X ey City

L. MICHAEL GRAPPERHAUS ... :
0

4 <P
= DIRECTION «pSETASCUR..  SETASPOI.. 9 @

ellé 577 at Lisk AVE Staten Island NY 10303

Rosy Line-of-Sight Distance: - o
| Account Name: L. MICH; @ >ERHAUS (
L zsons ]
1278
=

Main Phone: 411001954 .

<

ahway

Take An Action

/| 000006

OE

<

etc.)

Note: Multiple Check-In/Check-Out records can be created for any record (Appointments, Accounts,

Adding Notes while checking-in/out

While a user registers a check-in/out, they can add
some notes or attachment for the respective
record. For example, if they want to add some notes
related to the meeting they did, or any documents
they need to attach regarding the requirements of
the client, they can use this option to add the notes
or attachment.

Users can further go to the respective record to see
the notes and attachments within the timeline of
the Activities. If a user is checking-in/out for an
activity record like appointments or Bookable
resource bookings and has added notes or
attachments then in such cases the notes and
attachments will be saved within the respective
related record (for example, Account/work order)
saved in the regarding field.

@in@%’ig

6@ MAPLYTICS™

Check-In b4

Client needs 50 premium-A chairs

Select Attachment

Choose file | MOM 1...21.docx

Supported file type: .xlsx, .tet, xml, .png, jpeg, .jpg, -svo.

docx, .pdf, and .ods
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Creating Pending Check-In/Check-Out requests

If users want to check-in or check-out for a record for
which the meeting/service has been done in the past
but they missed to check-in/out at that time, because
of an off-site meeting or let’s say if they forgot to check-
in/out, so they can create check-in/out requests for
those records later sometime. They can select the
reason why they missed and select the date & time of
the meeting for which they missed to check-in/out and
click on ‘Create’. The requests will be pending for
approval from managers. Unless the records have been
approved by the manager, the records will not become
active check-in/out records and will remain as pending
check-in/our requests.

Check-In Y4

Select Attachment

| Choose file | No file chosen

Supported file type: .xlsx, .bet, .xmil, png, .jpeq, -Jpg, -Svo,

Check-In %

Add Notes Here...

Select Attachment

Choose file | Mo file chosen

Supported file fype: .xlsx, .xt, .xml, .png,
«docx, .pdf, and .ods

Check-In Time *
2021-03-23 05:30:00 Ph ©)]

Reason *

Meeting on off-site location

.ipeg, -jpg, .svg.

.docx, .pdf, and .ods
Check-In Time *
2021-03-23 05:30:00 PA E ©

Reasomn *

Other v

Had a family emergency

If the user wants to enter a reason which is not listed
then the user can select the ‘Other’ option and enter
their reason in the provided text box and click on
Create. These check-in/out requests will be converted
to an active check-infout record only when the
respective manager approves the reason for missing
the check-in/out and hence approves it to be a valid
check-in/out records.
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Visualize Check-In/Check-Out records on Detail Map

The managers can visualize the activities of field professionals by plotting
the Check-In/Check-Out records on the map just like any other entities
with the help of the Plot Card. User can select ‘Check-In’ as the Datasource
and select a required view to visualize the records from that view.

Plot Records

QL 2™0E

Filter -
Cluster Map
Current Locq Select View
System Views

Active Check-Ins

Active Check-Outs
Check-Ins This Month
@ Distancd Check-Ins This Week
Check-Outs This Month
Check-Outs This Week
O showTrd Inactive Check-Ins
Inactive Check-Outs

Wy Check-Ins This Week
My Check-Outs This Week
Today's Check-Ins
Select Datad  1o4a1s Check-Outs

Check- v | Select Viev v

Proximity

Datasource

Select Category
Check-In || Select..
If
Layer Menu < ——a »: B4 Road
—and, 4
- ) Regent’s Park ~\\\\\\’/\\ ONTO
Plot Records Y Ry @
FINSBURY || EEDo
Q8 2™ B =
St Lukes \\\ @-;
Filter ~ Cofe \ S
= Primary ﬂeri" R
School
Cluster Map @
} =0 Saint Luke's
Current Location
@® :
9 Amy Ct, Staten Island, NY 103 v d Liverpo
: " © bt Strget
ﬂ Proximity
" @pistance OTime et A ©  swiTHRELD b e
' Miles v o =@
i\ < Fleet Street
\ [0 show Travel Distance @ LA HOLBORN CHEAP
\‘ RO A CORNHILL
b I S
| DataSource A e s 5
< ® T ot Temple s & =4
® @ =
Select Datasource @ \.) A2
= @ ©
Check- v | | Last week v @ . (4] @
4 ®
Select Cat $ \
elect Category S *‘nuu,‘m,kBSANKSIDE e
‘ Check-In || Select C... ¥ = et
© e Guys [rx]
3 f GREEN PAiRK ’ ’L:nmann 1000 feet 1OSPIt3! 00m
7 = 7 y rioo
> Bin: Kensington Road | [ View Data l s Foo: S 2021 rosc Corporaton Tems

Oz &rwwurmos-
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Analyze Check-In/Check-Out records
After plotting the records for Check-In and Check-Out, user can analyze the pushpins by distinguishing
between the following two kinds of pushpins:

e Valid Check-In/Check-Out: When a user Checks-In/Checks-Out within the Default Radius or

Geofence Radius, it is a valid record and will be represented by v pushpin.
e Invalid Check-In/Check-Out: When a user Checks-In/Checks-Out outside the Default Radius it is

£
represented by ¥ pushpin.

Visualizing Related Records

After plotting the records for Check-in, user can also choose to view the records (Appointments, Accounts
etc.) against which the plotted check-ins and check-outs were created.

Visualizing Related Record (Appointments/Accounts, etc.) for Check-In/Check-Out records

After selecting the relationship, user can choose to view the related record for any Check-in and Check-
out record plotted on the map.

Layer Menu

Coram’s Fields

 A201]
vy e e
Filter A o 5 % = ar
Cluster Map . % @ Check-in Record ound Station € @
Current Location o  Bso6}
 As204]
9 Amy Ct, Staten Island, NY 103  A4200]
Proximity ndert ik SMITHFIELD  garthorm,
® Distance O Time Hosn
Miles > 4 & Lincol  B400)
~ © oD [ 2ol i Fiel 74
[J show Travel Distance ) e hyard of §
Q R Fleet Street
HOLBORN
Ungey DataSource ~ Z [A201]
l T Related Record
ct Datasource ) v ela’ ecor m L
Select Datasource %, % o Holbon]g;rand{ovem 2
Check- v | | Last week v | @ . E g i [ A4 PR CASTL

+

Select Category

Temple
aw

Check-In | Select C... ¥

T 8

View Data € 2021 Microsoft Corporation Jerme.

THE ROYAL ARCADE

The related record can be visualized in the following two ways:

e By Contextual Menu: User can right click on any Check-In/Check-Out pushpin to open the
‘Contextual menu’ and click on ‘Show Related Record’. This will plot the related record for the
selected pushpin. To hide the related record, user can again right click on the same Check-
In/Check-Out pushpin to open ‘Contextual Menu’ and click on ‘Hide Related Record’.

@:I‘IDE.IIg: &9 MAPLYTICS™
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e By Tooltip Card: User can click on the Check-In/Check-Out pushpin to open the Tooltip Card and
click on ‘Show Related Record’ from the ‘Tooltip Card Actions’. To hide the related record, user
can again click on same Check-In/Check-Out pushpin to open the Tooltip Card and click on ‘Hide

Maplytics™ — User Manual

. Show Related Record
Directions >
Add To Route

Set As POI Location
Actions >

Pen Save Settings >

Set As Current Location

Related Record’.

innovative

noGi

k&ic

- n" ,-"f
d Open Record

a
ba Hide Related Record

Directions >

2

Add To Route

Set As Current Location
Set As POl Location
Actions >

Save Settings >

¥ account-City Power & Light ...

¥ account-City Power & Light ...

=» DIRECTION =+ SETASCU.. =p SETASP..

D-16/2, Sanpada Midc Road Navi Mumbai MH ...

MName: account-City Power & Light Integration

= DIRECTION =+ SETASCU.. =p SETASP..

MName: account-City Power & Light Integration

D-16/2, Sanpada Midc Road Navi Mumbai MH ...

Owner: Sam K

User Latitude: 47 66669

User Longitude: -122.19854
Created On: 15-07-2019 11:54

account: City Power & Light Integration

Take An Action

cEp

Show Related Record Li‘ —--'! .
hd .

6@ MAPLYTICS™

Owner: Sam K

User Latitude: 47 66669

User Longitude: -122.19854
Created On: 18-07-2019 11:54

account: City Power & Light Integration

Take An Action

g

Hide related record I"
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Visualizing related Check-in/Check-Out records for plotted records (Appointments, Accounts,
etc.)

After selecting the relationship for the required entity within the entity map as suggested above, user can
click on any plotted record to open the Tooltip card and click on ‘Plot related record’ to plot the related
Check-In/Check-Out records.

= DIRECTION =+ SETASCU.. =p SETASP..
Select the relationship to plot related record

[ appointment - ikl_checkinentity (ikl_appoint. ..

wLie (] S lol=1E] —

2624 NE University Village Street Seattle WA ...

Take An Action

e S~
§OR Layer Menu < TR
- SE {1501} i St Luke's
2 Cofe
2 =2 Primary.
% Schoof
e | As201] Saint Luke's
@ £ BN
Liverpool
e © Street @
A s SMITHFIELD < e
{ Ai2n]
Fleet Street
HOLBORN
RO I8 CHEARD CORNHILL €
b= e =3
Pl o>
T o Temple $=4
West End e P e e o -y
[oo! 4
THE ROYAL A=2
ARCADE P-S 1945
- V. == MAYFAIR [ 5327
A [A300)
Hyde Park \ - N S,
N\ ° n E Hide Data S Al 1
V| lame reet wner ser Latitude ser Longitude
M N Y | Street1 Y | O Y U itud Y | U gitud Y
account-LORETTA'S KITCHEN LTD sam S 51.52 -0.12 *
)« 9 » el 200 v items per page (1 Selected) 1 - 1 of 1 items
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Visualize Pending Check-in/out requests

Managers can select the required view for the Check-in/out requests and plot the same on the map in

order to visualize the pushpins.

Layer Menu i
N | Plot Records

OS82 B
4 Filter A |

Cluster Map \

Current Location

Proximity

® Distance O Time

Miles v ‘
)

A

A 1

Select Datasource
Check- ¥ | | Today's pe vV ® .
+

Select Category

Check-In || Select... v

" Overlay

iNGke Charles

Lafayette ~——IMetairie”

kson

LUUIIAINA =] | S 4
\ Baton Rouge S

Florence

N 7N

Tugelo T

Starkville

/
By
.
y,

J

Mississippl /~

J

Hattiesburg :
{ ~

A

J

3 ‘<6u|f}>oﬂ “Pascagoula

Tuscaloosa

1
§
f

\ -
Huntsville
|

ALABAMA
Mon}gv5méry

/

Pensacola

B View Data anama City

_MOGbile =~ Crestview

B
Columbus

Tallahassee R

Albany

Nantahala
National Forest

Macon_ 3 '
i /
\ ~—Statesboro
| NS

\ Savannah

S

Hinesville

GEORGIA

\

Valdesta {
N

P 100%m

—acrsemville——————
\@ 2021 TomTom. € 202 Microsof Corporation Tems.

Approve/Reject pending Check-In/Check-Out records
Once the manager has plotted the pending check-in/out request records on the map as shown above,
they can check the request records created by field team and approve or reject the records in order to

accept it as an active check-in/out record or reject it.

If manager needs to approve/reject the requests from a
particular salesperson, they can also select ‘Owner’ within

Check-In - Owner

the ‘Category’ in the ‘Plot Records’ card to categorize the Select All H
request records with Owners. Manager can further go to the )
category card to deselect the other owners so as to visualize Joe Smith ';.}' .
only the records created by salesperson who reports to !
them. Sams I’\I..J;I .
William Smith '!f' .
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Now, manager can click on a pushpin from the map

h he A Rej . Admi
account-Kentucky Tenn. e and to the see the pp.rove/ eject bu.tton dml.ns
can also go to Maplytics App > Settings > Entity

=% DIRECTION =+ SETASCU.. =¢ SETASPO... map > Check-in entity map > Tooltip Mappings
> Add Request reason. This will show the Reason
Sulphur Mills Limited, 8, Hariba Sadhu Gay. .. for request on the tooltip card while a manager

Reason: Network issue clicks on a pending check‘-m/out. After checking the
, reason, manager can decide and click on the button
Owner: Joe Smith . .
to open the window and select Approve or Reject
account: Kentucky Tennessee Clay Co and click on save.

Approve / Reject x

C approve

Take An Action

O Reject
Manager can also use the option of
Approve/Reject from the Mass Actions to

approve or reject all the pending check-in/out
request records plotted on the map.

Layer Menu \ §
B v amsccsia - 3 " 2 5 Nantahala

National Forest
. Plot Records

= DIRECTION =» SETASCU...

=» SETASPO...

Sulphur Mills Limited, 8, Hariba Sadhu Gay.

% “ Reason: Network issue
~ Owner: Joe Smith
. account: Kentucky Tennessee Clay Co

Take An Action Tusealoosa

| ceee®

5\ % J
At 3
\ Auglq_sta
\ ki Manage Territory &
Send Email }
M :csn

\\ Execute

7] Workflow

— e g ¢

\{ W Vi Meridian Sta@ Export To Excel
4 \& y S Create Activities

4 N i 4 o \

\ T AN ) e |

Today's pending check-ins (12) +* Related Reco... | «+ Mass Actions

Name 4 Y | Street1 Y | Owner Y | User's Latitude Y | User's longitude Y | Reason Y | Status Reason Y | Status Reason Y

E, account-Kentucky Te... | Sulphur Mills Limited... | Joe Smith 33.66 -87 | Unable to find the g... | Active 2

=) account-Kentucky Te... | Sulphur Mills Limited... = Joe Smith 33.17993 -86.61626  Network issue Active

=] account-Laitinen, Ste... = Sulphur Mills Limited... = Joe Smith 33.45465 -86.98836 Had Family emergency = Active

w)( < @ > 50 v | items per page (12 Selected) 1 - 12 of 12 items

e Only the system Admin, Maplytics Admin, or the Manager of a user can approve or reject the
respective pending check-in or check-out records.

e Once the manger/admin approves/rejects a record, they cannot approve/reject the same
record again.
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Land Area Mapping

If users work with lands, real estates or farms etc. they can visualize their lands on map with this feature.
Users will be able to assign land regions to the records and visualize them on the map to understand the
coverage of area for each of the records using this feature.

Maplytics - Land Area Mapping B X

Plot Options ﬁ\)

Select Option v

6 Dou!Tfaa

Anpiston ),
Carrollton

alladega 7 McDohough
Newnan

\Vi

L Alabaster
Tuséaloosa™ &

Louisville /

Griffin @
Tified

/ = (20 . gevill
—Kosciusko \ < A s i
LaGrange
\ 9 -
\ f & Thomaston e
. ) 4 g Maton,
3 Philadeiph |+
Carthage i % FENAN
% T oy
{ 5 O
Jiton Opelika ¥ Robins
/ Demopolis.
: Coll @
Selfoa Columbus
Brandon Bienville
£ National Forest
.
N Americu:
N Cordele
Eufabla
Troy 74
itzgéra
ALY Sylvester

——Hattigsburg

ColUmbia

> Bing Despto National

©2021 TomTom)\@

Create and Assign land areas to entity records

Create 1: N relationship with Geography entity

User first needs to assign the land regions (Geographies) to the records of the CRM entity for which the
lands are to be visualized. For this, the user needs to create 1: N relationship between that entity and the
Geography entity. For example, if the user wants to visualize the landscapes for Account records, so to
create a 1: N relationship between the Accounts entity and the Geography entity. User can also add a grid
on the Accounts form in order to see the list of landscapes that have been assigned to the record.
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Dynamics 365 ~  Maplyti Sales > Accounts > 10301_A
= @ Save @ Save & Close New & OpenOrgChart [ Deactivate “R Connect = Add to Marketing List &, Assign
{1 Home
o 10301_A --- - Amit Bangar
(O Recent N Account Annual Revenue | No. of Employees | Owner
5 Pinned ~ Summary Map Details Geography Related
My Work Geographies (Account) New Geography
= Dashboards | Name 1
B Activities Atherton Active
Customers Leigh South Active
J& Accounts
R Contacts
Sales
& Leads
[t Opportunities
B Quotes .
~
B sales v B Active e

Attribute Mapping for Landscapes

Once the relationship is created, select the same in the respective Entity map. As per our example, the
Maplytics admin or system admin needs to go to Maplytics App > Settings (Left bottom) > Entity Maps >
Accounts Entity map > Attributes Mapping > Geography relationship > Select the 1: N relationship of
Geography and Account.

account
Entity Map

General  Attribute Mappings Tooltip Mapping  Category Configuration  Configuration  Advanced Settings  Related

Address Line 2 Address 1: Street 2 Zip Code Address 1: ZIP/Postal Code
Address Line 3 Address 1: Street 3 Country -

City Address 1: City Latitude Address 1: Latitude

County - Longitude Address 1: Longitude
Phone Main Phone Website --

Email - Land Area Mapping Account - Geography{

Account - Geography

V]

Territory -
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Assign lands to single record

In order to visualize the land of a record, user first needs to create the geography for the landscape and
assign the geography to the respective record. To do this, open the required record and click on ‘more

commands’ - to click on the button of ‘Land Area Mapping’.

Dynamics 365 Maplytics

= Save J Save & Close New @& Open Org Chart D Deactivate A3 Connect ‘ v T Add to Marketing List A/, Assign
a1 Home .
- 0969 Ocean View Road %) Email a Link |
(D Recent ~ Account r
= ]ﬁ[ Delete
57 Pinned N Summary Map Project Price Lists  Details  Field Service  Scheduling  Related () Refres!
) Re =)
Check Access
My Work ACCOUNT INFORMATION Timeline & Check Access
s P & Map
w Dashboards Account Name 0969 Ocean View Road 2 Search timeline
@ Check-In

Iz Activities Enter a note... @J

Phone (415) 555-9933 & A

- aie Land Area Mappin:
é! = Auto-post on 0969 Ocean View Roal .ng T {h
Customers Email . Account: Created By Bal m. Ba Process Land Area Mapping
| Accounts ® Geo Code Assign area to record(s)

ax -
Q, Contacts =2 View Hierarchy -

Website
Sales

B A "
@ Leads arent Account

[ opportunities Ticker Symbol

E Quotes

H Sales

Relationship Type

<>

E2 Active Save

After clicking on “Land Area Mapping’, a new window will open as shown below where the user can
upload Shape files or Excel files or draw shapes for the landscapes on the map.

Maplytics - Land Area Mapping

Plot Options

5 | 1
Select Option v P

3

W Cotlege St

Highw ay 70

{yf 4paID UMOL

b Bing
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Plot Options

There will be two options that can be used to plot the landscapes on the map.

e Shape File
e By Drawing
Shape File

Users can select a shape file or an excel file to plot the respective lands on the map. The supported file
formats are .shp, .kml, .geojson. Once the file is plotted on the map, user can use the selection tool at the
right top corner to select, deselect, multi-select or delete the regions plotted on the map. Now user can
select the required regions and right click to Assign Area.

Maplytics - Land Area Mapping B X

Plot Options
Shape File

Choose File | alabama.geojson

Supported file type: .shp, .kml and .geojson

User can here select the name for the selected region and click on ‘Proceed’ to save it.

Assign Land x

Area Mame *
STATEFP10
Select Record *

A, HARRIS PERSAUD & SONS
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By Drawing
Users can also create geographies for the landscaping using the option of ‘By Drawing’. They can use
the drawing tool to draw the shapes for the required landscape on the map. Further, use the selection

tool to select drawn shape(s) and right click to assign area.

Maplytics - Land Area Mapping

Plot Options

By Drawing v i
Double
Define Shapes Springs ===

Jmolollsll21 0@

Assign Land

Caledonia |

West Point
5 miles

b Bing

Millport

Sumiton

Empire]

10km

2021 TomTom. © 202 Micrpsoft Corporation Terms

Enter the name of the geography and click on ‘Proceed’. The color of the drawn shape changes after

getting assigned to the record.

Assign Land X

Land Name *

Hamilton

Select Record *

King, Christopher & Esq
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Assign lands to multiple records
User can select multiple records from the home grid and assign lands to the selected records from the
same map. After selecting required records, user can click on the ‘Land Area Mapping’ button.

Dynamics 365 Maplytics P @

= & [ showChart ¢ Edit [ Activate [ Deactivate [i] Delete | ~ & Detail Map & Heat Map

=t Home

Account - AL - USA ~ kg Search this view 2
(© Recent N
v Account Name Main Phone Address 1: Cit Primary Contact Email (Primary Contact,
s# Pinned ~
v K Cs Cstm Mouldings Wi 9075863711 Mobile --- - Active
My Work : .
v Kelly, Charles G Esq 9078681030 Mobile --- - Active
¥  Dashboards ) .
v Kentucky Tennessee Clay 9073493342 Columbiana --- - Active
Activities
v Killion Industries 9073455932 Spanish Fort --- == Active
Customers v King, Christopher A Esg.. 9076968089 Winfield - --- Active
Sl Accoun -
I Accounts v Kigo Pure Gold Oldies 10 9074574992 Opelika == == Active
Contacts
A Kisc 98 Kiss Fm 9073575633 Birmingham - Active
Sales Knights Inn 9074561408 Birmingham - - Active
& Leads L & L 5ales Co Inc 907 MONTGOMERY - - Active
[ opportunities L Winik & Assodiates Inc. 9072255166 Mountain Brook - - Active e
B Quotes M+ A B C D E F G H ) K L M N o P Q@ R S5 T U ¥ W X Y z
H Sales 0 1- 50 of 81 (6 selected) & & Pagel

After clicking on ‘Land Area Mapping’, a new window will open as shown below where the user can upload
Shape files or Excel files or draw shapes for the landscapes on the map as mentioned in the section of
‘Plot Options’ above. Now just like mentioned in the sections, use the selection tool to select the required
land on the map and right click to ‘Assign Geographies’'.

User can now select the area name if used a shape file or enter the area name if used the drawing tool
and further select the record to which the respective land has to be assigned. This is how user can select
the required region and assign it to all the records.
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Maplytics - Land Area Mapping B X
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Supported file type: .shp, .kml and .geojson
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Visualizing Assigned lands to the record

Users can select the entity in Datasource and the respective view in the ‘Plot Records’ card in Detail map
to plot the record on the map as pushpins. While visualizing records on the Detail map, users can right

click on any pushpin to open the Contextual menu and use the ‘Show Land Area’ button to plot the land

that is assigned to the respective record.

Maplytics - Detail Map
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If the user wants to see all the lands that have been
assigned to all the records that are plotted on the map,

they can use the ‘Show Land Area’ toggle button on the
Layer Menu to show/hide the same.

User can also click on any area plotted on the map to open
the Summary card to view the metadata (information from
the shape file) of the region.
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User can also select records from the home grid and click on ‘Land Area Mapping’ button from the ribbon

to view all the lands assigned to the records. They can further assign more lands to the required records

as mentioned in the section of ‘Assign lands to multiple record’ above.

Dynamics 365

Mapl:
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The below screenshot shows the lands assigned to the records selected from the Entity home grid.
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Visualizing Assigned lands to the records having no geocoordinates

If the users are using an entity for landscapes which doesn’t have its own address or are not geocoded,
but have assigned lands to the records, they can still plot the lands assigned to the entity records. To do
this select required record(s) from the entity dataset and click on ‘Land Area Mapping’ button from the
Ribbon. This will open a window plotting all the lands that have been assigned to the records. User can
further use the ‘Plot Options’ to plot lands on the map and assign them to the required records as
mentioned in the section of the ‘Plot Options’ above.

Dynamics 365

@ Home

o)

Maplytics

< &1 Show Chart

& Edit

O Activate

Assigned Land Areas ~

() Recent s
v Account Name ain Phone
= Pinned ~
v A All In One Construction +44 1632 960454
My Work
v A B E Doors & Windows.. +44 1632 960501
£ Dashboards
v A Datum Corporation +44 1632 960418
[  Activities
v A. BIANCA CELESTIN & St 3815160013
Customers v A. Datum Corporation (sa 555-0158
I Accounts v A. DINA VEDMED & SON 28351099606
2 Contacts
v A.1SSA KHORASANCHI & 41787675243
Sales
& Leads
[@ opportunities
B Quotes Al # A B © D E G
H Sales < 1-7of 7 (7 selected)
Maplytics - Land Area Mapping
Plot Options ;
Select Option v
= o e
é\.‘o
B
Goodmans g
Crossing ¥
Ash Brook Swamp. /,4’ Rahway (5
/
4
&
§ Colonia &
‘.?: ,Xf Avenel
)‘\{selin 3
N & Portt Rea
3 %
\ z
‘ &
\ % Sewayre
A b
T\ I
N Metuchen (55
N . T \ 95 )
\ )
N 5
\\ *«v‘z Y William
e . FoOr | DunlapHomes
o \\.,{’5 ! ] i VR
Sailes
i

52/

b Bing

) innovative logi
@ih::léié

Perth Ambgy

ﬁo MAPLYTICS™

[ Deactivate

s Land Area Mapping

[ Delete | ~ & Detail Map & Heat Map

- s Land Area Mapping

gn area to record(s)

Thorpe Jonsan Builder filmmaker@gmail.com  Active
London Active
Kingston Active
Staten Island Active
Redmond Active
Staten Island Active
Active
J K L M N o Q R 3 T u N X Y z

‘?4/, Marlboro
% Houses
“W

West Brighton

1 miles 1 km

E Wiew Data

© 2021 Tomjom, © 2021 Microsoft Corporation Jerms

Page 180 of 284




Maplytics™ — User Manual

Real-Time Tracking

With Real-Time Tracking, sales reps, service reps and resources can be tracked within all modules of CRM
in real time. This will help to view the routes that are being followed by reps/resources as well as the
routes that had been followed by them in the past. The appointments/bookable resource bookings that
have been assigned to the resources can also be seen with the help of this feature. This feature also works
in the Dynamics CRM app, Dynamics CRM sales app and Field Service app.

Configuration

To enable this feature, go to Maplytics App > Settings > Map Configuration Details > Default
Configuration details record (the one with no user) > Real-Time Tracking > Enable Real-Time Tracking >

select the checkbox.

Maplytics - saved

Map Configuration Details
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Advance Settings

Enable Real-Time

Tracking

Refresh Interval
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Refresh Interval: Admins can select the ‘Refresh Interval’ to decide the interval (in seconds) at which the
location of the Resources/Sales reps will be tracked. For example, every 30 seconds.

Day and Time: Working days and the start & end timings can be selected from the list. Based on this
selection the reps/resources will be tracked. If admins do not want the reps/resources to be tracked on
any particular day, they can leave the timings blank to avoid tracking on those days. Admins can also go
to the Maplytics Configuration Detail record of individual reps to set different required timings for
tracking.

User Settings for CRM Modules other than Field service

Real-time tracking can be used to track the reps/resources that have been added to the Maplytics team
as users. The admin needs to go to the user’s record > Maplytics Location Tracking > Enable the tracking
for the individual users and can view the other details.

Robert Butler - saved

User - User

summary  Maplytics Real-Time Tracking Details  Administration  Omnichannel  Related

Enable Real-Time

Tracking Yes

Last Tracked At 1272272021 f 4:04 PM
Latitude 19.07160

Longitude 73.02870

Tracking Status Tracking

Enable Location Tracking: Select “Yes” to track the respective user.
Last Tracked At: This will show the date and time when the respective user was last tracked at.
Latitude & Longitude: These will be the coordinates at which the user was last tracked.

Tracking Status: This will show the current status of tracking for the user. Based on three situations the
status will be as follows:

e Tracking - The user has enabled tracking in the Maplytics app and the tracking is on
e Tracking Stopped - Outside business hours — Tracking has stopped as current time is outside
business hours.
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e Tracking Stopped - Tracking Disabled/ GPS Issue/ Location Service Issue — Tracking has stopped
due to one of the three reasons:
o The user has disabled tracking in the Maplytics app
o GPSinformation is not available
o Thereisissue with the location service.

Maplytics Real-Time Tracking App for Sales and Other Modules
The Reps can download & install the Maplytics App and log in to their CRM credentials. The app is available
on Playstore and Appstore for Android or iOS devices.

When the reps log in to the Maplytics App they can view their current location on map in the form of a
pushpin. The pushpin will move on the map whenever the rep makes any movement. The rep can select
the toggle button to start the tracking. Once they have finished their work they can use the toggle button
to stop the tracking and log out from the app.

11:28 W oAcE 11:29 W 4G E
Maplytics ? Maplytics ?
&P MAPLYTICS &P MAPLYTICS”
Enter your Dynamics 365 web address Enter your Dynamics 365 web address
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Note:

e Users should be added to the Maplytics team in order to be tracked.

e For field service, admin also need to enable ‘Location tracking’ within the Geolocation
Settings of Dynamics 365 field service and select the timings, for example, every 1 minute
to track the location of the Resources at every specified interval.

e The users should be logged in to the Field Service app for tracking in Field Service CRM.

o The users should be logged in to Maplytics app and the tracking option should be enabled
for tracking in CRM with other Modules like Sales, Customer Service etc.

Once the Real-Time Tracking has been enabled, users can go to the Detail map > Select Data source >
select the Resource/User as the entity and the required view > click on Search. Once the users/resources
are plotted as pushpins on map, the resource location that is being tracked at every interval will be
updated on the map. Users can click on the pushpins of the users/resources to open the tooltip card for
that user/resource. Users can view the tracking information for only those Resources/Users that have
been added to the Maplytics team and have Location tracking enabled in the User Settings. Users can click
on the Users/Resources to view the tooltip card to find the two buttons for Real-time tracking, i.e.,
‘Today’s plan’ and ‘Location History’.

Note: To view the Users as an entity in the option for ‘Select Datasource’, an entity map for the
entity ‘Users’ should be created.
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I
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X
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Today's Plan

‘Today’s Plan’ button will allow the managers to view route assigned to the respective rep/resource to be

followed today as well as the route that is being traveled by the respective rep/resource in real-time, and

the appointments assigned to them for today. The route assigned to the rep/resource will be shown in

sky blue color and the route that is being traveled by the rep/resource in real-time will be shown in navy

blue color. As the rep/resource moves on the field, the pushpin for the rep/resource can also be seen as

moving on the map.

Sales and Other Modules

Clicking on the User’s pushpin, its tooltip card opens up.
User can also hover on the plotted user’s pushpin to see
further information about the rep. The below screenshot
shows the information about the rep in the tooltip card
for the rep ‘Robert H’. Here user can click on the ‘Today’s
plan’ button to track Robert for today.

Users can view the following information of
Appointment Timestamps on the Summary card opened
up for the respective rep. They can also hover on the
resource pushpin to see these details.

e StartTime

e EndTime

e Total Travel Distance

e Total Travel time

e Total Appointments

e Total Completed Appointments
e Total Canceled Appointments

e Total InProgress Appointments
e Total Scheduled Appointments

@.n:us.'tg: ﬁO MAPLYTICS™
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= DIRECTION =p SETAZ CUR... = SETASPOI...

Damani Dye Chemical Private Limited, D/. ..

Full Name: Robert H

Business Unit: org90138f7d

Take An Action
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Maplytics - Detail Map
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User can go to the Layer Menu and use the toggle button to

show/hide the route being tracked in the real-time and the

route that was assigned to the resource.

Bolt Fencing Solutions

=p DIRECTION =p SETASCUR... =p SETASPOI...

H/15, Padmashri Dr DY Patil Road, Thane,

Account Name: Bolt Fencing Solutions

Take An Action

CO0R0PE

O) S

m Real-Timea Trackin. ..
m Robert H - Today's. ..

m & Enpabled Users @

User can also click on the pushpins of the waypoints on
the map to view the details of the respective

Account/Contact.
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Field Service
Clicking on the Resource’s pushpin, the tooltip card opens up. The below screenshot shows the Tooltip
card of the Resource Sam K.

= DIRECTION = SETASCU... = SETASPO..

Amar Deep Apartment, E-1/11, Balaram Hir...

Resource Type: User
Organizational Unit: Fabrikam US
Business Unit: firecrm032sb
Tracked At: 4/24/2021 2:45 PM

Take An Action

Users can view the following information of Booking Timestamps on the Summary card opened up for the
respective resource. They can also hover on the resource pushpin to see these details.

e Total Travel Distance

e Total Travel time

e Total Bookings

e Total Completed Bookings
e Total Canceled Bookings
e Total InProgress Bookings
e Total Scheduled Bookings
e EndTime

e StartTime
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Layer Menu
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User can go to the Layer Menu and use the toggle button
to show/hide the route being tracked in the real-time and
the route that was assigned to the resource.
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User can also click on ‘View Data’ button to view the details of the resources.
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Location History

‘Location History’ button will allow the managers to view the routes that have been travelled by the
reps/resources in the past. To do this, they can click on the ‘Location History’ button on the tooltip card,
select the required date and click on search. Users can also select the time if they want to view the history
between a specific duration on the selected date.

Sales and Other Modules

Clicking on the rep’s pushpin opens up the tooltip card. The below screenshot shows the tooltip card for
the Sales rep Robert H. Users can click on the highlighted button of Location History and select the date
& time required and click on Search.

=% DIRECTION =p SETASCUR... = SETASPOI... Select Date *
2021-12-30
Damani Dye Chemical Private Limited, D/. ..
I select Time
Start Ti
Full Name: Robert H e
Business Unit: org90138f7d 8:30 AM ©
End Time
Take An Action - ©

wYuYaYoYi ©]

This will show the route assigned to the respective rep to follow on the selected date as well as the route
that was actually travelled by the respective rep. Here we can see that Robert H is travelling the exact
route that was assigned to him. Users can view the information of Appointment Timestamps on the
Summary card opened up for the respective rep. They can also hover on the rep pushpin to see the details.
User can also click on ‘View Data’ button to view the details of the reps.
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Location: Damani Dye Chemical Private Limited, D/
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User can go to the Layer Menu and use the toggle button to show/hide
the route being tracked for the selected date and the route that was

assigned to the rep.

w RobertH -

QO+ ==&

= o 12, Kalamboli, Panvel, MH 4102 | «
=@ S V Tank and Vessel Limited, 3, | x

= (@ | Sion Panvel Expressway Raigac | x

= (@ | H/15, Padmashri Dr DY Patil Re | x

Oz &rwwurmcs-

@D @ Enabled Users
@
@

Location History L...

Robert H - Locatio...

Q

Users can go to the Direction card to select the reps required from the
list there and click on Today’s plan or Location history button to view

the tracked information for the respective resource.
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Field Service

Clicking on the resource pushpin opens up the tooltip card. The below screenshot shows the tooltip card
for the resource Sam K. Users can click on the highlighted button of Location History and select the date

& time required and click on Search.

= DIRECTION =¢SETASCU... = SETASPO..

Amar Deep Apartment, E-1/11, Balaram Hir...

Resource Type: User
Organizational Unit: Fabrikam US
Business Unit: firecrm032sb
Tracked At: 4/24/2021 2:49 PM

Take An Action

wldtlul o 0] @

Location History ®

Select Date *

2021-04-16
P select Time

S‘éart Time

9:30 AM

End Time

6:30 PM

This will show the route assigned to the respective resource to follow on the selected date as well as the
route that was actually travelled by the respective resource. Here we can see that Sam K had travelled the
exact route that was assigned to him. Users can view the information of Booking Timestamps on the
Summary card opened up for the respective resource. They can also hover on the resource pushpin to see

the details.

innavative logic
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o ' ;
Layer Menu < VASIII'Ii S C;l Turbhe Industrial Park :1 > ! Road
= [ 4 ;
2 5
Plot Records X SECTOR 2 1 ]
=e==ECTOR 6 & ]
P NMS -
Directions > S pestadium ot ML .
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e ] l L @-WE
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ahid Bhagat Singh Road Thane MH 40070 i
4 6India :
Tracked At: 4/24/2021 2:38 PM H
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\
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If users are visualizing the tracking information for multiple reps/resources or multiple days, each route
will be plotted into different colors so as to be able to differentiate between individual routes. Further

users can close the Summary card to remove the tracking information for the respective rep/resource
from the map. Thus, users can track reps/resources in the following ways.

innovative

noGi

Single rep/resource for multiple days
Multiple reps/resources for single day
Multiple reps/resources for multiple days
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Real-Time Tracking in Mobile

Users can use Real-Time Tracking within the Field Service App/Dynamics CRM app/Dynamics CRM Sales
App as well, just like the way explained above for desktop. Once they have plotted the reps/resources on
the map, they can click on the pushpins to open the tooltip card and see the buttons for Location History
and Today's Plan to view the travel history of the rep/resource for the required dates and time or the
travel plan of the rep/resource for today respectively.

@ Layer Menu < < ‘ 198 Layer Menu !“':‘;‘/ASADE ‘?H
2 gg  Plot Records X N
. of - . - vv ~ - wanmnawesn Ll NV §"£
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Total Bookings : 2 X Total Travel Time : 12 min NARTEN

ULWAL  Total Completed Appointments : 2
Total Canceled Appointments : 1 ! ASODE
Start Time : 12/30/2021 9:10 AM B
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¥ \DIVATL

Total InProgress Bookings : 1
Total Scheduled Bookings : 1
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Maplytics API

Maplytics API allows users to retrieve geographical data from Maplytics maps to use it outside of CRM. If
a user needs to show CRM data based on a Proximity search or from a specific region etc. on a portal or
website, they can use Maplytics API to do the same. Maplytics API will be used to make API request to
give the response as per user input like proximity, region etc. For example, if a user has a website that
provides training for driving and they want to allow the visitors to find trainers nearby their location. If
the trainers are stored in Dynamics CRM, then Maplytics APl can be used to show the results of Maplytics
Proximity search i.e., the trainers around a specified location on the website while a visitor searches for
it.

Maplytics APl will be provided with a transaction limit. The transaction count will be provided as per the
user’s requirement. The API transaction usage will be counted into three ways. Please contact Inogic at
crm@inogic.com if interested into using Maplytics API.

e Daily
e Monthly
e Yearly

The transaction limit will be provided based on the required usage among the three mentioned above.
Let’s say, based on user’s requirement, if they have been provided with daily transaction limit of 100 then
the user will be allowed to make 100 API requests per day. If the user exceeds the limit for a day, then a
message will be shown that will inform the user that they are not allowed to make any more APl requests
for today. Then the user will be able to make API requests the next day. It will work the similar way for
the Monthly and Yearly usages.

Note: To execute API request you should have active Maplytics license.

List of APIs:

Proximity Search
Region Search
Territory Search
Template Search
Direction instruction
Get Timezone

ok wnNeE

APl accepts following parameters. Based on the value passed in the parameter of the respective operation
it will get the response. Also, Parameters are optional.
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By Proximity
Suppose you want to search using proximity. For this, we have created the custom action with name
“Inogic.Maplytics.API.Proximity” (ikl_InogicMaplyticsAPIProximity).

Custom action accepts following parameters:

e CurrentlLocation: Location for which you want to do the proximity search.

e Proximity: Provide the proximity radius. e.g., 3. If you want to do Concentric Proximity search,
then specify multiple proximity radii separated by comma ;. For example, 5, 10, 15.

e DistanceUnit: Provide the radius unit. It can be either “mile or kilometer". If the unit is not
specified then by default mile will be considered as the radius unit.

e Records: EntityCollection

e Entity: Provide the entity name. e.g. “Account”

e ViewName: Specify the view name. e.g., “My Active Accounts”

When user passes the required parameters and executes this action then it will return records collection.

Note: As custom action has 2 minutes timeout so maximum records that are processed is around
90K- 100K. If you have a view having records more than 100K then it may throw a timeout issue.
So, make sure to enter the viewname of the view that has less then 100K records.

To execute proximity action using the C#, use the following code.

//create request object
string requestName = "ikl InogicMaplyticsAPIProximity";

//create request object

OrganizationRequest orgReq = new OrganizationRequest(requestName);
//for proximity

orgReq["CurrentLocation”] = "New York";

orgReq["Proximity"] = "10,25";

orgReq["DistanceUnit"] = "Mile";

//Entity & view

orgReq["Entity"] = "account";

orgReq["ViewName"] = "My Active Accounts";

OrganizationResponse response = service.Execute(orgReq);

EntityCollection recordsCollection =
(EntityCollection)response.Results["RecordsCollection"];

To execute the action using the javascript (web api) you can use following code.

function executeCustomAction() {
try {

var actionObj = {
CurrentLocation: "New York",
Proximity: "10,25",
DistanceUnit: "Mile",
Entity: "account",
ViewName: "My Active Accounts"”,
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}

// call this function to execute the action
execute(actionObj, "ikl InogicMaplyticsAPIProximity()", function (data) {

alert("Success: " + data);

}, function (error) {
debugger;
alert("Error:

s

} catch (e) {
alert(e.message);
}

"

+ error.message);

}
function execute(req, reqName, successCallback, errorCallback) {

//create AJAX request
$.ajax({

type: "POST",

contentType: "application/json; charset=utf-8",

datatype: "json",

url: encodeURI(getWebAPIPath() + regName),

data: window.JSON.stringify(req),

beforeSend: function (xhr) {
//Specifying this header ensures that the results will be returned as JSON.
xhr.setRequestHeader ("Accept”, "application/json™);
//xhr.setRequestHeader("Content-Type", "application/json; charset=utf-8");
xhr.setRequestHeader ("OData-MaxVersion", "4.0");
xhr.setRequestHeader("OData-Version", "4.0");

}s

success: function (data, textStatus, xhr) {
//successCallback function
if (data != null && data.value != undefined) {

successCallback(data.value);
} else {
successCallback(data);

}

¥

error: function (xhr, textStatus, errorThrown) {
errorCallback(Inogic.Maplytics.ApilLib.errorHandler(xhr));
}
3
}

function getWebAPIPath() {
return Xrm.Page.context.getClientUrl() + "/api/data/v8.0/";
}
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By Region

Suppose you want to search records within a specified region. For this, we have created the custom action
with name “Inogic.Maplytics.APl.Region” (ikl_InogicMaplyticsAPIRegion). Custom action accepts the
following parameters.

o RegionType: Provide the type of region based on which user wants to search. , i.e., City, State,
County, Country, PostalCode, PostCode Sector, PostCode(Outward Code), PostalCode Areas
“City/Postalcode/State”. You need to provide any of the above.

e Region: Provide the region where you need to search. E.g., New York.

e Entity: Specify the entity name. e.g., “Account"

e ViewName: Specify the view name. e.g., “My active accounts”

When user passes the required parameters and executes this action then the action will return records
collection.

To execute region action using the C#, use following code.
string requestName = "ikl_TInogicMaplyticsAPIRegion";

//create request object
OrganizationRequest orgReq = new OrganizationRequest(requestName);

//for region
orgReq["RegionType"] = "city";
orgReq["Region"] = "New york";

//Entity & view
orgReq["Entity"] = "account";
orgReq["ViewName"] = "My Active Accounts”;

OrganizationResponse response = service.Execute(orgReq);

EntityCollection recordsCollection =
(EntityCollection)response.Results["RecordsCollection"];

To execute the action using the javascript (web api) you can use following code.

var actionObj = {
RegionType: "City",
Region: "New York",
Entity: "account",
ViewName: "My Active Accounts",

}

// call this function to execute the action
execute(actionObj, "ikl_InogicMaplyticsAPIRegion()", function (data) {

alert("Success: " + data);

}, function (error) {
debugger;
alert("Error:

+ error.message);

1)
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By Territory

Suppose you want to search records within specified territories. For this, we have created the custom
action with name “Inogic.Maplytics.APL.Territory” (ikl_InogicMaplyticsAPITerritory).

Custom action accepts the following parameters.

e Territories: Specify the names of territories. E.g., “FL, NY”.
e Entity: Specify the entity name. e.g., “Account”
o ViewName: Specify the view name. e.g., “My active accounts”

When user passed the required parameters and executes this action then the action will return the
collection of records.

To execute region action using the C#, use following code.
string requestName = "ikl_TInogicMaplyticsAPITerritory";

//create request object
OrganizationRequest orgReq = new OrganizationRequest(requestName);

//for Territories
orgReq["Territories”] = "NY";

//Entity & view
orgReq["Entity"] = "account";
orgReq["ViewName"] = "My Active Accounts”;

OrganizationResponse response = service.Execute(orgReq);

EntityCollection recordsCollection =
(EntityCollection)response.Results["RecordsCollection"];

To execute the action using the javascript (web api) you can use following code.

//By territory
var actionObj = {
Territories: "NY",
Entity: "account",
ViewName: "My Active Accounts”,

}

// call this function to execute the action
execute(actionObj, "ikl _InogicMaplyticsAPITerritory()", function (data) {

alert("Success: " + data);

}, function (error) {
debugger;
alert("Error:

})s

"

+ error.message);
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By Template

If you want to search records based on Maplytics template then for this we have created the custom
action with name “Inogic.Maplytics.APl.Template” (ikl_InogicMaplyticsAPITemplate).

Custom action accepts the following parameters.
Template: Specify the Template name. E.g., “Accounts with 10 miles”.

When user passes the required parameters and executes this action then the action will return the
collection of records.

To execute Template action using the C#, use following code.
string requestName = "ikl InogicMaplyticsAPITemplate"”;

//create request object
OrganizationRequest orgReq = new OrganizationRequest(requestName);

orgReq[ "Template"] = "Accounts with 10 miles";

//execute the request
OrganizationResponse response = service.Execute(orgReq);

EntityCollection recordsCollection =
(EntityCollection)response.Results["RecordsCollection"];

Get Time zone

To get the time zone of a region, when we pass address or latitude/longitude then it will return the time
zone.

To execute time zone action using the C#, use following code.

string requestName = "ikl_TInogicMaplyticsAPIGetTimeZone";

//create request object
OrganizationRequest orgReq = new OrganizationRequest(requestName);

orgReq[ "TimezoneLocation"] = "new york";

//execute the request
OrganizationResponse response = service.Execute(orgReq);

"

string TimeZone = "TimeZone: + (string)response.Results["TimeZone"];

string TimeZoneAbbreviation = "TimeZoneAbbreviation: +
(string)response.Results["TimeZoneAbbreviation"];

To execute the action using the javascript (web api) you can use following code.
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var actionObj = {
TimezonelLocation: "New york",

}

// call this function to execute the action
execute(actionObj, "ikl InogicMaplyticsAPIGetTimeZone()", function (data) {

alert("Success: " + data);

}, function (error) {
debugger;
alert("Error:

"

+ error.message);

s
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PowerApps Component Framework

User can add custom controls on fields or grids within Dynamics CRM. These custom controls will help the
user to view the respective records on the map on the record form or the entity grid without switching to
any other screen. This will enhance the user experience while working with views and individual records.
User can add the following custom controls:

Map View Control for Record

User can add this control on any of the field with the Data type ‘Single Line of Text’ of the record to view
the respective record plotted on the map. User can further view the Address and geo-coordinates on the
hover of the pushpin.

Steps to Add control: To add the control to a field within a record form, user can follow the steps

mentioned below:
1. Go to Settings > Advanced Settings > Customizations > Customize the System > Components >

Entities > Required Entity
Here, we have taken the Lead entity for an instance. Within Leads, go to Forms > Main Form > Select

a field > Change Properties

[t roME | nserT @
Save s . ~ Header =1 @l [ % EnableSecuriy Roles 5
[ Save and Close - Footer =z = % a4 show Dependencies
Save Body Busin Form  Preview Merge
[y Publish gaton =~ Rules Proper - {&Managed Properties | Forms
Save Select Form Upgrade

Solution: Default Solution Field Explorer >

Filter Custom Fields v

¥l Only show unused fields

(5] GOFR Cptout

i A record on

- New Fieid

Note: The data type of the field on which user needs to add control should be ‘Single Line of Text’.
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2. Go to Controls > Add Control > Select Map View Control for Record > Add

Field Properties 7 x

Modify this field's properties.

Display Formatting Details Events Business Rules I Controls I

—Label
Specify the iabel for this Feld in foms. Add Control
.
Label View recard on Map Select a custom control from the field.

pisplay label on the form

_A

—Field Behavior MapViewControl

Specify field-level behavior Metadata Control

DField s read-only PostLoad Picklist Contrel

Maplytics - Map View Control for Record

—Locking
Specify whether to lock this field on the form, Modes:
O Lock the field on the form Types: SingleLineText
&9 MAPLYTICS ™
Visualize address on the map. Hover over
—Visibili‘ty the pushpin to show the address details.
Specify the default visibility of this control.
Visible by default
—Availability

Specify the default availability of this field on phone.
Available on phone

Note: Please uncheck the option of ‘Display label’ within the field properties for better visualization.
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3. User can choose to allow the control on Web, Phone or Tablet. Click on ‘OK’ > Save & Publish.

Field Properties 7 x

Modify this field's properties.

Display | Formatting = Details | Events | BusinescRules | Controls
Control Web Phone Tablet
Text Box {default)
IMap lytics — Map View Control for Record O O O b4 I
Add Control...

Maplytics - Map View Control for Record

Property Value

Field Property *

amics 365 v Maplytics  Sales > Accounts > A.Datum

= New @& Open Org Chart D Deactivate % Connect < Add to Marketing List 8, Assign 2] Email a Link ]E Delete O Refresh
@ H
{n} lome A. Datum Prashant Sonare o
(® Recent v Account Aii o
52 Pinned M Summary Map Project Price Lists  Details Field Service  Scheduling  Files  Related
ACCOUNT INFORMATION . . + Primary Contact
My Work Timeline ¥ .

Vincent Lauriant

- Account Name
s~ Dashboards

]
- A. Datum c b A
Activities & Email
(55 Chutung L7 @ Auto-post on wall A. Datum s2pem 2 Viiceh i@ adAtIRLEsR
Customers Ssirh—\; Account: Created By Prashant Sonare.
Tathu \3 & Busir
N Accounts
L iR - 012-156-8778
f3 Tang-shih s
R Contacts Ao argke;
Changhua e CONTACTS
Sales Nan:tou
Ta-ch'éng ()
& Leads Lun‘pei;. Chu=shan @
Yuan-ch'ahg Kuang-
[0 Crpartuntis Sifueh No data available.

Tung;shih

EB Quotes

o~
n Sale= Vo Active B Save
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Map Edit Control for Record

User can add this control on any of the field with the Data type ‘Single Line of Text’ of the record to view
the respective record plotted on the map. User can hover on the pushpin to see the coordinates as well
as the address of the pushpin. User can further drag the pushpin around and drop it on the required
location to update the new Address and the geo-coordinates for the record. User can also type in the
address in the space provided and click on the update button to update the Address and the geo-
coordinates for the record. Before updating this, the user will be shown a message where user can also
choose if they want to save address and the geo coordinates or only the geo coordinates.

Steps to Add control: To add the control to a field within a record form, user can follow the steps
mentioned above while selecting ‘Map Edit Control for Record’ in the Step2. After adding the control user
can open any record of the entity to view this control added on the field.

Dynamics 365 v  Maplytics Sales > Contacts > Adrian Dumitrascu

= New [@ Deactivate 3 Connect : AddtoMarketing List R, Assign (%! Email a Link ] Delete (

{n Home

® Recent

> Pinned

My Work
#  Dashboards
B] Activities
Customers
8 Accounts

| A Contacts
Sales

& Leads

] Opportunities

[® quotes

n Sales

) innovative logic
@ihaéilg:

Adrian Dumitrascu
Contact

v Summary Map Details Scheduling Files Related

CONTA FORMAT " .
CONTACT INFORMATION Timeline

First Name

Adrian

Last Name @ Auto-post on wall Adrian Dumitrascu

d By SYSTEM.
2

Dumitrascu

Randburg

1Bing:. o M cre 0 2018k

ﬁo MAPLYTICS™

SYSTEM

Company

Y

S Adventure Works

Bl save
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Map View Control for Dataset

User can add this control to any entity to visualize all of the records of the view or sub-grid on a map. User
can further hover on the pushpins to view the information regarding the records. The information on the
hover of the records is customizable. To add more information on hover, please refer to the section of
Advanced Settings within the Entity maps in the Installation manual. User can also click on the pushpins
to highlight them. Highlighting multiple pushpins can help the users to perform various actions from the
ribbon on all the highlighted records at once. User can also right click on any pushpin to open the
respective record.

Steps to Add control: To add this control on an entity grid, user can follow the steps mentioned below:

1. Go to Settings > Advanced Settings > Customizations > Customize the System > Components >
Entities > Required Entity
Here, we have taken the Contact entity for an instance. Within Contacts, go to Controls > Add Control
> Select Map View Control for Dataset > Add

Add Control

Select a custom control from the field.
Read Only Grid
Time Entry Grid

Maplytics - Map View Control for Dataset

Modes:
Types: Grid

I &P MAPLYTICS™

View the recards in the grid view ona
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2. User can choose to allow the control on Web, Phone or Tablet. Click on Save > Publish.

e | =% Show Dependencies = Solution Layers gy Puslish [f Managed Properties @ Help ~

m Contact
u

' 4 Information

Solution Default Solution General | Primary Field |~ Controls
> |y Configuration a
> & Cornection Control Web Phone Tablet

> 8 Connection Role

> [g:Connector Connector

> BB Contact I Maplytics - Map View Control for Dataset O 0 0 x I
Contact Price List

Resd-only Grid (default]

Add Control.,

ontrol for Dataset

Maplytics - Map View

Property Value
» BA Data Map

> (43 Database Version

> g Delegation

> @ Discount

> [ Discount List

> &3 Document Location
> [3 Duplicate Detection...
> % Ema

Dataset Display_Key

> Bl Email Server Profile
> [ email Signature
> 5] emai Tempiate
> [B) Entitiement

> A Entitiement
> [Ell Entitlement Tem
> B8] Entitiement Templa.

3. User can open any view of the entity to view this control.

s365 v Maplytics Sales > Accounts

— & Show Chart New Delete v O Refresh & Detail Map & Heat Map [F Email a Link v o/ Flow Run Report
@ Home 5 2 e
Accounts: No Campaign Activities in Last 3 Months P
® Recent A
57 Pinned % {
ICELAND
My Work
Hudson Bay
Dashboards CANADA {aboadar

Activities -

Customers

| Accounts

R Contacts

Sales Atlantic

Ocean

Sargasso Sea

LIBYA EGYPT

Gulf of
Mexico J

@ Leads

D Opportunities

¢ MAURITANIA | k ' |
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Detail Map Control for Dataset

User can add this control to any entity dataset or dashboard to visualize all of the records of the view,
sub-grid or dashboard on a map. User can also click on the pushpins to highlight them. Highlighting
multiple pushpins can help the users to perform various actions from the ribbon on all the highlighted
records at once. Detail Map Control provides the user with the freedom of using Maplytics features right
from the page without switching to any other screens. User can also perform the following Maplytics
features within the Detail map control. To know about these features in detail, please refer to the

respective feature section in this manual.

Note: Visibility of Maplytics actions within the Detail map control will be dependent on the actions
selected within the Security Template if any assigned to the logged-in user. Please refer to the

Security Template section.

e Plot entity records — The records of the entity
dataset on which this control has been added
will be plotted on the map by default. They
can hover on the pushpins to view the details
regarding the pushpin and click on the
pushpins to open the respective tooltip card.
Users can use right-click to open the
contextual menu which allows to take certain
actions on the respective pushpin. They can
open the record, set the respective record’s

El Create New Record

¢ Directions > | Set As Origin

1. Add To Route Set As Destination
(®) Set As Current Location
*

(@ Set As POI Location
*

£07 Save Settings >

location as origin, destination or a waypoint to a route. They can further set the record’s location
as current location, POl location or take actions like add tasks or Schedule Appointment based on

the actions configured for the Tooltip card.

With the Contextual Menu, user can use the option of ‘Save Settings’ to save the default locations
for current location, Origin, Destination and the default Map Zoom Level & map centre.

e Plot multiple datasources - Other than the default data plotted on the map i.e. the Entity dataset
on which the Detail map control has been added, user can also select two more Data sources and
their respective active views to plot the same on the map. Thus, a maximum of three datasources

can be visualized on map.
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Dynamics 365 Maplytics
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e Search Options — User can choose the search options By Location @, By Region ., or By

Drawing 9to plot the data as per their requirement.

Plot Records
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By Location: This search option will be selected by default. The following screenshot shows records of the
default view My Active Accounts been plotted by location.

ics 365 Maplytics
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By Region: The below screenshot shows the active account records falling in Alabama, USA.
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By Drawing: The below screenshot shows the accounts falling into the drawn shapes.
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e Plot categorized data- User can also select an attribute for each data sources plotted on the map

with the option of ‘Select category’ to categorize the data sources based on the selected
respective attribute.
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e Multiple-Category for single entity - User can also plot a single entity records categorized by
multiple attributes. For e.g. Account records categorized by Open revenue, Originating lead,
Owner. The user can choose an entity twice or thrice with two or three different views
respectively and choose required attributes for the respective views to categorize the same entity

with different attributes. User can select a maximum of three attributes to categorize a single
entity.
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e  Proximity search — User can set any location as the current location from the tooltip card or

contextual menu with a right-click on any location on map. Once the user sets the current location,
they can perform Concentric Proximity Search and can look for the Line-of-Sight Distance on the
hover or the tooltip card for any record plotted within the proximity.
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e POl locations — User can set any location as the POI location from the tooltip card or contextual
menu with a right-click on any location. Once the user sets the POl location, they can use the POI
card and view any geo-tagged Bing mapped locations by clicking on the icons available on the POI
card or entering the keyword for the required location. For example, the below screenshot shows
the POl locations plotted for Coffee places and Dentist.
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e Route Optimization— User can set any location as the origin, destination or a waypoint from the tooltip
card or contextual menu by right clicking on a record or anywhere on the map and get the route
created for the waypoints selected. User will get further options like selecting the unit for the distance,
Optimize Route based on Shortest Time or Shortest Distance, avoiding highways or toll roads and see
Traffic etc. within the direction card. Once the route is created, user can use the ‘Save’ button on the
Directions card to save the route. They can use this button to it to add changes to an existing route or
save it as a new route with a date and owner assigned. The saved route can later be plotted using the
‘Open Saved Route’ option by entering a date or range of date.

User can also use the ‘Open Navigation Links” button on the Direction card to view the turn-by-turn
directions to navigate themselves for the route on Google Map or Waze App based on the App Set in
User Configured Detail record. User can also send the route as an email to any other user or clear the
route with the options on the Direction card. User can also click on ‘Print Route’ to print a Route as
well as the adjoining Map.
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e Layer Menu- User can show/hide the layers of the plotted

data on the map using the Layer menu to view only the

data that is required.
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e Current location- While using Maplytics Detail Map Control on Mobile/Tablet, users can easily plot
their current GPS location with the help of the ‘Locate me’ button thereby making it easier to
perform Proximity search and relate the data plotted on the map in terms of their location.

My Active Accounts v

Maplytics — Detail Map Control |
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/T\
1
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e Check in/out- Check-In feature enables users to register their arrival and departure time for the

meetings while navigating on field with the help of Check-In and Check-Out buttons. User can click
on any record’s pushpin to open the Tooltip card and click on the Check-in button to register the
arrival to the meeting location and click on the same button that gets converted to the Check-out
button and register the meeting completion and departure from there. User can further add some
notes for the respective records and also create pending check-in/out requests if they are outside
the default radius.
Once field team has check-in/out for respective meetings, their managers can plot the Check-in
entity to plot the respective check-in/out records on the map and analyze pushpins are valid and
which are invalid to track the performance of the field team. They can also plot the pending check-
in/out requests and approve/reject the same.
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Notes

Add Notes Here...

Select Attachment

Choose File | No file chosen

Supported file formats: xml, xisx, .ods, .pdf,
docx, .txt, .svg, .png, .jpg, jpeg

Check-In Date *

Select Time *

Reason *

[ Select Reason

Multi search layer - While users have so many search options and features to plot data on the map,
they also have the capability to perform more than one search at a time to plot data on a map. For
example, if the user needs to view the data with the search of By Region as well as By Drawing together
on the same map, they will be able to do it with this ability of Multi search.

In the Detail map control, the records from the respective view will be plotted by default. In the below
screenshot, the map shows the default view of the Accounts plotted with pushpins in green color. To
add more searches to the map, user can click on ‘Add New Search’ to select the required search
option and Data sources for the same.
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The below screenshot shows that the Search option ‘By Region’ is selected in the New search which
becomes ‘Search 2’ after clicking on Search button. It is now showing all the records from Alabama, USA
in pink color. However, as the default view was already plotted in green color pushpins, the records are
still there as the part of Search 1. Since the views for both of the searches is the same i.e. the default view
the pink pushpins of Search 2 are overlapping on the green pushpins of Search 1.
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The number of multiple Searches is visible in Plot

Records Card. User can also click on the ‘Delete’ i to Plot Records X

delete the respective search layer.
Search 2 ~
9 Search 1
Search 2 (i

Filter
.‘) Search 1 Delete

D <P My Active Accounts

The ‘Layer Menu” will show the layers based on the
Searches performed. In this screenshot, it is showing the

") Search 2 Search 1 that contains the default view plotted and the
Search 2 with the records plotted from Alabama State

D <> Region Layer using ‘By region’ option as mentioned above. User can
use the toggle buttons to hide/show the Search layers or

@D © My Active Accounts () the layers within an individual Search. This will also help

to view the pushpins that are overlapped by other
pushpins in case the views selected in two searches are
the same like in our example above.
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Users can also use the ability of Multi Search layers to perform Proximity Search at different locations in
the same map. The below screenshot shows Search 1 where the Proximity search is performed on My
Active accounts that is the default view here & the All Contacts and Search 2 where the Proximity search
is performed on My Active Accounts on a different location.
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While clicking on the circles of the Proximity searches the Summary card information will be shown based
on the pushpins belonging to the respective Proximity Searches.
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e Map mode and labels- Two map modes are available viz. Road and Aerial view. User can also
select to view the labels of regions on the map.

HBAVRIDGE /i BOROUGH PARK [
, / ! Road

N Road
31/ A standard road map

$ [ErRICE)

Bird's eye

A better angle of aerial photography

Streetside

ore at eye leve

e PrintRoute- Usercan printa Route as
well as the adjoining Map. User can
plot a route on map, and use the
button ‘Print Route’ to print the
route.

Note: There are some limitations to some of the features mentioned above which will be
available in our future releases.
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Steps to Add control: To add this control on an entity grid, user can follow the steps mentioned below:
1. Go to Settings > Advanced Settings > Customizations > Customize the System > Components >
Entities > Required Entity
Here, we have taken the Contact entity for an instance. Within Contacts, go to Controls > Add
Control > Select Detail Map Control for Dataset > Add

Add Control

Select a custom control from the field.

Maplytics - Map View Contral for Dataset

Read Only Grid I
Timeline contral

Maplytics - Detail Map Control

I &P MAPLYTICS™
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2.

User can choose to allow the control on Web, Phone or Tablet. Click on Save > Publish.

PowerApps

o Try New Experience  There's 2 better way o customize the system | Try New Exper x
el | 582 Show Dependencies S solution Layers (g Puolish % Managed Properties @Hebp -
ile
Contact
LE i
-+ 5 Information
Solution Default Solution General | Primary Field | Controls
Control Web Phone Tablet
» & connection N
> §§ Connection Role ny Grd
> [#Connector Connector ® ® ® b'd

4 X Contact

Add Control.,

sages
Ed Business Rules

Select or 2dd a custem control to see its configuration.

> [#] Contract
> [, Contract Line
> [§] contract Tempiate

> 4 Database Version

> [Dataflow Dataflow

> [ Device

> @ Discount

> i3 Discount List

> 5, Document Location

> (3} Duplicate Detection...
> & Ema)

User can open any view of the entity to view this control.
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Heat Map

Clicking on the Heat Map command button will bring up the Heat Map Screen.

Westfield

B8 » Heat Map

Select Datasource

iy -
| Account ¥ ‘ My Active Accounts ¥ |
. sl e s s

. Select Measure

L
- ‘ Annual Revenue

5 | Select Category

ave | Industry
Please Select Region Type
‘ PostalCode

“7r¢ Select Display

i Boundary

Select Datasource:
This option helps the user to choose the Entity and view combination to analyze the data.

Select Measure:

This helps the user to define the aggregation method to be used to color code the region. By default, it is
based on number of records (i.e. ‘By Count’). The user can change this to any other field attribute from
the drop-down. Dropdown contains the list of all numeric and currency fields.

Select Category:
This option helps the user to filter data. The user can modify the search result using selection in the

Category option.

Social Service
Transportation
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This option helps the user to define the geography level for aggregation. The user can choose any option

from the drop-down:

o City

e State

e County
e Country

e PostalCode: The smallest postcode category, such as a zip code.

o PostCode Sector: The second ‘1’ is called “Postcode Sector”. Example: CA1 1

e PostCode(Outward Code): This is called Outward Code, the part of the postcode before the single
space in the middle. Example: CA1

o PostalCode Areas: The next largest postcode category after Postcodel that is created by
aggregating Postcodel areas.

e Territory: This option will use the Sales Territory defined in Dynamics CRM.

Note:

e The regions that were plotted using the option Post code Areas before will now be plotted by
using the option of Post code sector.
o The regions will be plotted as per the Bing maps.

The default option is to summarize the addresses by City. You can find the default settings on the
Maplytics Configuration record for the individual user as shown below:

0 Maplytics

General Advance Settings

Check-In

Auto Scheduling  Related

Optimize Direction No Default Location
Live Traffic No Mavigate Within
Route Option Shortest Time Records Per Page In
Grid
] Map Center
Zoom Level
Heat Map Type Boundary a1
User
Summary Grouping City | Maplytics Security
Template
Default Template
Set As Destination
Set As Origin Other

Other - Set As Origin

) innovative logi
@ih::léié

Other - Set As

Diestination

10 Voie des Vaches, 08450 Angecourt

ﬁo MAPLYTICS™

Loipersdorf bei Fiirstenfeld 271, 8282 Loipersdorf bei
Fiirstenfeld, Austria

Waze

50

Other

Mont-devant-Sassey, Meuse, France
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Select Display

There are four options available to analyze data on Heat Map. Default Heat map display can be selected
using Maplytics Configuration Settings.

Boundary

This will create Heat Map on basis of selected region type like City, Postal Code, Country, State, Territory,
etc.

Ll Heat Map

Industry

Y]

Select All

«

Blank

«

Others

«

Accounting

®

Banking

«

Consulting

Y

Consumer Services

Engineering

@
@

Financial

<

Insurance

£y

Social Service

Summary Card

No Boundary

This option does not consider the region type. It simply creates a Heat Map by the density of the measure
selected without geographical boundaries.

& Heat Map

Select Datasource

‘ Account X H Active Accounts

Select Measure

‘ Annual Revenue

Select Filter

‘ Industry

[Ferect Display

I‘ No Boundary

bl ol N,
Industry X " i - A TED“éTATEsmmm

Summary Card
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Pie chart

Users can view the data in the form of Pie charts based on the heat of the attribute selected in the
Measure and Filter. Pie charts help the users to analyze the data on the basis of comparative data shown
by the Pie charts on the map.

Column chart

Users can view the data in the form of column charts plotted on the basis of the heat of the attribute
selected in the Measure and Filter. User can easily analyze the plotted data on the basis of the proportions
shown by the respective columns.
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Hover: On hover, it shows the details of that Boundary/Pie chart/Column chart
Summary Card: The user can click on any Boundary/Pie chart/Column chart to get the summarized

information of the same.

Anmual Revenwe (Sum §85.282.00000
No. of Employees (Sumy 000

Banking 117
Anmaal Reversse (S $60.402.73000
No. of Employees (Sum )y 000

Beokers |
Annual Reveows (Sumy §348 651 000,00
No. of Employees (Sum) 000

Buniness Services 17
Ancmasl Reverse (5= §184.4482 50000

Total Records 563

Anreal Revenwe (5o
$1.596408.321.00

No. of Emplopeet (Sumk 000

Btak: |
Anreast Reeerwe (o §0.00
No. of Employees (Sumy 000

Accounting 7
Anneal Revene (Sum) $85.282.00000
No. of Employees (Sum: 000

S Banking 117
Annsal Revenwe (Sumy §60.403730.00
No. of Employees (Sum: 000

Beokevs |
Anewal Revesue (Susy §185 65300000
No. of Employess (Sum)y 000

Business Services 1
Anrsl Revence (Som) §184 442 500.00

1630

[
Comame
™
"

Note: If Pie chart/Column chart is selected as the Display type, the option of Territory under Region

@,
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Search:

Clicking on the ‘Search’ button will plot the addresses of all the records that were selected in the view and
has already been geocoded. Records that do not have their latitude/longitude updated in the record will
be ignored and will not be plotted on the map.

Summary card: . %
Every time the users create a heat map visualization, a
‘Summary Card” summarizing the aggregate Total Records: 456

information for the complete heat map will open up.
This gives the users a brief summary of the heat map
they created. The measure is also summarized by
default. No. of Employees (Sum): 23,400.00

Annual Revenue {(Measure): $3256368,260.00

Annual Revenue (Sum): $256368,260.00

e Loserrsecreera o

The user can also click on any region plotted on the

map to open the summary card for that region. This
_ will also filter the data of the region in the data grid.
To differentiate between the summary cards, the
individual summary cards have the region
Annual Revenue (Measure): $10,000.00 name/number as the title.

Total Records: 1

Annual Revenue (Sum): $10,000.00 If the user has selected a field attribute in the ‘Filter’
dropdown, the summary card will further
summarize the information for the selected
category filter as well.

MNo. of Employees (Sum): 2,900.00

Export to Excel: The search results are listed by the grouping selected at the bottom of the screen and
user can further export these data points using this button as shown below;

1 c NTRY LAN Keansb
Jstown ) L Keyport it Sandy Hook Bay.
Port Monmouth ==
Black Horse East Brundwick b Atlantic 885 21.713
Old Bridge Matawan |AY " [E Hide Data | Highlands

7 7 T SRR T T b wn | | IR
My Active Accounts (654) ‘OExport To Excel
Account Name Address 1: Cit Main Phone Territo dustr Created O Annual Revenue
» PostalCode: 10302, NY, Staten Island, USA (Count: 18)
4 PostalCode: 10303, NY, Staten Island, USA (Count: 21)
=]

This functionality adhere to CRM security roles, if the user does not have permission to ‘Export Data to
Excel’ in CRM, then he/she will not be able to export data from Maplytics.

Zoom Level of Heat Map uses personalized ‘Zoom Level’ setting for the logged in user. Also, the color scale
for the Measure will be fetched from the defined ‘Heat Map Measure Color Scale’ in the Entity Category
configuration on the Entity Map for that particular entity.

Print: Clicking on the print button will print the heat map, as shown in the screenshot below:
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Print

Total: 1 page

Destination | SaveasPDF

| change..

e

Pages o Al 1
i

g.1-5,8,11-13 ya

Lower New mq’ Bay

Layout Landscape v

4 More settings

\ [ = el
5000 $50.785,602.00
0GO)
"

Note: A4 size paper with landscape mode is recommended while printing.
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Support for CDS

If user does not have Dynamics CRM, they can still use Maplytics by subscribing for the PowerApps

platform. This platform comes packaged with some base entities that includes Accounts and Contacts
along with other platform entities to provide support for it security and other infrastructure.

To use Maplytics within PowerApps, user can follow the steps mentioned below:

A. Go to admin.powerapps.com > log in using PowerApps credentials.
B. Click on ‘New environment’ > Enter the details > Create an environment

PowerApps Admin center

EH\H:V ment - Q

Environments

NAME ~ TYPE REGION CREATED BY CREATED
Data policies
PHawk Solutions (default) (org92d7d... Default United States SYSTEM 01/16/2019
%o Dataintegration
PHawk Solutions (peterhawk01) Production United States SYSTEM 01/16/2019

Tenant

New environment
Create new environments for app and flow development and tc maintain
separate databases. Learn more

Environment name
Maplytics
ion ()
Region (2)

india (default) M

Environment type (3)

Trial A

Cancel Create environment

e C(Click on ‘Create database’ > Select the required details > Create database

Y You created an environment Create a database for this environment &
Choose the currency and language your data should use.
Currency (7)
Do you want to create a database? usp
(Recommended)

Language (
@ Your environment includes access to the Erglish
Common Data Service. Create a database to
start using it. 21 include sample apps and dat
- Collect, store, and share data
- Use data modeling @ By choosing Crente my database, you agree Microsoft can use entity and field
_ Create custom forms names that you create (but not content in the database tables) to help improve
i our common data model, T mes may be stored in our diagnostic systems
- Manage security and access to data and copied across regions. Learmn more

w e— s

e C(Click on ‘Navigate to other Applications’ > All apps > Powerapps > Select required environment
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PowerApps Admin center

Environments

NAME ~ TYPE
Data polic

Maplltics (orgdc2999a0) Trial (27 days)
Data integra

PHawk Solutions (default) (org92d7d... Default

Tenant
PHawk Solutions (peterhawk01) Production

PowerApps Admin center
] officecom B Dynamics.com
A~ TYPE
s (orgdc2999a0) Trial (27 days)
Solutions (default) (org92d7d... Default
Solutions (peterhawk01) Production

L ﬁo MAPLYTICS™

REGION

United States

United States

United States

REGION

United States

United States

United States

CREATED BY

Peter Hawk

SYSTEM

SYSTEM

CREATED BY

Peter Hawk

SYSTEM

SYSTEM

Q New environment

CREATED

03/11/2019
01/16/2019

01/16/2019

Q New environment

CREATED
03/11/2019
01/16/2019

01/16/2019
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PowerApps r 7 R

pinned

Q New environment

|~ TYPE REGION CREATED BY CREATED
Add-In

s (orgdc2999a0) Trial (27 days) United States Peter Hawk 03/11/2019
CRM Hub

Solutions (default) (org92d7d... Default United States SYSTEM 01/16/2019

Dynamics 365

Solutions (peterhawk01) Production United States SYSTEM 01/16/2019

Flow

PowerApps

Security & Compliance

Talent: Attract

Talent: Onboard

Import Maplytics solution

e Click on solutions at the left navigation pane > Import > Maplytics. This will create the Maplytics

A D Build business apps, fast
M Lesm Create apps that connect to your data and work across web and mobile. Learn about PowerApps
B Apps Make your own app
Create T —
a
— v
E Data - / {"E o I =
+ + o i
B .

o®  Businesslogic E

Canvas app from blank Model-driven app from blank Start from data PowerApps Training for Office

& Canvas app @ Model-driven app # Canvasapp & Canvas app

All templates —
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PowerApps Map;yt\c:

= {3 Open AppSource 5 Publish all customizations T Switch to classic Y Solution checker = Al
{n Home
0 Learn Display name Created | Version
P Asset Checkout
Innevation Challenge
Create ?
Fundraiser 2
B Data

Common Data Services Default Solution
o Business logic

Default Solution

f  Solutions

e Toaccess the Maplytics App, click on Apps at the left navigation pane > Select Maplytics App.

PowerApps

(5 Open AppSource [} Publish all customizations =7 Switch to classic {5 Selution checker = Al

New solution < Import

R Home

Itions

Learn Display name Crested | Version

Maplytics 9040
Create
E Data ~
o Businesslogic -

1 Solutions

PowerApps

= |- Create anapp ¢ Import package (preview) P Microsoft Dynamics 365

@ Home
n
@ Learn
Recentapps  Shared with me  Apps | can edit  Org apps

Apps

i Name Modified Owner Type

Create Bl Maplytics
B Data -
o Businesslogic

(1 Solutions
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Clicking on the Maplytics app, following Maplytics dashboard will open.

Dynamics 365

Maplytics

@ Home
(® Recent

52 Pinned

My Work

l ¥ Dashboards

Activities

Customers

Accounts

R Contacts

Sales

@ Leads

0 Opportunities

Quotes

B Sales

Note:

S B Save As New

Maplytics Detail Map v

v
AV
Q8 2w
Filter
Current Location
9 Amy Ct, Staten Island, NY 10314
Proximity
@® Distance O Time
Mile: v
Y
[J show Travel Distance
M
v
A
24 Overlay

Activate and configure Maplytics

Vv Set As Default

O Refresh Al

<

fort

sntain
West Milford

al,

Al

L5 !“Haverstraw

New City

Spring ™

Ramapo __
) N 2s7)
Falley

Mahwah

(55)
Ossining
(100}

Mount Pleasant

Greenburgh
'White Plains

# Greenwich

Port,Chéster

? Ridgewood 6 Harrisoh
208 Yonkerss,
»)  Paterson NeWw Rochelle
: . g
= Hackensack
Clifton =7
Passaic
o I =
o 7 @ s Plass =t
East'@rangé New York ¥ ¢ Hicksvil
Newarks == L . East Meadew o
- Jersey Gity. i ‘
2T Hempstead ¥

To access the Maplytics user needs to Activate and Configure Maplytics to start the license

and configure the basic Entity maps, Dashboards and Census data.

=  Go to Settings > License registration > Click on Activate
=  Go to Settings > License registration > Click on Configure

Add users to Maplytics team

=  Go to Settings > Teams > Maplytics team > Add users

1. Entities of leads, Cases, Opportunity, Invoices are not available in PowerApps
2. Marketing lists are not available
3. While configuring, four Entity maps will get created for Accounts, Contacts, Appointments and

Customer Address
4. Only three dashboards will get shipped on configuration

innovative logic

imnoGic
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User can use the credentials of the environment to log in to PowerApps and select the Maplytics app to
perform Maplytics features. Use the buttons ‘Details Map’ or the ‘Heat Map’ to open the respective maps.

@® v e
Th \
Layer Menu - i \/ = Rk @ b/ B9’ Road o
[ Unity Place
Plot Records pinll, Y, WALTHAMSTOW. RODING
corestRoad =]
Central
Seven Sisters
- = Pargde SNARESBROOK
Filter ~ {52) Al 2l @
T 23
South Tottenham = ® 3 WANSTEAD
Cluster Map Manor House “ \’) AL Q e = ?ef R
Current Location / il MO & T -y
vomp, = Stamfgrd Hill o o
. 9 Amy Ct, Staten Island, Nv 103 | @ | @ ( #12]
A Il A107]
£ o (2} Leyton
Proximity | \ Marshes = % Wa;;tr:m
S bistance 2 Tine Fiﬁsbury Park JORDSHIP e i’;
il e
Miles v 7 X 24 GROVE GREEN =
\ BROWNSWOOD, STOXE NEAETGN @ = BACKNEY Aldersbrook :
. [ D it}
‘ Show Travel Distance Il FWanstead gy 8
<3 Il LEYTONGY Leytonstone v Cem
Select Asset ? = Leyton 2 B & Crem)|
| A E
g @ SHACKLEWELL Clapton R‘“{”?( RS K./ S
sz Select Asset v || Select Hazarc v == EZJ jafa‘! o west v —
I Wick Field o™ Ham ‘Bark 3
B | 3 Stratford 28
DataSource ~ Ba | & s i i @ ) qomo®
| i i
3y Canonbury | (,/ ,é
Select Datasource e II @ Westfield
12| Il Stratford ~
Accour v || Accounts - v | @ . i || = Kingsland i T aty @ )
‘ \l 2 | — B3 VICTORIA Y. \ West
@ ] | sAINT PETER'S II Landoh 7 Ham
e Y et | / Victoria Stadium A Park A @
> = N AN = 7 / Portway Upton %
- =32 i : = | Park / ey .
/ A \/\ X \ - islifigton [HAGGERSTON jes /4 WEST MAM 2500 feet 1km
\ I Data Foes) © 2021 TomTom, © 2021 Microsof Corporationaferms
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Maplytics Dashboard

The users can define their Dashboard views for Maplytics and include them as web resources in standard
Dynamics CRM Dashboards.

[ other

| Partner
Trade Show

W Web

[ Blank

A
AUSTRALIA AUSTRALIA AMERICA l;sm A

T

s o)
© 2016 HERE Eatistar Geogaptics SO © 2015 Mcsot Capain © 2016 HERE  Eattstar Geogaptics SO © 2015 Mcsat Capaain
PR Supo - Sy > 2l aekbdimien,”

A 1-Qualify
L Y £ 2 2Develop
3Propose
w m 4Close
% 2, M Blank
N L

Mabplytics ships with five pre-defined Dashboards for various Sales and Service Modules for different user
roles. To set up more dashboards, please refer the ‘Installation Manual’.

Steps to add Maplytics View to Dashboard

To include the Maplytics component in Web Resource Properties ?
Dashboard, click on the new button and select to Madify tnis Web resource’s properties.
add Web Resource. Select

‘ikl_/Maplytics/Maplytics.Dashboard.html’ web
resource and set the name of the Dashboard

— Web resource

Web resource * @] ik/Maplytics/Maplytics.Dashboard.htm S ,ﬂ
record in the custom data parameter to be passed
to the HTML Web resource. — Field Name and Properties
Name * WebResource_MyFollowUpCasesByTodayByPriority

Label * s Follow-up Cases By Priority

Display label on the Da

r— Visibility

¥ visible by default

—Web Resource Properties
My Todays Follow-up Cases By Priority
Custom Parameter|data)
Restrict cross-frame scripting, where supported,

Pass record object-type code and unique identifier as parameters,
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Create a route dashboard
To plot route on a CRM dashboard follow the steps mentioned below:
1. User needs to include the Maplytics Detail Map component on the Dashboard. To do this click on
the ‘New’ button in the section of dashboard and select ‘Add Web Resource’. Select

‘ikl_/Maplytics/Maplytics.DetailMap.html’ web resource.

Go to Sales > Dashboards > Click on “New” button

Dynamics 365 Maplytics

= (S B save As = New ™ ~" Set As Default k“_) Refresh All
{at Home . -
Maplytics H 2% Dynamics 365 Dashboard

(5} Recent ' @
F—
5¢ Pinned N ® Heat Map <
My Work Select Datasource

_ Wl e View " Barents Sea

I & Dashboards select Vie
o Select M I
Activities Elect Measurs
v
2. Choose any layout as shown below:

Choose Layout x
AT 4 I " l . =

ll hhh l Ri=5

3-Column

Regular Dashboard
2-Column 2 Lanluonn, 3.Column

R N olumn Regular Dasht ol B - ~ Thic 1avout " aceammadat
Regular Dashb Focused Dashb s layout can accom ate

3. Provide the dashboard name and click on the web resource button to add the Detail map HTML
web resource.
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Esave X close £} PROPERTIES o} CHART

shboard l

.

IN"N‘: * My route Da:

= UST @ WEB RESOURCE

TIMELINE [0 IFRAME

4. Add web resource :‘ikl_/Maplytics/Maplytics.DetailMap.html’ web resource
5. Add a parameter in Custom Parameter (data) field as <Dashboard Name>[ [dashboard| [true

and click on ‘OK’

Add Web Resource

&

innovative logic
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6. After saving the dashboard and user can see the route plotted on the dashboard.

My route Dashboard v

AORTLASE
OO g
2
R ong Fock !-"
H
= 3 (
£ = % '3 | £
- Options Bs "samvnwwuoon
bt 4 SW19 8PE ENGLAND §
B : @ |wxen7oATONHOUSE 601 |« 8 £ : =
| L ‘-‘.'J:C'I-‘ \-'TI-
B - @ | 25 The Mall Road London Londs porers ¥
‘ 570 KINGSTON R
’ - (@ | 260 LINKS ROAD TOOTING LC PARK LONDON
. - = ==y [P =D
|« @ 10 sTREATHAMROAD MITC ) .
B . @ | MNH4659 DALTON HOUSE 60 Cornetery
% = @ | MJX2475 DALTON HOUSE 601 By :
i AT s
S \ (@ ViewDeta  pyk  yr <

T =

CR4 2QE UK [ A2
AR THORNVTON MEAT
=n 4
15 5 1 s Tem o
MACHIOO0E

820 HERE B NTp Menicr Conenpten Tk

Note: Only 25 waypoints can be

added into the route.

mOGIcE
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Add a template in dashboard

Users can add a template to a Dashboard to visualize resultant data of pre-set search criteria on the
dashboard in one glance.

To do this, user can select the required criteria on the map and save it as a template using ‘Save Template’
button. Please refer to the Template section in this manual to know more about saving templates. After
saving the template, user can add the template to the dashboard.

Steps to add template to dashboard

User can create a new Dashboard as explained in above topics and add the web resource
‘ikl_/Maplytics/Maplytics.DetailMap.html’. They also need to provide the custom parameter (data)
having template name. For example, the template with the name “Clients around supplier” should be
entered as — Clients around supplier| | template. Click Ok then Save

Web Resource Properties ? X

Madify this Web resource’s properties.

—Web resource

3|

Web resourcs * 9] ikl_/Maplytics/Maplytics.DetaillMap.htm

r—Field Mame and Properties

MName* |'.-'-."e9:.+50.1'c = Componentbd2des) |

Label ® | Componentb@24==0 |

u} Dizplay label on the Dashboard

—Visibility
B visinie by default
Enable for mobile

—Web Resource Properties

Clients around supglier|termplste

Customn Parameter{data)

u} Restrict cross-frame scripting, where supported.

Pazs record object-type code and unique identifier 3z parameters

Once the web resource is added, user can refresh and open the dashboard to view the saved template.
Moreover, if a user wants they can add multiple templates to a CRM dashboard to view multiple data in
a single dashboard.
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©

@ Home
@ Recent
ﬁ Pinned
My Work
l‘r-‘E Dashboards

Activities

Customers

Accounts

,Q Contacts

Sales
@ Leads
D Opportunities

@ Quotes

n Sales

innavative logic
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<>

P/ Save As

Client overview v

New VvV J Edit

D Delete

V/ Set As Default

|# Share Dashboard &, Assign

() Refresh All

Layer Menu

Proximity
@® Distance
2.3

DataSource

e

o
¥
&

Current Location

Cluster Map

427 Bradley Ave, Staten Island, I

O Time

Miles v

O Show Travel Distance

Select Datasource

\ Accounv | All Accoun v ﬁ ® .

\\ Select Category

CHARLESTON E

o

Bayonne
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Upper New York Bay
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Island N

&
&

&

2
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z

2
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Workflows

Maplytics ship the following workflows:

1. Geocoding workflows —This geocodes addresses of the records and provides the values for respective
Latitude and Longitude.

2. Territory Assignment workflow — This assigns territories to CRM records on the basis of the addresses
in the respective records.

3. Driving Instructions workflow — This automatically generates directions (in HTML and Plain text
format) between two related entity records using their respective addresses.

4. Get Time zone workflow — This provides the time zone of the respective records in which they lie
based on their addresses.

Geocoding workflow is configured for Account, Lead, and Contact entities and Territory workflow for
Account by default. The user can set up these workflows for custom entities also.

+ My Processes ~
2, New S = 8 X | © adivate @ Deactivate More Actions -

'  Process Mame Category Primary Entity Status
Inogic.Maplytics.GecCoding ‘Workflow Account Activated
Inogic.Maplytics.GecCoding Workflow Contact Activated
Inogic.Maplytics.GecCoding ‘Workflow Lead Activated

Note: To run the workflow, please make sure the Microsoft Dynamics CRM Asynchronous
Processing service is running as shown in below screenshot.

Rl b B B BB L

File  Action VWiew Help

e D Dok Bml »mnn

C, Services (Local) £ Services (Local)
Microsoft Dynamics CRM Mame = | Deseription | Status | Startup Type | Logonas |
Asynchronous Processing Service "l Hyper-¥ Data Exchange Service Provides a ... Started Automatic Local Service

S Hyper-y Guest Shutdown Service Provides a ...  Started Automatic Local System
wper-Y Heartbeat Service Monitors th,..  Started Autamatic Metwork. 5.,
iyper-¥ Time Synchronization Service Synchroniz,,.  Started Autamatic Local Service
vper-¥ Yolume Shadow Copy Requestor Coordinate...  Started Automatic Local System

Stop the service
Bause the service
Restart the service

Description: 15 Admin Service Enables thi... Started Autamatic Local System
Handies the processing of queued CHIKE snd AUEhIP TPsec Keying Modules The IKEEX... Started  Automatic Local Systern
Asynchronous Events ndexing Service Indexes co...  Started Automatic Local System
nteractive Services Detection Enables us... Manual Local System
nternet Connection Sharing (1C5] Provides n... Disabled Local System

ntersite Messaging Enables me... Started Automatic Lacal System
F Helper Provides tu,..  Started Autamatic Local System
Psec Policy Agent Internet Pr... Started Manual Metwork 5.
erberos Key Distribution Center ©n domain ... Started Automatic Local Systemn
R for Distributed Transaction Coordinator Coordinate. .. Manual Metwark 5.,
ink-Layer Topology Discovery Mapper Creates a... Manual Local Service
icrosoft (MET Framework NGEN v2.0.50727 _X64 Microsaft ... Disabled Local System
icrosoft \MET Framewark NGEM v2.0.50727_X66 Micrasoft ... Disabled Local Systern
icrosoft \MET Framework NGEM v4.0.30319_264 Microsoft ... Automatic 0., Local System
icrasnft BET Eramenrk BIEFR v 0 50519 YEE Wicrnsaft Lot (0 Local Syshery

& znidle: ... Started Automatic M 5.0 I

TEFOSETT Uy Tiarmics R Ay e T oT oS PrOCe sy Servie Tameer. - Fandes . Stared falslae e TIETFIoTE =
% Microsoft Dynamics CRIM Sandbo:x Processing Service Handlesth... Started Automatic (0., Mebwork S...

Ai g
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Configure Geocoding workflows for custom entities

©

1. Go to Setting > Processes > Click on ‘New’ to design a new Workflow Process.
2. Write Process name, choose ‘Workflow’ under category section and select desired entity as

shown below;

3. Select “Organization’ under ‘Scope’ dropdown.

Create Process

actions, dialogs, and workflows.

Process name: *

Category: * Workflow

Maplytics.GeoCodingWorkflow

Define a new process, or create one from an existing template. You can create four kinds of processes: business process flows,

Entity: *

Account

Run this workflow in the background (recommended)

ype

#)| MNew blank process
MNew process from an existing template (select from list):

Ok Cance

change’ options as shown below:

innavative logic

imnoGic

Select ‘Record is created’ and ‘Record fields

‘ Process: Incgic.Maplytics.GeoCoding
[ = %, Information
Genera Administration Notes
4 Common
Z. Information « Hide Process Properties
4 Audit History

4 Process Sessions

[& Process Sessions Activate As Pro M
Available to Run
Run this workfiow in the background (recommended)

d process
Workflow Job Retention

Automatically delete completed workfiow jobs (to save disk space)

‘Working on solution:

Entity Account

Category Workflow

Options for Automatic Processes
Scope
Start when: Record is created

Record sta

Record is assigned
Record fields change View

Record is deleted

6@ MAPLYTICS™
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geocoded when any of the address fields is changed as shown below;

the address is

Select Fields

Select the fields that the process will monitor for changes.

Display Mame a

LU Y Y
T
n

55 1: Shipping Method
< 11 State/Province

s 1: Street 1

ss 1: Street 2

= 11 Street 3

< 1: Telephone 2

s 1: Telephone 3

1 UPS Zone

s 10 UTC Orfset

Postal Code

Name
addressi_shippingrmethod..
addressi_statecrprovince
address1_linel
address1_line2
addressi_|
address?
address1_
addr
address1_|

address1_postalcode

addressZ_composite

Option Set
Single Line of Text
Single Line of Text
Single Line of Text
Single Line of Text
Single Line of Text
Single Line of Text
Single Line of Text
Whole Number

Single Line of Text

Multiple Lines of Text

Cance

-

5. Select the Inogic.Maplytics.Geocoding workflow assembly from the Add step menu as shown

below;

Note: Please don’t select Latitude & Longitude field attribute here.

Z, Information

4 Common
T, Information
& Audit History
4 Process Sessions

[&] Process Sessions

Status: Activated

General

Process: Inogic.Maplytics.GeoCoding
£

Administration  Notes

‘Working on solution: Default Solution

~ Check condition for Geecode Record

I

Account:Geecode Record doss not contain data

AND

{Account:Address 1: Street 1 contains data OR Account:Address 1: City contains data OR Account:Address 1: State/Province contains data OR Account:Address 1: ZIP/Postal Code contains data OR Account:Address 1: Street
2 contains data OR Account:Address 1: County contains data OR Account:Address 1: Country/Region contains data}, then:

# Setaddress input parameter to calculate the geocode.

Inogic.Maplytics.Geocoding (5.4.0.5):GeoCodeWoarkflow.GeoCodeAddress View properties

# Set calculated Latitude and Longitude in selected record.

Update: Account Vi
Otherwise, if

Account:Geocode Record equals [Ne]

AND

{Account:Address 1: Street 1 contains data OR Account:Address 1: Street 2 contains data OR Account:Address 1: City contains data OR Account:Address 1: State/Province contains data OR AccountiAddress 1: Counfy
contains data OR Account:Address 1: Country/Region contains data OR Account:Address 1: ZIP/Postal Code contains data), then:

# Set address input parameter to calculate the geocode.
InogicMaplytics.Geocoding [5.4.0.5):GeoCodeWorkflow.GeoCodeAddress View pi

# Set calculated Latitude and Longitude when Geocode Record is equal fo No.

Update: Account Vie

W properties

innavative logic
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Note: For custom workflows, add an 'AND' condition, if the address fields are not blank as shown in the
above screenshot. This will avoid the trigger of the workflow if the address fields do not have any value.

6. Click on ‘Set Properties’ and set the address parameter as shown in below screenshot for the

workflow assembly;

h &-L 5ave and Close

— Process: Inogic.Maplytics.Geocoding
Ll Set Custom Step Input Properties

Property Name
Streetl
Street2
Street3
City
StateQrProvince
County
Country

PostalCode

Data Type
Single Line of Text
Single Line of Text
Single Line of Text
Single Line of Text
Single Line of Text
Single Line of Text
Single Line of Text

Single Line of Text

Value
{Bill To Street 1(lnvoice]}
{Bill To Street Z(lnvoice]}
{Bill To Street I({lnvoice]}
{Bill To City(Invoice]}

{Bill To State/Province(lnvoicel}

{Bill To Country/Region(lnvoice]}

{Bill To Street 3{Invoice]}

7. Choose ‘Update Record’ from ‘Add Step’ menu after selecting ‘Set Properties’ record and select

same entity for which workflow is being created.

8. Click on ‘Set Properties’ of the new record and in the update window set the Latitude, Longitude
and Rating to the output parameters returned by the workflow assembly as shown in the

screenshot below;

Latitude {Latitude{Set address il
Longitude {Longitude{Saet addres:
Rating {Rating(Set address ing

innovative logic ﬁo MAPLYTICSW
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Geocoding Confidence Rating:

User can also check the geocoding confidence rating provided by Bing Maps. A ‘Rating’ field can be added
that shows the confidence rating as High, Medium or Low. The ‘Rating’ field is set in the workflow as
shown in the above screenshot.

<« Map
Mo Aute Geocoding No
Street 1 3649 at HYLAN ELVD
Street 2 10308
Street 3
City Staten Island
State/Province NY
ZIP/Postal Code
Country/Region usa
Latitude 40.54925
Longitude -74.13826
Rating Medium
Territory

Note:

e Latitude and Longitude fields should of data type: ‘Floating Point Number’ with precision set to
5. Add minimum to maximum range of fields respectively Latitude (-90 to +90), Longitude (-180
to +180).

e Geocoding Confidence Rating cannot be checked for Geocoding plugin
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Configure Territory Assignment workflow for custom entities

imnoGic

Follow the Steps 1 — 3 from configuring
geocoding workflow for custom entities. This
will help you create a new workflow.

For the Record fields change option, select all
of the address fields to ensure the territory is
changed when any of the address fields is
changed as shown below;

Select Fields x

Select the fields that the process will meonitor for changes,

Display Name & Type

Single Line of Text

Account Name

Account Number Single Line of Text

Account Rating Option Set
# Address Multiple Lines of Text
# Ad 1: Address Type Option Set
#  Ad Single Line of Text
#  Ad Single Line of Text
# Ad Single Line of Text
Ad Single Line of Text
Ad Option Set
#  Ad Floating Point Number

o

OK Cancel

3. Click on ‘Add Steps’ and add ‘AssignTerritoryWorkflow.AssignTerritory’ assembly as shown below;

Process: Inogic.Territory.Assignment.Workflow
Lg*l 2. Information

Genera Administration Notes
4 Common

‘Working on solution: Default Solution

%, Information
4 Audit History

~ Hide Process Properties

3 Process Name* Inogic Territory.Assignment Workflow
4 Process Sessions

2] Process Sessions Activate As Process v
Available to Run

Run this workflow in the background (recommended
| As an on-demand process

As a child process

Workflow Job Retention

S3Add Step + | rSinsert v X Deletz this stz
Assign Record "
Send Emai
Start Child Workflow
Perform Action
Change Status

Stop Workflow

VoC ¥
Inogic.Mapilytics. AssignTerritoryWorkflow (1. »
Status: Draft Inogic.Maplytics.Geacading (5.4.04) ¥

#| Automatically delete completed workflow jobs (to save disk space)

Entity Contact
Category Workflow
Options for Automatic Processes
Scope Qrganization v
Start when: | Record is created
Record status changes
Record is assigned

#| Record fields change

Record is deleted

AssignTerritoryWorkflow.AssignTerritory

innavative logic
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4. Click on ‘Set Properties’ and set the address parameter as shown below and Save this;

ol Set Custom Step Input Properties - Microsoft Dynamics 365 - Google Chrome

& https//maplyticsdemo56.crm.dynamics.com/S

:
Save and Close -

Working on solution: Default Solution

&) Process; Inogic. Territory.Assignment.Workflow

2 set Custom Step Input Properties

Property Name Data Type Requirea Value Form Assistant 3
Latitude Floating Point Num... Optional [Address 1: Latitude(Contact)} Dynamic Values
Dynamic Values
Longitude Floating Point Num... Optional {Address 1: Latitude{Contact))

Operator:
Setto v
Look for:

Contact v

Address 1: Latitude v

X & »

Address 1: Latitude(Contact)

Default value:

Configure Get Time Zone workflow

1. Go to Settings > Processes > Click on ‘New’ to design a new Workflow Process.
2. Write Process name, choose ‘Workflow’ under category section and select desired entity:

Create Process
Define a new process, or create one from an existing template. You can create four kinds of processes: business procass flows,
actions, dialogs, and workflows.

Process name: ¥ Get Timezone
Categony: * Waorkflow r Entity: * Account v
#| Run this workfiow in the background {recommended)
We recommend using Microsoft Flow instead of background workflows, Click here to start building Flows!
Type: &) Mew blank process
Mew process from an existing template (select from list):
Template Name 4 Primary Entity Owne
3
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Select ‘Organization’ under ‘Scope’ dropdown. Select ‘Record is created’ and ‘Record fields change’

options.

o -
T h t +» Hide Pociris Properlies
A skt Hiit
4 Procen Sendens e
ol Froces Sevsona 2t & y
Awaidukibe £ Esn
s & L ] - L el
B o HE

Wekfow bk etratos

o RAc—alialy dewle comoieted workls Bf AC iaws ddk soace

For the ‘Record fields Change’ option, select all of
the address fields to ensure the address is
retrieved when any of the address fields is
changed.

innovative logic
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Wierking on sobutssr |

C e

el dod At (umat Fuiseiaes

e e g "
» it - & Rpcong LR

Select Fields

Select the fields that the process will manitor for changes.

CYRCYCYCY

Display Name a
Address 1: Shipping Method

Address 1: State/Province

B

=

= B

=

ddress 1:

=

ddress 1: 7'

=

Address 2

\ddress 1: Street 2
treet 3
elephone 3
ddress 1: UPS Zone
UTC Offset

P/Postal Code

Name

_statecrprovince

\ddress 1: Street 1 address1_linel

ephone 2

address1_shippingmethod...

ype
Option Set -
Single Line of Text
Single Line of Text
Single Line of Text
Single Line of Text
Single Line of Text
Single Line of Text
Single Line of Text
Whole Number
Single Line of Text
Multiple Lines of Text

o

oK Cancel
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5. Select the Inogic.Maplytics.GetTimezone workflow assembly from the Add step menu.

» Show Process Properties
a -
B3 Add Step Sra@insert ~ X Delete this step
Microsoft.Dynamics. Service. Workflows.Cantr...  »
GetMyChangedSkills ]

Microsoft.Dynamics. Service. Workflows.Other ¢

Estimates ]
Geofencing 3
Approvals ]
Dates r
User Profile 3

Microsoft.Dynamics Service. Workflows.Cantr...  »

Team member position accept »
Micreseft.Crm.ActionCardRankingActivity ]
Gauge 3
Export Workflow ]

Microsoft.Dynamics. Marketing. MarketinglList... ¥

I Inogic.Maplytics. GetTimezone {1.0.0.0) ] I

Inogic.Maplytics.Re at'or‘sl‘iptreateWon| Inegic.Maplytics.GetTimezone (1.0.0.0)

[ P YT P . P =

6. Click on ‘Set Properties’ and set the address parameter as shown in below screenshot for the
workflow assembly.

» Show Process Properties

B add Step ~ j*ﬁlr'ser—.v }( Delete this step.

# |5et the address to get the t'mezu:-r'e{

Inogic.Maphytics.GetTimezone (1.0.0.0):mogic.Maplytics.GetTimezone.GeiTimezone | Set Properties
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Process: Get Timezone Woaorking on solution: Default Solution
I: | Set Custom Step Input Properties
. Form Assistant ¥
Property Mame Data Type Required Value
Dynamic Values v
Street] Single Line of Text Optional {Address 1: Street 1{Account]} Dynamic Values -
Street2 Single Line of Text Optional {Address 1: Street 2(Account)y - | Operator:
Setto T
Street3 Single Line of Text Optional Look for:
Account ¥
City Single Line of Text Optional {Address 1: City(Account)} - (Deprecated) Traversed Path v
) ) ) ) Add
StateOrProvince Single Line of Text Optional {Address 1: State/Province(Acct «
x &% @
County Single Line of Text Qptional |
Country Single Line of Text Cptional {Address 1: Country/Region(Ac =
Zip/PostalCode Single Line of Text Qptional {Address 1: ZIP/Postal CodefAc =
Default value:
[ ]

Here, user needs to specify the address fields on the basis of which user wants to get the time zone. After

this user needs to set the time zone in field (string type). Please foll

1. Choose ‘Update Record’ from ‘Add Step’ menu after
select same entity for which workflow is being created.

ow below steps for the same:

selecting ‘Set Properties’ record and

2. Click on ‘Set Properties’ of the new record and in the update window set the TimezoneName,
TimezoneAbbreviation to the output parameters returned by the workflow assembly.

Website

Parent Account =
Ticker Symbol
Relaticnship Type v

one Abbreviation {TimezoneAbbreviatio

ezone {TimezoneMame(Provi

Product Price List =]

Once user finishes all the above steps and activates the workflow,
user can run it on any record of the respective entity which has
address data. This will provide set the time zone set for the record
as shown below.

@.ru:us.'tg: &9 MAPLYTICS™

TimezoneMame h

Add

X & B

TimezoneName(Provide input paran

»

0 - 0 of 0 (0 selected) M 4 IDEfaIM value:

ACCOUNT
A. DINA VEDMED & SONS

Summary Map Area of service  Territories

Relationship Type

Timezone Abbreviation

EST

Timezone

Eastern Standard Time
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Configure Driving Instructions workflow

7. Go to Setting > Processes > Click on ‘New’ to design a new Workflow Process.
8. Write Process name, choose ‘Workflow’ under category section and select desired entity as shown

below;

Create Process

actions, dialogs, and workflows.

Process name: * GetDirection
Category: * Waorkflow v
#| Run this workflow in the background (recommended)

Type: &) MNew blank process

Template Name 4

Mew process from an existing template (select from list):

Primary Entity

Define a new process, or create one from an existing template. You can create four Kinds of processes: business process flows,

T

Account ot Drica | jst

Actual Data Export (Deprecated)
Address

Agreement

Agreement Booking Date
Agreement Booking Incident

Agreement Booking Product

9. Select ‘Organization’ under ‘Scope’ dropdown. Select ‘Record is created’ and ‘Record fields change’

options as shown below;

Dyt G

|'5' & Information

i Comman Cegrara Admrabebon ezt
L. nforrmator = Hide Protmia Paoperties
o Basder Hrnary
e — 2 N I
2 Proce Tasuom Beteate A1 ¥
Aragdisbebr B3 Ean
¥ Bt Pl Wi fow 1 B BiShirousd [reteeT raerded
i3 g -
3 R oo
e
& BAz—atiay Grelectmaeted wenkow obi B0 deen d o sace
innavative logic ™
@il‘lDEi& 6@ MAPLYTICS

Werking on solutesr |

Cntegay

et B Rl it P DR
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10. For the ‘Record fields Change’ option,

select all of the address fields to ensure the
address is retrieved when any of the
address fields is changed as shown below;

Select Fields

Select the fields that the process will moniter for changes.

Display Name a MName

Address 1: Shipping Method

#  Address 1: State/Province statearprovince
b line1
rd line2
rd line3
elephone 2 address1_telephone2
elephone 3 _telephone3
i

address2_composite

address1_shippingmethod...

Type

Option Set -
Single Line of Text
Single Line of Text
Single Line of Text
Single Line of Text
Single Line of Text
Single Line of Text
Single Line of Text
Whole Number
Single Line of Text
Multiple Lines of Text

-

OK Cancel

11. Select the Inogic.Maplytics.DrivingInstructions workflow assembly from the Add step menu as shown

©

below;

innovative logic

imnaGic

Genera

B3 Add Step

Administration

MNotes

» Show Process Properties

Stage

Check Condition
Conditional Branch
Default Action

Wait Condition
Parallel Wait Branch
Create Record
Update Record
Assign Record
Send Emai

Start Child Workflow
Parform Action
Change Status

Stop Workflow

=) W
“rElnsert v

Inogic.Maplytics. AssignTeritoryWorkflow {1.. »

Inogic.haplytics.BulkGeoGraphies {1.0.0.0) ]

Inogic.Maplytics.Geocoding (5.4.0.4) ]

Inogic.Maplytics. Bt i iglaeyt (1.0.0.0) 3

Inogic.Maplytics,Drivinglnstructions.Drivinglnstru...

6@ MAPLYTICS™
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12. Click on “Set Properties’ and set the address parameter as shown in below screenshot for the workflow

©

assembly;

3 Add Step - :,"G nsert = >( Delete this step

& Get the Directions information

Inogic.Maplytics.Drivinglnstructions {1.0.0.0):Incgic.Mapiytics.DrivingInstructions.Drivinglnstructions I Set Properties

Process: GetDirection ‘Working on solution: Default Solution

] Set Custom Step Input Properties

Form Assistant

Property Name Data Type Required Value
Dynamic Values v
FromAddress Single Line of Text Required {Address 1: Street 1{Account)} {~  Dynamic Vales -
ToAddress Single Line of Text Required {Address 1: Street 1(Primary Co « Operator:

Setto v

TravelMode Single Line of Text Optional Driving Look for:
Primary Contact (Cantact)

DistanceUnit Single Line of Text Optional Mile Address 1 v
Add

In ‘FromAddress’: Select the address fields of the entity that you want the direction ‘From’. Select

the all address field i.e. Steetl, Street2, and City etc. and ensure sure you keep space between
two fields.

{Address 1: Street 1(Account)} {Address 1: Street 2(Account)} {Address 1: City(Account)} {Address
1: State/Province(Account)}

In ToAddress: Select the address fields of the entity that you want the directions ‘To’. Select the
all address field i.e. Steetl, Street2, and City etc. and ensure to keep space between two fields.

Travel Mode: Select the Travel mode. For example (Driving, Walking, Transit). If you do not specify
the Travel mode then it will take Driving mode by default.

Distance Unit: Select the Distance unit. For example (Mile or mi, Kilometer or km). If you do not
specify the unit then it will take Kilometer as default unit.
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13. Click on add step -> Send Email -> Click on set property

PowerApps

| save ane Close 0 | © Adivate cund workflow | =33 Show Dependencies @Hen -
ile :
Process: Dire ction Working on solution: Default Solution
L-g‘ Z, Information
Genera Administration Notes
4 Common
. . -
Z. Informatio [ Add Step » | Jrsinsert » Delete this ste;

Audit History
ﬂ ! Stage

4 Process Sessions
- . Check Condition
3 Process Sessions slytics.Drivinglnstructions.DrivingInstructions  Set Properties

rlies

»

»

»

o.Xmn.Workflow.ldentity (1.0.0.2) »

orage Utilities »

Inogic.Maj AssignTer 3
Inogic.M: »
Inogic.Maplytics.DrivingInstructions (1.0.0.0) »

Click on Email body -> Select Look for -> local value “inogic.Maplytics.Drivinglnstructions.
DrivingInstruction”

H Email: New Email - Microsoft Dynamics 365 - Google Chrome:

& https//map208.crm.dynamics.com/SFA/Workflow/entityfo

[l save and Close
File

Process: Dire ction

Create Email

Form Assistant >
om o] L) |@ | X |G @ | moreAdons -
o Account{Registration Proccess]} File Name 4 (@)
Be =]
Subject K !
B 1 ul = = == 4 A- A~ QR 0 -0 of 0 (0 selected) M4 Page

Owring Use:
Local Values
InogicMaplytics.Drivinginstructions.Drivinginstructions

Process

B0

H

Select Drivinglnstruction for plan text or DrivinglnstructionHTML for html page. Click on save and
close.
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14. The driving instructions will be returned both in HTML and Plain Text format as an output parameter
to this workflow. User can use either of them. For example we have used HTML formatted direction

instruction in Email here.

[From Address: 1 NW 50th Ln Ocala FL 34482 USA
Imﬁ Frosiprool FL 30843 USA.
otal Travel Distance: 208.45 milas
otal Travel Duration: 3 hrs 25 min
instruction Distance
Depart NW 50th Ln toward NW 115th Ave 10.707
Turn right onto NW 115th Ave j.613
[Turn right onto NW Highway 4648 / CR-464B 1.652
[Keep straight ante NW 110th Ave 127
[Turn right onto US-27 5 / SR-500 S 11.539
(Take ramp right for 1-75 South toward Tampa 0,409
At exit 328, take ramp left for Florida's Tumpike South toward Orlando / 10,912
[Tumpike I
At exit 289, take ramp right for US-27 toward Cleremont / Taveres 70.493
[Turn left onto W Main St/ CR-17 2.715
[Turn right onto 10th St N |
[iuad.namc changes to US-27 ALT / SR-17/ 10th 5t 8 9.455
ITum left to stay on US-27 ALT / 5R-17 / E Main 5t 18.945
At roundabout, take Znd exit 16.91
[Bear right onto McLeod Rd 353
Keep straight onio N Palm Ave 1,992
[Turn left onto W 15t 5t j0.202
|Arrive at Frostproof, FL 0

@IHD,‘S'& ﬁ? MAPLYTICS™
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Maplytics Batch Processing Tool

The workflows for Geocoding and Territory Assignment designed can be used on a day-to-day basis for
addresses that are changed or added occasionally. However, for bulk geocoding/territory assignment on
data, we recommend using the Batch Processing tool. This tool ensures that the bulk geocoding on records
is handled in single batch. While in the territory assignment, this tool helps to assign the respective
territories to all the selected records based on their Latitude and Longitude values.

Note: To run this tool, the user needs to make sure that machine has Microsoft .net framework 4.0
and Maplytics installed in Dynamics CRM.

To run the tool, Extract the Batch - )
) L Narme Type Compressed size
Processing tool .zip file and run the
. . . = BatchP ingTool Applicati 104 KB

BatchProcessingTool application. Frenriacessng oo sppmesten
|| BatchProcessingTool.exe XML Configuration File 1 KB
%] Microsoft.Crm.Sdk.Proxy.dll Application extension 38 KB
%) Microsoft.ldentityModel.dll Application extension 360 KB
%) Microsoft.Xrm.5dk.dll Application extension 146 KB

Executing Batch Processing Tool

Connection Details:

Please enter the CRM details on this screen. The users have to enter the following details:
Deployment model: The user can select either of the options given in below screenshot
depending on their deployment.
CRM Server: Please enter the serverurl of CRM. For example, http://<servername>:<port> or
https://<orgname>.crm.dynamics.com
Organization: If the deployment model is ‘OnPremise’ then the user has to specify the
organization name. For other deployment models leave this blank.
When the user enters the server URL in case of On-Premise deployment model, the organization
list will be auto-populated with the organizations available in CRM. Select the organization for
which Maplytics is to be or already has been installed.
Username: Username of a valid CRM user. For example: mollyc@CRM166504.onmicrosoft.com
In case of On-Premise deployment model, the organization list will be auto-populated with the
organizations available in CRM. Select the organization for which Maplytics is to be or already has
been installed.
Password: Password of CRM user.
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t: Maphytscs - Batch Processing Tool {2.000.8)

"'; ©  Maplytics Batch Processing

User can also use their Client Id and Client secret key to log in for their respective CRM using Application
user.

{2} Maphytics - Bateh Processing Toel (2.0.04)

'f‘.- “  Maplytics Batch Processing
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Choose Option: Here, the user can make selection whether they would like to run this tool for Geocoding
(Batch Geocode) or Territory Assignment. In this example, we have chosen Batch Geocode as shown

below:

@

’: @
»©

Maplytics - Batch Processing Tool (2.0.0.8)

Maplytics Batch Processing

o Em

Entity Selection and Filtering:
Please find the details of the same below:

Entity: Select the entities on which the user would like to run this tool.

Views: Once the user selects the entity, all the views defined for this entity are populated in the

list of views. Select the required view.

@

’: @
»©

Maplytics - Batch Processing Tool (2.0.0.8)

Maplytics Batch Processing

My Open Leads Y]

Add

Ertity Name View Mame

o

Account Active Accounts

Lead My Open Leads

Oz &rwwurmcs-
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Results and Log Settings:
Since this is executed as a batch process in the background, enter the email address, if the users would
like the job results to be mailed to them.

@ Maplytics - Batch Processing Tool (2.0.0.8) = =

’: Q
v

Maplytics Batch Processing

Cancel

Progress :
In this section, the user can see the progress of the geocoding process.

@ Maplytics - Batch Processing Tool (2.0.0.8)

f; @ Maplytics Batch Processing

Fetching geocode data from Bing map

Note: The Batch Processing Tool takes time to process based on the number of records selected.
Please do not close the window until this process is completed.
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Record Summary:

Geocoding:

Bing Status: This shows the number of the records for which the geocoding from Bing maps were

successful or failed.

CRM Status: This shows the number of the records for which the updation of geocordinates (Latitude &

Longitude) to the respective CRM records were successful or failed.

After completing the geocoding process, the user can download the results. The results will be
downloaded in CSV format. User can check the columns of CRMDescription and BingDescription in the

result to check the reason for failure of processes on the records.

@ Maplytics - Batch Processing Tool (2.0.0.8)

Maplytics Batch Processing

Records Summary
Total processed record
Bing Status

Succeeded: Failed: 0

Entity View Name

Accourt Active Accounts

ity o e

CRM Status
Succeeded: Failed: 0

Entity View Name

Account Active Accounts ’

iy o e

Go to Home

Download the results

Oz &rwwurmcs-
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Territory assignment:

CRM Status: This shows the number of the records for which the updation of Territories for the respective
CRM records were successful or failed.

& Maplytics - Batch Processing Tool (2.0.0.8) = =

Maplytics Batch Processing

Records Summary
Total: 2088

CRM Status

Total Align Records :

Entity View Name Succeeded
Lead My Open Leads 1088

oo | 0

Go to Home Download the results Finish

Note:

1. If a user selects ‘All records’ for an entity, then a view for that entity cannot be selected.

2. A user cannot select an entity with a same view twice.

3. If the user adds an entity with a view and then selects ‘All Records’ for the same entity, it will
remove all the views selected for that entity with the user’s permission.

4. All of the above instructions apply for running Batch processing tool for Territory
Assignment.
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Territory Assignment Rule

Users can use this feature to create rules for assigning territories or owner to the CRM records
as per the requirement. With creating a rule user can set some conditions based on which the

territories or the owners will be assigned to only those records which satisfy the conditions
provided.

Enable Territory Assignment Rule

To enable the Territory Assignment Rule, go to Maplytics App > Settings> Map Configuration
Details > Default Configuration Detail record (the one with no user)> Advance Settings > Enable
Territory Assignment Rule and select the checkbox to enable using the feature. The feature will
be disabled by default.

Maplytics

Map Configuration Details

General Advance Settings Check-In  Auto Scheduling  Real-Time Tracking  Related

Configure option

Enable Travel Enable Truck Route O Map in New Window O
Distance
. Enable Territory Enable Multiple
Show All Territories v ! H
@ Assignment Rule Territories U

Once this feature is enabled, they will be able to see a new tab of Territory Assignment Rule in
the Entity Maps. For an instance, the screenshot below shows the Entity map of Accounts.

account
Entity Map

General  Entity View Configuration  Attribute Mappings  Tooltip Mapping  Territory Assignment Rules

=z
D

ew Maplytics Assign...
v | MName T Created On * Priarity

Accounts by Revenue 472972021 7:22 PM 1
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Creating Territory Assignment Rule

To create a new rule, click on New. The user will be able to see the window for a New Rule.

General

In the ‘General’ tab, user can enter the name for the rule and select the entity for which the rule is being
created.

Accounts by Revenue
Maplytics Assignment Rule

General Assignment Rule  Related

MName “  Accounts by Revenue

Entity Map * Bl account

Assignment query

Here, the user can find the various options as explained below to set the conditions required within the
rule:

Accounts by Revenue
Maplytics Assignment Rule

General  Assignment Rule Related
Assign Cwner 9 RobertK
Assign Territory 0 AU - NSW

Location agnostic (]

Query Mode *  Simple
View Active Accounts
Order 1

T &P MaPLYTICS" Page 264 of 284




Maplytics™ — User Manual

Assign Owner: Select the user who should be assigned as the owner to the records.

Assign Territory: Select territory which should be assigned to the records. If users want to assign only the
owner to the records, they can leave this blank.

Location Agnostic: This option will be visible only when a territory is selected in the Assign Territory

field. It will be deselected by default and will have an effect on the assignment of the territories and

owners as explained below.

Not selected - If the option of Location agnostic is not selected, the selected territory and the
owner will be assigned to only those records which satisfy the query and also lie within that
selected territory based on the respective latitude or longitude values of the records. For example,
a territory for Staten Island has been selected and the condition in the query says, Accounts with
Annual revenue greater than 100K USD, then Staten Island territory and the selected owner will
be assigned to only those records which have annual revenue greater than 100K as well as they
lie within Staten Island based on the latitude and longitude values of the records.

Selected: If the option of Location agnostic is selected, then the selected territory and the owner
will be assigned to all the records from the selected view that satisfy the query irrespective of the
latitude and longitude values of the records. For example, a territory for Staten Island has been
selected and the condition in the query says, Accounts with Annual revenue greater than 100K
USD, then Staten Island territory and the selected owner will be assigned to all the Accounts from
the selected view which have annual revenue greater than 100K, even if they lie outside the Staten
island based on the latitude and longitude values of the records.

Query Mode: There are two Query Modes:

©

Simple: If query mode is selected as Simple then it will show all the system views. User can select
a System view to consider the respective records.

Accounts by Revenue
Maplytics Assignment Rule

General  Assignment Rule Related

Assign Owner 9 RobertK
Assign Territory 0 AU - NSW
Location agnostic

Query Mode *  Simple

View Active Accounts
Order 1
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e Advanced: If query mode is selected as Advanced, the user can put the required Fetch xml in the
field as shown in the below screenshot.

Accounts by Revenue
Maplytics Assignment Rule

General  Assignment Rule Related

Assign Owner © R RobertK

Assign Territory [0 AU - NSW

Location agnostic

Query Mode *  Advanced

Eetch XML <attribute name="accountid” /> N
<order attribute="name" -

Order 1

To create a Fetch XML query, go to Advanced find > Select the entity and the required
filters > Download Fetch XML

2% Microsoft | Dynamics 365

ADVANCED FIND i
@ K save as Q [{= Group AND @
m D @ Edit Columns = Group OR

Query Salrecl Resurts MNew Clear Download Fetch
(5} Edit Properties = Details HML
Show View Query [}ihuq
Look for: | Accounts w Use Saved View: [new]
w Annual Revenue Is Greater Than 100,000.00
Select
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Priority: If multiple Territory Assignment Rules are created and while assigning territories a record satisfies
more than one rules then this field will decide the priority of the rules to be run and assigned among the
list of rules. Where 1 is the highest priority and the priority keeps decreasing as we go to a higher number.
Let’s say three Territory Assignment rules are created with the priorities given as 1, 2 and 3. While
assigning territories, if a record satisfies all the three rules, then first, it will check the priority of those
three rules and 1 being the highest priority, the respective territory and the owner will be assigned to the
record as per the Territory assignment rule with Priority 1.

account
Entity Map

General  Entity View Configuration

| Mame T
Accounts by Revenue
Alabama - USA

ndustry

) innavative logic
@il‘IDEiC

Attribute Mappings  Tooltip Mapping  Territory Assignment Rules

Created On
4/29/2021 7:22 PM
4/29/2021 7:39 PM

4/29/2021 7:37 PM

ﬁo MAPLYTICS™

MNew Maplytics Assign...

(3]

ra
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Override Existing Territory

The Maplytics admin or the System admin can use this feature for the respective entities to decide
whether the existing territory(ies) will be overwritten or not while assigning territories to the records.

To use this, first create a field with data type ‘Boolean’ on required entity form for Override territory. Here
users can set it to be ‘Yes’ or ‘No’. By default, this field has already been created for Accounts, which can
be added to the form. This option will be set as null by default.

Once the field is added to the required entity, Maplytics admin or System admin can go to Maplytics App
> Settings > Entity map > Open entity map for required entity > Attribute Mappings > Override Territory
> Select the field that was added on the entity form.

account
Entity Map

General  Attribute Mappings  Tooltip Mapping  Category Configuration  Configuration  Advanced Settings  Related

City Address 1: City Latitude Address 1: Latitude
County - Longitude Address 1: Longitude
Phone --- Website -

Em ail --- Land Area Mapping -

Territory Relationship  Account - Territory Override Territory Override Territory

Based on the value of the ‘Override territory’ field in the record, it will be decided whether the existing
territory(ies) will be overwritten or not while assigning territories to the respective records.

e If the Override territory field is set as ‘Yes’ then while assigning territories, if there are any
territory(ies) already assigned to the respective records, then those will be overwritten and
replaced by the new territory(ies) that are being assigned.

e If the Override territory field is set as ‘No’, then while assigning territories, if there are any
territory(ies) already assigned to the respective records, then those will remain asitis and no new
territories will be assigned.

e If Override territory field is set as ‘No’, then while assigning territories, if there is no territory is
assigned to the respective records, then it will assign the new territory(ies).
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Maplytics — Tablet / Mobile

For Dynamics 365 v9.x, Maplytics can be accessed from the Entity homepage and entity form using the
‘Detail Map’ , ‘Heat Map’ and ‘Map’ button respectively.

Active Accounts v

Search this view

4 Sort by Account Name
0969 Ocean View Road
o (415) 555-9933
Jersey
(# LogOut
&  Detail Map
& HeatMap
2 Emailalink
¥ Flow
o Al Builder
@  Excel Templates
@7 Export to Excel

<3 Quick Campaign

My Active Accounts v

Search this view ol

v Account Name T Main Phone | Address 1: City ™ | Primary Contact \
[ Loghn

&  Detail Map

& Heat Map

L1 EmailaLink

¥ Flow

o Al Builder

B2 Excel Templates

Email (Primary Contact)

Mobile

Tablet

@ U PORTER & SONS

Summary Map Template on Record

< o +

Owner * R sams

ACCOUNT INFORMATION

@, Check Access

& Map

© CheckIn

Ha Process
Click2Clone
Get Records

¢ Follow

N

Flow

¢85 Word Templates

<

ACCOUNT
A All In One Construction

Summary  Map  Template on Record Kanban Board for Case

Attach2Dynamics

B  Click2Export

() Refresh

Q) Check Access
& Map

@© Checkin
Hi Process

Map My Relationships Area off

innovative logic

imnoGic
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Maplytics can also be accessed from the Dynamics 365 App for Phones and Tablets (both on Dynamics
365 v8.2 and v9.x) using a dashboard for detail map. To open Detail map; Go to Dashboard > Maplytics
Detail Map as shown below:

My routes

My routes

User Adoption Summary 2
User Adoption Summary 2
Maplytics Customer Service Representative D...

Maplytics Detail Map Maplytics Customer Service Representative Dashboard

Maplytics Heat Map Maplytics Detail Map

Maplytics Overview - Sales Manager
Maplytics Heat Map
Maplytics Overview - Sales Reps

Maplytics Overview Dashboard Maplytics Overview - Sales Manager

Manlvtine Salec Activity Nashhnard

[ ] @ <4

Detail Map

The Detail map consists of the following components. There are five ways to plot the data on Map, similar
to the Detail Map on browser:

e By Location

e By Region

e By Drawing

e By Territory

e By Template
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Proximity

Enter the radius for the proximity search. The Proximity can be provided in either Miles or Kilometers.
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Now users can also get the aggregated information for a particular closed shape on the map with Summary

Card.

Layer Menu

’ Plot Records

A Area: 10.18 Square Kilometer

Total Records: 11

mn

Avg. Annual Revenue (Average):
$5,382,068.64

Sales (Sum): $251,692,388.00
| Sum Annual Revenue (Sum)
$59,202,755.00

CASTLET
COR)

Lnd

BULLS HEAD'
T
a

vig NEW.S
il
e 68 :

E-“Kl!nvnu o

RICHMOND —
e

NSUM

ing

Account - (Accounts - Staten island):

&
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Concord

SOUTH B;
So

tmses  3km
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198 Layer Menu

a\ Plot Records

o2
- | 99502 Alaska USA
Total Records: 16 TU(@)SA!

Account - (Accounts - Alaska - USA):
16

Annual Revenue (Average):
$353,125.00

No. of Employees (Surr}): 12,010.00

SAND LAKE

Accounts - Alaska - USA (16)

#|. Account Name Y  Address 1: City Y  Status
L_:E |#2. Carpet house ANCHORAGE Active
L-:a |## Crown hardwares Anchorage Active
L-=E |« Jammy Pizzas Anchorage Active
T « 1 v > 50 v items per page

BETR Y

Y  Annual Revenue Y | Industry Y
250000 Consulting
250000 Consulting
370000 Durable Manufacturing

TReset | &

CAMPBELL PARK

(16 Selected) 1 - 16 of 16 items

Search POI

Ability to search for any Points of Interest (POI) like ATMs, restaurants, hotels, coffee shops, etc. in the
vicinity. This will be plotted alongside the CRM data.
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Category Filter

User can categorize the data on the basis of an attribute of the Entity
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Current Location
This is used in combination with Proximity to specify the center point for the proximity search. By default,
this field displays the address stored in the Maplytics Personalized record of the logged in user.
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Set GPS Location as the current location

The user can also locate the GPS location of phone/tablet devices using @ button.

TR
2 Thane > E] £ | Plot Records < Bhiwandi <
& @ Q r! Murbad
Bhiwandi C o . i Kalyan
@@ Filter i -3 y

(e Bhiwandi 21 - ® ane Ulhasnagar @

orivali Y Cluster Map
ghane Ulhasnagar Current Location
e
Vednath Ayurvedic Store, Lokne
Ulhas
River
Kurla Proximity ) -@-
© @ Distance Time Ulhas
Panvel Miles River. Panvel
nbai
Matheran Karjat Show Travel Distance
Uras Matheran—Karjat
Khalapur DataSource Unatt
i Select Datasource Khalapur
gen Accoun v Select Viev ¥ Amba
River Khopoli Mawal

Alibag =3 _ Smiles 10km

b 8ing s b éind View Data ©2021 TomTom, © 2021 Microsoft Corporation Terms

GPS location is represented by ‘Blue’ circle on the map. It will automatically update the user’s current
location, making it easier to perform proximity (Near-Me) searches.

Note: Please ensure the following points for the GPS functionality to work:
e Provide ‘Location’ permission to Dynamics 365 App in phone / tablet device
e GPS location is turned ON of respective devices
e ‘User Content and Location’ is tuned ON in Dynamics 365 App

innavative logic
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Tooltip Card

Every Pushpin will display the record name, address, as well as the contextual data defined in the tooltip
section of the Maplytics Configuration. The user can open the record, change owner and run workflow
using the available quick actions button.
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IO Loyer Menu < j < 198 Layer Menu < B @ Rees: ¢
A€ Lingo {f Te {
~ PlotRecords X St
= ﬁé‘ & Plot Records Eartgqtake a
. arl
: P g gTraversne
[* ] SORECTION  -pSETAS CURR. SETASPOIL. @@ Pastel shirts TURNAGAIN 1 i

2131 at RICHMOND ROAD Staten Islan. =p DIRECTION ~ =p SETAS CURRE.. =p SETASPOIL..
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Contextual Menu

To get a contextual menu on the map, long press anywhere on the map. Pushpin Contextual menu
provides the following additional options. These option provides commonly used features in Maplytics
like Set as Current Location, Origin, and Adding to Route, etc.
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Set As Origin:

Selecting this option will set the address of the pushpin as the start location of the route.

Set As Destination:

Selecting this option will set the address of the pushpin as the end location of the route.

Add to Route:

This option will set the address of the pushpin as a middle waypoint of the selected route. For example, if
the users already have Point A and Point B selected as their route, and click on the Add To Route option,
then the Point B will become Point C, and the address of the selected pushpin will become the Point B of
their route.

Set As Current Location:

This option is used to set the address of the pushpin as the current location, which can be used for
proximity search. For example, if the user wants to plot all the leads that are within a radius of 100 miles
from a particular record then the user can click on the Set As Current Location option to set the address
as the current location and then the user can plot the records around this location.

This option also removes the additional step to type the current location manually for the proximity
search.

Set As POI Location:

This option helps the user to set the center point for the Point of Interest (POI) searches like ATMs,
restaurants, Airports, etc. Once this location is set as the POI location, the user can search for different
POI around this location.

Manage Territory:

The user can manage the territory, i.e., assign/re-assign territory from the map using this option.

Save Template:

User can save the plotted search criteria as a template, so as to open the template directly instead of
searching on the map again.

Save The Template

Save The Template

7 Add to existing template
Add o existing template
® Create new template
@ Create new template
Proximity from MN Proximity - 2 miles
Access Level AccessLievel
Personal

Personal
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Routing — Tablet / Mobile

Another essential feature of Maplytics is Routing across multiple waypoints. Using the Contextual Menu
options explained above, the users can add multiple waypoints to their journey. At given point in time,
the users can add maximum 25 waypoints in direction.
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Once multiple waypoints have been added, click on Go button to bring up the Routing Screen shown
below.
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Unified View for Route and Records

When the user plots the data and then creates a route, both the plotted data and the route will stay on
the map. This makes it easy for the user to add more waypoints to the route without switching between
Plot and Directions card. The route can be cleared using the ‘Clear Route’ button.
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Save Route and Plot Saved Routes

Users can now save the route from the Dynamics 365 App for Phones and Tablets and later use the ‘Open
Saved Route’ feature to plot the saved routes.

Save The Route

Save The Route - Add to existing route

Add to existing route (®) Create new route *
@ Create new route *

. Today's product demos
Today's product demos

Select route date * Select route date *

2021-05-05 2021-04-26

Owner

Joe Smith Owner

Joe Smith
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Email route - The user can email route to any of the

Dynamics CRM records using email route option.

Along the Route Search

9

Directions

The user can also search the along the route records the same way as on the Browser.
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Route Redirect and Copy Navigation Links

Redirect with Google Maps

Navigation Links

For turn-by-turn navigation, please use the
following links

Navigation Links

Driving Directions Show Complete Route

Show Complete Route From: Genaral Manager: 95 W. 3rd St.
CRENSHAW Luverne AL 36049
To: Owner: 205 State Highway 21 S LOWNDES

Hayneville AL 36040

From: 10 Ellsworth Ave, New York, NY
10312

To: K. FRANK MARTARELLA il & SONS: 255
at VINELAND AVENUE Staten Island NY
From: Owner: 205 State Highway 21 S LOWNDES
Hayneville AL 36040

To: Director: 1629 W Highland Ave DALLAS
Selma AL 36701

From: K. FRANK MARTARELLA lll & SONS:
255 at VINELAND AVENUE Staten Island NY
To: X. FELIX PUSTYLNIK & SONS: 1942 at
VICTORY BOULEVARD Staten Island NY

8 Copy Links
From: Director: 1629 W Highland Ave DALLAS

Selma AL 36701
To: Genaral Manager: RR 3 Box 54b PERRY
Marion AL 36756

From: Genaral Manager: RR 3 Box 54b PERRY

Redirect with Waze

Navigation Links

For turn-by-turn navigation, please use the
Navigation Links following links

From: Current Location

To: Crown hardwares: 6839 Jewel Lake Rd
ANCHORAGE Anchorage AK 99502

Driving Directions

From: Current Location

To: Bob & Sons: Shop No.3, Sun Flower
Road, Sector 17, Vashi Navi Mumbai §
Maharashtra From: Current Location
To: Jammy Pizzas: 4370 W Intl Airport Rd
LA St ANCHORAGE Anchorage AK 99502
To: National Institute: Liberty Housing

Society, Sector 17, Vashi Navi Mumbal
From: Current Location

To: Pastel shirts: PO Box 220334 ANCHORAGE

Anchorage AK 99522

Maharashtra
From: Current Location
To: Navjeet & Sons: Plot 10, Sector 17,

& Copy Links
) From: Current Location

To: Jimmy Burgers: 3450 Aviation Ave
ANCHORAGE Anchorage AK 99502

From: Current Location
To: Alkem machinery: 9001 Jewel Lake Rd Ste 11

& Cobv Links.
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Heat Map - Tablet / Mobile

For Dynamics 365 v9.x, Maplytics can also from the Entity homepage and entity form using ‘Heat Map’.

When clicked on Heat Map button, it opens the heat map.

10305 n: _ (Measure): $4,700.148
Total Records: 33 { S o « Annual Revenue (Average):
€ sales (Measure): o A, 3 531981376
4,700,148.00 Opportunity Pipeli
g innual Revenue i o ) $336,976.9167
= (Average): $319,813.76 ! o .
Opportunity Pipeline ) s Number of Employees
(Average): ° (Average). 52
$336,976.9167 v |
Number of Employees B ~ Banking: 15
= (Average): 52 7 ; I (Measure): $115,250
Banking: 15 7, Annual Revenue (Average):
Sales (Measure): s 1l $331,666.57
| $115,250.00 ~  Opportunity Pipeline
& Annual Revenue | (Average) $342,380.8571
| (Average): $331,666.57 L i
Opportunity Pipeline
(Average):
$342,380.8571
Number of Employees B el |
[~ (Average): 58 et ~ (Measure): $1,502,000
P | Annual Revenue (Average):

,' Engineering: 6
Sales (Measure):

M 528941217
Opportunity Pipeline
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Pie chart in Heat Map

Column chart in Heat Map
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Dashboards - Tablet /| Mobile

The users can define their Dashboard views for Maplytics and include them as web resources in standard
Dynamics CRM Dashboards. Maplytics ships with 6 pre-defined Dashboards for various Sales and Service

Modules for different user roles.

o +

Maplytics Sales Performance Dashb... v
Heat Map for Accounts

UNITED, §1' :

NS

Bristol Bay

Gulf of Alaska

Maplytics Overview - Sales Manager v
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Contact Us

M/S. INOGIC TECH (INDIA) PVT. LTD.
A-301 Everest Nivara InfoTech Park,
MIDC, Turbhe, Navi Mumbai - 400 705 - INDIA.

E-mail: crm@inogic.com

Twitter: @Maplytics; @Inogic

Facebook: @Maplytics; @Inogic

Website: http://www.maplytics.com/ ; http://www.inogic.com/
Online Help File: www.docs.maplytics.com
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